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Mastering iFIX

The Mastering iFIX manual is intended for system integrators, OEMs, and process control engineers 
responsible for implementing a software automation solution using iFIX®. This manual assumes that 
you are familiar with Microsoft Windows, Microsoft Visual Basic, the iFIX WorkSpace, and your plant's 
network.

Reference Documents

For related information about iFIX, refer to the following manuals:

 l Understanding iFIX

 l Writing Scripts

 l Creating Pictures

 l Setting Up the Environment

 l Implementing Alarms and Messages
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Scheduler 

There are certain tasks that you may want to perform at a specified   time or interval, or when a change 
occurs in a database value or in any   OPC data server value. For example, you may want to run a Visual 
Basic® for Applications   (VBA) script that generates a report at the end of every shift or replaces   the cur-
rently-displayed picture when a database point exceeds a certain   value. The Scheduler allows you to cre-
ate, edit, monitor, and run both   types of actions as scheduled entries. In the Scheduler, you define the   
time or event that triggers a scheduled entry, and the action, referred   to as an operation,   that you want to 
occur. 

iFIX®   supplies Experts for common tasks such as replacing a picture. These Experts   generate scripts 
based on the information that you supply. The Multiple   Command Script Wizard enables you to use one 
or more Experts to assemble   a scripted sequence of commands. You can also write custom scripts for   
tasks that do not have Experts. Refer to the Writing  Scripts manual for detailed information on writing 
VBA scripts.

Overview 

In the configuration environment, iFIX displays schedules in the   iFIX WorkSpace, allowing you to easily 
create, edit, and start monitoring   entries while you work on your project.
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Scheduler in the Configuration    Environment

In the run-time environment, you can view the status and statistics   of the entries in your schedule. You 
can also control your entries using   the Start/Stop, Reset, and Fire Now buttons.
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Scheduler in the Run-time   Environment

The Scheduler provides the following features:

 l Spreadsheet design   that allows you to easily view and edit entries. 

 l Ability to schedule   as many entries as necessary and to trigger them as often as necessary.   

 l Ability to run as   a service under Microsoft Windows. 

 l Experts, via the   Multiple Command Script Wizard, for common events. 

 l Ability to easily   monitor entries and view diagnostic statistics. 

 l Ability to trigger   scheduled scripts on demand. 

 l Ability to run schedules   as a foreground or background task. 

Using the Scheduler with iFIX 
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Individual schedules can be run as a foreground or the background task. When you run a schedule in the 
foreground, you can easily test and debug scripts in the run-time environment. When an error occurs, 
VBA launches the Visual Basic Editor (VBE) debugger, where you can edit and save changes to a 
script. You cannot run scripts in the configuration environment.

When you run schedules as background tasks, they run regardless of whether the iFIX WorkSpace is in 
the run-time or configuration environment, and regardless of whether the iFIX WorkSpace is running. If 
you modify a scheduled entry, it automatically restarts. When the iFIX WorkSpace is in the run-time 
environment, you can view Scheduler statistics and diagnostic information about each entry in the 
schedule, including the number of times each entry has been fired and the last time it was fired.

You can also run the Scheduler in the background as a service under Windows. Because the Scheduler 
runs as a service, operators can log in and out of an Windows node without affecting scheduled entries, 
and entries are triggered regardless of whether or not the iFIX WorkSpace is running.

You can create multiple schedules, which allows you to organize and easily maintain entries. Each 
schedule can be configured individually to run as a background or foreground task. Also, as you add 
events to a schedule, you can choose whether or not to start monitoring them immediately, or to wait 
until the next time the iFIX WorkSpace starts.

The Scheduler supports a powerful Find and Replace feature that allows you to quickly and easily 
modify information in a schedule. For additional information on using the Find and Replace feature, refer 
to the Finding and Replacing Data section of the Understanding iFIX manual.

Getting Started with the Scheduler 

Before you start scheduling entries, you should understand how the Scheduler   executes scripts. The 
Scheduler can run as a foreground or background   task. When you run a schedule in the foreground, it 
runs on the same thread   as the scripts in the iFIX WorkSpace, allowing you to quickly   test and debug 
scripts in the run-time environment. When you run a schedule   in the background, it runs on a separate 
thread from the scripts in the   iFIX WorkSpace, monitoring the system and triggering scheduled   events.

The Scheduler does not loop; it waits for events to occur. When a selected   event occurs, the script is 
triggered from a schedule running in the background,   it is added to the queue, and it executes after the 
scripts in front of   it have finished executing. For this reason, when a schedule is run as   a background 
task it is ideal for monitoring tasks. This is exactly the   same as scripts triggered from schedules running 
as foreground tasks in   the iFIX WorkSpace. 

Generally, schedules created to run in the foreground are used for testing   and debugging. Once a sched-
ule created to run in the foreground has been   tested and debugged, we suggest that you set it to run in 
the background.   

This section includes the following topics on how to get started with   the Scheduler:

 l Using   the Scheduler

 l Securing   Schedules

 l Resolving   Schedules

 l Running   Foreground and Background Schedules

 l Opening   Pictures From Background Schedules
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 l Debugging   VBA Scripts

 l Starting   the FixBackgroundServer Task

 l Adding   Schedules to the Background Task Startup List

 l Foreground   Schedule Checklist

 l Background   Schedule Checklist

Refer to the Writing  Scripts manual for an explanation of how scripts are implemented in   the iFIX 
WorkSpace.

Using the Scheduler

Schedules are spreadsheets with separate tabs for event-based entries and time-based entries. Double-
clicking an empty row in a schedule displays a dialog box for adding an entry. Once you have created an 
entry, you can edit individual cells in the spreadsheet without using the dialog box.

Time-based entries create a timer object while event-based entries create an event object. These iFIX 
objects have associated properties, methods, and events that you can use in VBA scripts. They are dis-
played in the system tree and are the objects to which scheduled scripts are tied.

Securing Schedules 

iFIX's schedule protection prevents unauthorized users from accessing or modifying schedules. To con-
figure security for your schedules, enter a security area in the Properties window. For more information 
on configuring security, refer to the Configuring Security Features manual.

Resolving Schedules 

Database information for each data source in a schedule is saved as   part of the file on disk. When a 
schedule executes in the run-time environment,   and the database information is not up-to-date, iFIX 
queries the database   and resolves   the tag definitions. This can be a time-consuming process which   
slows the execution of the schedule. 

Resolving schedules removes the need for iFIX to query the database.   Therefore, resolved schedules 
execute faster in the run-time environment.   We recommend resolving your schedules as a final step in 
the configuration   process. The Resolve feature is available for both schedules and pictures.

If the process database is modified after you resolve a schedule, you   need to run Resolve again. These 
modifications include:

 l Loading a different   database. 

 l Deleting database   tags. 

Running Foreground and Background Schedules 
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You can select whether you want your schedules to run as foreground   or background tasks. When you 
create a new schedule, the default is for   it to run in the foreground. To run a schedule in the foreground, 
the   iFIX WorkSpace must be running in the run-time environment. Running   a schedule in the foreground 
is useful for testing and debugging VBA scripts.   

To run a schedule in the background, the FixBackgroundServer task must   be running. If the FixBack-
groundServer task is not running, it is automatically   started when a schedule is added to the background 
task. To create a schedule   that runs in the background you must change the default setting in the   Sched-
uler Properties dialog box, which is available by right-clicking   a schedule and selecting Scheduler Prop-
erties from the pop-up menu. You   can use this dialog box to change the default setting for a new 
schedule   or for an existing schedule that is set to run in the foreground. Also,   you can select whether you 
want a schedule to run in the foreground or   the background, set the window properties, and set the stat-
istics refresh   rates.

NOTE: An unsigned write occurs when a database   tag is configured for electronic signature, but you write a 
value directly   to that tag without capturing a signature. If you are working in a secure   environment with the 
Electronic Signature option enabled, you must be   aware of the impact of unsigned writes to the process data-
base. Unsigned   writes can originate from schedules. Refer to the Implications  of Database Writes With Elec-
tronic Signature section of the Using   Electronic Signatures manual for detailed information.

To avoid the possibility of these messages occurring,   append the intErrorMode parameter, set to "2", to the 
schedule's    script command. This will send an error message without a prompt to configured   iFIX alarm des-
tinations, and the schedule will continue without the need   for user intervention.

For example, if the schedule script is as follows:

WriteValue "33",   "Fix32.ROXIE.AI_TAG.F_CV"

modify it to:

WriteValue   "33", "Fix32.ROXIE.AI_TAG.F_CV", 2

Opening Pictures From Background Schedules

If a schedule running as a background task opens a picture while you   are editing another picture or 
schedule in configure mode, you may experience   unexpected behavior. In some instances, the picture 
may open over a modal   dialog box and you will not be able to return to the original dialog box.

To avoid this problem, it is recommended that when adding an entry to   a background schedule that ref-
erences a picture, you write a custom script   that configures the schedule to check whether the object is 
in the run   mode or configure mode before opening a picture. 

NOTE: It is recommended that schedules configured   to run in the background do not reference pictures. If 
you do not check   whether the WorkSpace is in run mode before opening the picture, and the   WorkSpace is in 
configure mode when the open attempt occurs, the attempt   fails since FixBackgroundServer cannot open pic-
tures in configure mode.   

The following VBA code shows an example on how a timer object checks   whether the Workspace is in 
run mode before opening a picture named MyPicture.grf.   If the WorkSpace is in configure mode, the pic-
ture does not open and a   program called Task.exe runs instead. The timer object in this example   runs 
from a background schedule:

Private Sub FixTimer3_OnTimeOut(ByVal lTimerId As Long)
Dim WrkSpcApp As Object
Set WrkSpcApp = GetObject("", "Workspace.Application")
 
'If the object is in run mode open the picture
   If WrkSpcApp.Mode = 4 Then
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     OpenPicture "MyPicture"
 
'Otherwise, just run this program called Task.exe 
   Else
     Task.exe
   End If
 
Set WrkSpcApp = Nothing
End Sub

For more information on creating new schedules and using the Scheduler   Properties dialog box, refer to 
the Creating   and Editing Schedules and Entries section. 

Debugging VBA Scripts 

If a scripting error occurs while a schedule is running, the VBE debugger automatically launches to allow 
you to quickly edit and save the changes made to the script. If the schedule is running in the foreground 
when the VBE launches, any changes made to the script are automatically saved in the schedule. If the 
schedule is running in the background when the VBE launches, close the VBE editor, re-open it in iFIX 
WorkSpace, and make the necessary changes to the script. Any changes made to the script are auto-
matically saved in the schedule.

NOTE: In order for scripting changes to be saved in a schedule, the VBE must be started in the iFIX 
WorkSpace. Any scripting changes made in the VBE launched from the FixBackgroundServer task will not be 
saved in a schedule. 

Starting the FixBackgroundServer Task 

The FixBackgroundServer task can run on its own, or as a Windows service.   If you configure iFIX to 
start as a service, the FixBackgroundServer task   runs as a service, provided you have added it to the 
task list.

To start iFIX as a service, shut down iFIX and in the SCU's Local Startup Definition dialog box enable 
the Continue Running After Log Off option. If iFIX is running, this option is unavailable. In the Task Con-
figuration   dialog box, add the FixBackgroundServer task to the task list. 

Refer to the Configuring  Startup Tasks section in the Setting Up the Environment manual for   more 
information on configuring startup tasks.

Adding Schedules to the Background Task Startup List 

Normally, you want your schedules to start automatically when iFIX is   started. To do this, you must add 
the schedules to the background task   startup list. If you are adding entries to a schedule that is already   
running in the background, you can choose whether or not to start monitoring   the entry immediately.

Foreground Schedule Checklist

The following is an overview of the steps necessary to successfully   implement a foreground schedule:
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 1. Create a foreground   schedule in the configuration environment of the iFIX WorkSpace.   

 2. Monitor entries as   necessary from the run-time environment of the iFIX WorkSpace.   

 

Background Schedule Checklist

When creating a schedule that runs in the background, you can create it directly as a background sched-
ule or create a foreground schedule and convert it to a background schedule. The following is an over-
view of the steps necessary to successfully implement a background schedule:

 1. Create a background schedule in the configuration environment of the iFIX WorkSpace.     

 2. Add the schedule to the background task startup list, using the Background Startup tab in the 
User Preferences dialog box.   

 3. Monitor entries as necessary from the run-time environment in the iFIX WorkSpace.   

Designing Schedules 

This chapter explains the issues you need to consider while you are   designing schedules. When cre-
ating schedules, there are two types of entries   that you can select: event-based entries and time-based 
entries. This   section describes both types of entries and the triggers that can be used   by each. Refer to 
the following sections for more information on:

 l Event-Based   Entries

 l Time-Based   Entries

 l Script   Authoring Experts

 l Writing   VBA Scripts that Access the iFIX WorkSpace

 

Event-Based Entries 

Event-based entries are created using the Add Event Entry dialog box. Event-based entries can use any 
data source available to the system to trigger an action. To select a data source, you can either enter the 
data source in the Data Source field or click the Browse button to access the Expression Builder.

Five event types are available to trigger an action based on the value of a data source. For example, you 
may want to have a certain action occur when an alarm equals HIHI. By tying the value of the alarm field 
to the OnTrue event type, you can trigger an action when the value of this field becomes equal to HIHI. 

The following table lists the event types that are available and when they trigger:     

  

The event 
type...

Triggers...
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OnDataChange When the expression changes.
OnTrue When the expression resolves to a non-zero value.
OnFalse When the expression resolves to zero.
WhileTrue At the specified interval as long as the expression evaluates to a non-zero 

value.
WhileFalse At the specified interval as long as the expression evaluates to zero.

  

Time-Based Entries 

Time-based entries are created using the Add Timer Entry dialog box. Time-based entries trigger at a 
scheduled time and are not tied to a data source. The following table lists the time triggers that are avail-
able and when they trigger:     

The time 
type...

Triggers...

One Shot Once at the specified date and time. For example, you can schedule an entry to 
trigger at 5:00 p.m. on 7/4/98.

Continuous Continuously at the specified interval, starting at the specified time. For example, 
you can schedule an entry to trigger every eight hours.

NOTE: You may notice in the log file that the timers occasionally fire +/- 1 or 2 mil-
liseconds off. This may happen on the first fire and will return to the specified inter-
val in a subsequent firing.

Daily On the scheduled days of the week at a particular time. Optionally, you can spe-
cify an end time and interval. For example, you can schedule an entry to trigger 
Monday through Friday, at noon, or every hour from noon until 6:00 p.m.

Monthly On the scheduled days of the month at a particular time. Optionally, you can spe-
cify an end time and interval. For example, you can schedule an event for the 
15th of the month, at 9:00 a.m., or every hour from 9:00 a.m. until 5:00 p.m. You 
can also schedule an event for the end of the month at a particular time. This set-
ting determines the last day of the month for you.

NOTE: If you have Daylight Saving Time enabled and you create a timed-based entry to have a 2:30 AM Start 
Time, be aware that during the transition from Standard Time to Daylight Saving Time, the schedule will actu-
ally fire at 1:30 AM. All other days of the year, it will fire at 2:30 AM. 

All time-based entries run the script tied to the OnTimeOut event procedure.

Adjusting for Daylight Saving Time 

The Scheduler supports daylight saving time for time-based events. Before allowing automatic Daylight 
Saving Time to be used in a production environment, you should test your application under each of the 
following scenarios for proper behavior:

 l While in Standard Time.   

 l While in Daylight Time.   

 l During the transition from Standard Time to Daylight Time.   

 l During the transition from Daylight Time to Standard Time.   
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Multiple Command Script Wizard and Scheduling

When selecting an action in the Operation field of either the Add Timer   Entry or Add Event Entry dialog 
box, you can click the Run Wizard button   to open the Multiple Command Script Wizard. You can also 
open the Multiple   Command Script Wizard by double-clicking the Operation field of an existing   timer or 
event entry and then clicking the Run Wizard button in the dialog   box that appears.

The wizard enables you to select one or more commands for the desired   operation, each of which is con-
figured using an Expert. After you have   provided each Expert with its required information, a VBA script 
tied   to the appropriate event is generated. You can later edit the script by   rearranging or deleting com-
mands in the wizard, or you can customize the   script in the VB Editor.

NOTES: 

 l Although the Multiple   Command Script Wizard's purpose is to fully automate the VBA command script-
ing   process, you can manually edit scripts generated by the wizard with the   VB Editor. You may add or 
edit VBA scripts anywhere before the Scripts   Authoring Tool header line (***** Scripts Authoring Tool 
*****), or directly   between a "WizardEnd" and a “Wizard[x]=” statement. Do not edit   any of the com-
mented areas in the wizard-generated script. If the Multiple   Command Script Wizard detects an 
improperly customized VBA script, you   may encounter an error.

 l The Multiple Command   Script Wizard does not check the command sequence to make sure com-
mands   occur in a logical order.

If you do not want to use the Multiple Command Script Wizard, you can   also use the VB Editor to write 
your own custom scripts for frequently   performed tasks. Refer to the Writing   Custom Scripts for the 
Scheduler section for information on how to   create your own custom scripts for the Scheduler.

Writing VBA Scripts that Access the iFIX WorkSpace 

When you write a scheduled script that opens, closes, replaces, or accesses a property of an object in a 
picture, you must ensure that the iFIX WorkSpace is running and that the picture you need to access is 
open and active. This differs from writing scripts that run from pictures.

Before you can access any information about the active picture in the iFIX WorkSpace, you must activ-
ate the iFIX WorkSpace using the GetObject method as shown in the following example.

Dim AppObj As Object
Set AppObj = GetObject("","Workspace.Application")

You can now check to see if the picture is open:

If UCase(AppObj.ActiveDocument.Name) = UCase("MyPicture") Then
<perform a task or open the picture>

You can then check to see which document or picture is open, and replace it if it is not the one you need. 
Once the proper picture is open, you can access its objects.

Refer to the Writing Scripts manual for more information on using VBA with iFIX.

Creating and Editing Schedules and Entries 
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The Scheduler allows you to create multiple schedules which help you   to easily organize and maintain 
events. When you create a new schedule,   you can control its properties from the Scheduler Properties 
dialog box.   

The following table lists the tabs on the Scheduler Properties dialog   box and the properties that can be 
controlled from each: 

Tabs Properties

Run Time State Run in Foreground

Run in Background

Window Prop-
erties

Window Height

Window Width

Window Styles

Stats Refresh Timer Statistics Refresh Rate (in seconds)

Event Statistics Refresh Rate (in seconds)

Background Files Lists all schedules running in the background. No   changes can be made from this 
tab.

You can create new schedules when the iFIX WorkSpace is in the   configuration environment.

NOTE: iFIX does not   support schedules that use the same name as the local node. Therefore,   do not use 
your local node's name for any schedules you create.

Once you have created a schedule, the schedule and all its entries appear   in the Schedules folder of the 
system tree. You can open a schedule and   view or edit its properties at any time by double-clicking the 
schedule   name in the system tree.

Once you have created a schedule, you can add new entries to it using   the Multiple Command Script 
Wizard or by writing your own custom scripts   in the VB Editor. You can edit an existing entry by select-
ing the entire   entry or a specific cell within the entry. Once created, entries can be   easily copied or 
moved from one schedule to another.

Sorting the Spreadsheet 

You can sort Scheduler entries in ascending or descending order by clicking   the heading of the column 
you want to sort. For example, if you want to   sort entries alphabetically by name, click the Name 
column's heading.   The entries will appear in ascending order. To sort them in descending   order, click the 
Name column's heading again.

NOTE: Sorting is only   available in the configuration environment. In the run-time environment,   entries appear 
in the order they were added to the schedule.

Viewing and Controlling Entry Diagnostics 

The Scheduler allows you to view and control entry diagnostics in the   run-time environment. If you open 
a schedule in the run-time environment,   you can view the status of entries, the number of times they 
have been   fired, and the time when they were last fired. You can also:
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 l Start or stop an   entry from executing. 

 l Reset the statistics   (number of times it has been fired and time when it was last fired) of   the 
entry. 

 l Trigger an entry   to fire on demand. 

If you have loaded a schedule, but the scripts are not firing, you need   to determine whether the problem 
is caused by the firing mechanism or   by the script itself. 

Writing Custom Scripts for the Scheduler 

The Scheduler provides Experts that generate a script that is executed   when an entry triggers. These 
Experts, which are available for common   tasks such as toggling a digital point or generating a report, are 
accessed   using the Multiple Command Script Wizard.

You can also create custom scripts for tasks that you need to perform   using the Visual Basic Editor. 
This section shows sample code that may   be helpful when writing custom scripts for use with the Sched-
uler. It   includes the following sections:

 l Form   Script Sample Code

 l Button   Script Sample Code

 l Generated   Script Sample Code

For additional examples, use the VBE to view the code for the Experts,   buttons, and forms supplied with 
iFIX. Refer to the Writing  Scripts manual for detailed information on writing VBA scripts.

Form Script Sample Code

The following example shows code that collects the name of the picture the user wants to display when 
the event is triggered, generates the script, and creates the event. The Procedures object is a collection 
of scripts. Before you generate the script, you need to get the index number for the next script using the 
GetEventHandlerIndex method. Once you generate the string that will become the script, use the 
AddEventHandler method to add the event.

Private CurrentObject As Object
Private EventName As String
 
Public Sub GetCurrentObjectValues(obj, Str)
     Set CurrentObject = obj
     EventName = Str
End Sub
 
Private Sub CommandButton1_Click()
 
'get file name entered by user
Dim FileName As String
FileName = TextBox1.Value
 
Dim WorkingObj As Object
Set WorkingObj = CurrentObject.Procedures
 
'Get the index for the procedure
Dim Index As Long
Dim Found As Long
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WorkingObj.GetEventHandlerIndex EventName, Index, Found
 
'Generate code
Dim StringCode As String
StringCode = "Dim doc As Object" & Chr(13) _
                    & "Dim PicturePath As String" & Chr(13) _
                    & "PicturePath = ""c:\fix32\pic\"" & FileName" & _
                    Chr(13) & "Set doc = _ 
                    Application.Documents.Open(PicturePath)" & Chr(13)
 
'Add the event 
WorkingObj.AddEventHandler EventName, StringCode, Index
 
'Close the form 
End
 
End Sub

Button Script Sample Code

The following example shows code for a button object called MyExpert that gets the timer or event 
object, the event trigger name, and picture name, if any, from the Add Event dialog box. It passes this 
information in to the form using the GetCurrentObjectValues procedure, and then displays the form.

Private Sub MyExpert_Click()
 
     Dim CurrentObj As Object
     Dim EventName As String
 
     'Set procedure object, event name, and file name
     Set CurrentObj = MyExpert.ProcedureObject
     EventName = MyExpert.EventProcedure
     MyExpert.Property1 = frmOpenPicture.TextBox1.Value
 
     'Pass the object and event name into the form 
     Call frmOpenPicture.GetCurrentObjectValues(CurrentObj,_
     EventName)
     frmOpenPicture.Show
     frmOpenPicture.Hide
End Sub

Generated Script Sample Code

The following example shows the script that would be generated if you ran this Expert on the Timer7 
object, using the OnTimeOut event.

Private Sub Timer7_OnTimeOut(ByVal lTimerId As Long)
Dim doc As Object
Dim PicturePath As String
PicturePath = "c:\fix32\pic\" & FileName
Set doc = Application.Documents.Open(PicturePath)
End Sub

Scheduler Dialog Boxes
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The Scheduler includes the following dialog boxes (listed in alphabetical   order):

 l Add   Event Entry Dialog Box

 l Add   Timer Entry Dialog Box

 l Scheduler   Properties Dialog Box

 l Script   Authoring Wizard Dialog Box

 

Add Event Entry Dialog Box

NOTE: If you   are modifying an existing Scheduler event-based entry, the title of this   dialog box changes to 
"Modify Event Entry."

The Add Event Entry dialog box displays the following items:

Schedule Info

Item Description

Name Allows you to specify a name for an event-based Scheduler   entry. 
The name can be any alphanumeric name up to 64 characters and 
must   begin with a letter. Do not use names that contain VBA reserved 
words.   See the Microsoft VBA help system for more information on 
VBA reserved   words.

Description Allows you to provide a description of up to 80 characters   for an 
event-based Scheduler entry.

Event Data Source

Allows you to enter a data source or expression for this Data link.    The term   data source refers to a ref-
erence to a source of information, such as   iFIX tagnames and historical files, or other OPC-compliant 
data servers.    A data   source may also consist of iFIX objects (such as shapes, charts, and variables)   or 
3rd party OLE controls.  The   term expression refers to constants, data sources, or a combination of   con-
stants and data sources that are connected with one or more operators.    Use the   Browse (...) button to 
open the Expression Builder dialog box. Use the   Quick Modify button to modify a database block directly 
without launching   the Database Manager.  

Event Properties Tab

Event Type

Allows you to select the condition that must be met for the event-based   script to fire. The options are: 

Option Description

On True Evaluates a Boolean expression in the Data Source   field and fires the 
entry if the expression evaluates to a non-zero value.

On False Evaluates a Boolean expression in the Data Source   field and fires the 
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entry if the expression evaluates to zero.

On Data Change Fires the entry every time the value in the Data Source   field changes.

While True Evaluates a Boolean expression in the Data Source   field and fires the 
entry at the specified interval for as long as the   expression evaluates 
to a non-zero value.

While False Evaluates a Boolean expression in the Data Source   field and fires the 
entry at the specified interval for as long as the   expression evaluates 
to zero.

Interval

Allows you to specify the duration of time between each triggering of   a While True or While False event-
based entry. The entry will fire for   as long as the expression in the Data Source field evaluates to one or   
zero, respectively.  

Historical Properties Tab

The Historical Properties tab allows you to set the parameters for a   query that fetches historical data 
from GE Historian. The tab contains   the following items:

NOTE: The following   fields, with the exception of the Update Rate fields, are only available   if you select a His-
torical Mode other than Current Value.

Start Date

Item Description

Fixed Date Specifies whether to enter a specific start date for   the query of the data 
source.

Days Before Now Specifies whether to enter the number of days prior   to today to fetch 
data from GE Historian. For example, if you want   to display data col-
lected for the data source two days ago, enter 2.

Start Time

Item Description

Fixed Time Specifies whether to designate a specific time to   start, based on a 24-
hour clock.

Lock Time Locks the fixed time, even if you change the time   zone in the Date and 
Time Properties dialog box in the Control Panel. This   field is available 
only when you designate a specific time to start using   the Fixed Time 
field.

Duration Before 
Now

Specifies whether to enter the duration prior to the   current time to start. 
The minimum duration is 0 seconds; the maximum   is 23 hours, 59 
minutes, and 59 seconds.

Time Zone

Item Description
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Time Zone Allows you to select the time zone to associate with   the start time. You 
can select the client time (time zone for your computer),   the server time 
(time zone used by the Historian server), or the tag time   (uses the time 
zone bias of the tag, which is set in Historian). The default   time zone is 
that of the client machine. This field is available only   when Historian is 
used.

Adjust for Daylight 
Savings Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   

Historical Mode

Allows you to determine how iFIX   selects and fetches data from a historical data source and, determ-
ines   what each displayed value represents. The options are:

 l Sample – The last   valid value found, up to and including the start of the specified interval.

 l Avg – The average   of all valid data found during the specified interval. 

 l High – The highest   valid data point value found during the specified interval. 

 l Low – The lowest   valid data point value found during the specified interval. 

 l Interpolated – The   data is interpreted by assuming that the line between two values is a   straight 
line. All points along that line are estimated except the starting   point and the ending point. 

 l Current Value – The   current value of the data point.

IMPORTANT:   The Current Value may update at a rate different from the rate set in   the Update Rate 
field. The update rate is not set solely by the rate entered   in the Update Rate field. It also depends on 
the collection rate, the   rate for querying Historian, and the time required to request an update   from the 
Historian server and send it back to the client. As a result,   the time it takes to display the updates may 
be longer than anticipated.   Additionally, please be aware that the timestamp for this mode represents 
the timestamp from the Historian server, not the client.  

 l Standard Deviation – The   standard deviation of all valid data found during the specified interval.

 l Total – The total   of all valid data found during the specified interval.

Duration

The duration determines the time range for the historical data source.   The minimum duration for a fetch 
is one second; the maximum is 999 days,   23 hours, 59 minutes, and 59 seconds. 

Item Description

Days Allows you to enter the number of days. This field   can be used in 
conjunction with the other fields in this area.

Hours Allows you to enter the number of hours for the duration   for the 
data fetch query. This field can be used in conjunction with the   
other fields in this area.

Mins Allows you to enter the number of minutes for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Secs Allows you to enter the number of seconds for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
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other fields in this area.

Update Rate

Allows you to specify the rate at which the data is updated. The default   rate is five seconds. Zero is per-
mitted for a one-time fetch. The fastest   update rate is five seconds, the slowest, 1:59:59.

Item Description

Hours Allows you to enter the number of hours for the rate   of data 
update. This field can be used in conjunction with the other fields   
in this area.

Mins Allows you to enter the number of minutes for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Secs Allows you to enter the number of seconds for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Action Info

Item Description

Operation Displays the command(s) currently scheduled to trigger   when the 
defined event occurs. If the field is blank, you can specify   one or more 
commands by clicking the Run Wizard button to open the Multiple   
Command Script Wizard, or the VB Editor button to open the VB 
Editor.   If more than one command is specified, the Operation field will 
display   "Multiple Commands". If you specify a command using the 
VB Editor,   the Operation field will display "Custom Script".

Run Wizard Opens the Multiple Command Script Wizard to automatically   create a 
VBA script for the current event-based entry.

VB Editor Launches the Visual Basic Editor to display the script,   if any exists, 
for the current event-based entry.  If   no script exists, you can use the 
VB Editor to create one.

Add Timer Entry Dialog Box

NOTE: If you   are modifying an existing Scheduler time-based entry, the title of this   dialog box changes to 
"Modify Timer Entry."

The Add Timer Entry dialog box displays the following items:

Name

Allows you to specify a name for the time-based Scheduler entry. The   name can be any alphanumeric 
name up to 64 characters and must begin with   a letter. Do not use names that contain VBA reserved 
words. See the Microsoft   VBA help system for more information on VBA reserved words.  
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Description

Allows you to provide a description of up to 80 characters for the time-based   Scheduler entry. 

Trigger Info

One Shot

Allows you to schedule a time-based entry to trigger once on a specific   date and time.  

Item Description

Date Allows you to specify the date on which a one shot   time-based entry will 
trigger.  

Time Allows you to specify the time at which a one shot   time-based entry will 
trigger.  

Continuous

Allows you to schedule a time-based entry to trigger continuously at   a specific interval.  

Item Description

Start Time Allows you to specify the time at which a continuous   time-based entry will 
begin triggering. Once triggered, the entry will   trigger at a regular period of 
time specified by the Interval field.  

Interval Allows you to specify the duration of time between   each triggering of a con-
tinuous time-based entry. The entry will begin   running at the time specified 
in the Start Time field.  

Daily

Allows you to schedule a time-based entry to trigger at a particular   time on the days of the week you spe-
cify.  

Item Description

Day of the 
Week

Allows you to select this day as one of the days of   the week that you want 
a daily time-based entry to trigger.  

Start Time Allows you to specify the time at which a time-based   entry will begin trig-
gering.  

Enable End 
Time/Interval

Allows you to configure a time-based entry to trigger   continuously from 
the time specified in the Start Time field to the time   specified in the End 
Time field. The entry will continuously trigger between   these times at the 
regular time intervals specified by the Interval field.    
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End Time Allows you to specify the time at which a time-based   entry stops trig-
gering. This field is only available if the Enable End   Time/Interval check 
box is selected.  

Interval Allows you to specify the duration of time between   each triggering of a 
time-based entry. The entry will begin triggering   on the selected days at 
the time specified in the Start Time field and   end at the time specified in 
the End Time field.  This   field is only available if the Enable End Time/In-
terval check box is selected.    

Monthly

Allows you to schedule a time-based entry to trigger at a particular   time on the days of the month you 
specify.    

Item Description

Day of the 
Month

Allows you to select this day as one of the days of   the month that you 
want a monthly time-based entry to trigger.  

End of Month Allows you to automatically schedule a monthly time-based   entry to trig-
ger on the last day of each month.  

Start Time Allows you to specify the time at which a time-based   entry will begin trig-
gering.  

Enable End 
Time/Interval

Allows you to configure a time-based entry to trigger   continuously from 
the time specified in the Start Time field to the time   specified in the End 
Time field. The entry will continuously trigger between   these times at the 
regular time intervals specified by the Interval field.    

End Time Allows you to specify the time at which a time-based   entry stops trig-
gering. This field is only available if the Enable End   Time/Interval check 
box is selected.  

Interval Allows you to specify the duration of time between   each triggering of a 
time-based entry. The entry will begin triggering   on the selected days at 
the time specified in the Start Time field and   end at the time specified in 
the End Time field.  This   field is only available if the Enable End Time/In-
terval check box is selected.    

Operation

Displays the command(s) currently scheduled to trigger at the specified   date and time. If the field is 
blank, you can specify one or more commands   by clicking the Run Wizard button to open the Multiple 
Command Script   Wizard, or the VB Editor button to open the VB Editor. If more than one   command is 
specified, the Operation field will display "Multiple   Commands". If you specify a command using the VB 
Editor, the Operation   field will display "Custom Script".
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Run Wizard

Opens the Multiple Command Script Wizard to automatically create a VBA   script for the current time-
based entry.  

VB Editor

Launches the Visual Basic Editor to display the script, if any exists,   for the current time-based entry.  If   
no script exists, you can use the VB Editor to create one.

Scheduler Properties Dialog Box

The Scheduler Properties dialog box displays the following items:

Run Time State

Item Description

Run in Fore-
ground

Allows a schedule to run as a foreground task in the   run-time environment 
of the iFIX WorkSpace.  

Run in Back-
ground

Allows a schedule to run as a background task, separately   from the iFIX 
WorkSpace. Time-based and event-based scripts will   still run as sched-
uled, even if the iFIX WorkSpace is not running   - provided that the scripts 
have been added to the FixBackgroundServer   task and the FixBack-
groundServer task is running.  

Window Properties

Item Description

Window 
Height

Allows you to configure the height of the iFIX schedule   that is currently 
open. Window height is specified as a percentage.  

Window 
Width

Allows you to configure the width of the iFIX schedule   that is currently 
open. Window width is specified as a percentage. .

Title Bar Enables or disables the Scheduler's title bar at run-time.    

System 
Menu

Enables or disables the Scheduler's system menu.  

Resizable Specifies whether or not the Scheduler window is resizable   at run-time.  

Always On 
Top

Specifies whether or not the Scheduler window stays   in front of other win-
dows within the iFIX WorkSpace at run-time.    
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Stats Refresh

Item Description

Timer Stat-
istics Refresh 
Rate

Allows you to set the rate, in seconds, at which time-based   entry stat-
istics are refreshed at run-time. Setting the refresh rate to   a higher value 
will improve CPU time.  

Event Stat-
istics Refresh 
Rate

Allows you to set the rate, in seconds, at which event-based   entry stat-
istics are refreshed at run-time. Setting the refresh rate to   a higher value 
will improve CPU time.

Background Files

Displays all the schedules that are currently loaded in the FixBackgroundServer   task.  

Script Authoring Wizard Dialog Box

The Script Authoring Wizard dialog box displays the following items:

Operation

Displays the command(s) currently scheduled to trigger for the specified   event or date and time. If the 
field is blank, you can specify one or   more commands by clicking the Run Wizard button to open the Mul-
tiple Command   Script Wizard, or the VB Editor button to open the VB Editor. If more   than one command 
is specified, the Operation field will display "Multiple   Commands". If you specify a command using the 
VB Editor, the Operation   field will display "Custom Script".

Run Wizard

Opens the Multiple Command Script Wizard to automatically create a VBA   script for the current time-
based or event-based entry.  

VB Editor

Launches the Visual Basic Editor to display the script, if any exists,   for the current time-based or event-
based entry.  If   no script exists, you can use the VB Editor to create one.

How Do I...

Click on any of the following links for more information on working   with the Scheduler application:

 l Working   with Scheduler

 l Working   with Entries

 l Working   with Scheduler at Run-time

 l Advanced   Topics

 

Working with the Scheduler
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You can perform the following tasks when working with the Scheduler:

 l Creating   and Running a Scheduled Event

 l Creating   New Schedules

 l Running   Schedules as Background Tasks

 l Starting   FixBackgroundServer

 l Starting   FixBackgroundServer as a Windows Service

 l Resolving   Schedules

 l Assigning   Schedules to a Security Area

 

Overview: Creating and Running a Scheduled Event

 

 To create and run a schedule:

 1. In the iFIX   WorkSpace's configuration environment, create the schedule.

 2. Add a new time-based   or event-based entry to the schedule.

 3. Configure the schedule   to run as a foreground or background task.

 4. View or edit the   properties of the schedule as necessary.

Creating New Schedules

 

 To create a new schedule:

 1. In Classic view,   in WorkSpace, click the New Schedule button on the Standard Toolbar. 

-Or-

In Ribbon view, click the WorkSpace button,   select New, and then click Schedule. 

 2. Right-click anywhere   in the schedule window and choose Add New Timer Entry.  

-Or-

Right-click anywhere in the schedule window   and choose Add New Event Entry.  

 3. Select the desired   timer or event options.

 4. In Classic view,   on the WorkSpace menu, click Save As. 

-Or-

In Ribbon view, click the WorkSpace button,   and then Save As.

 5. In the File Name   field, enter a name for the schedule. iFIX schedules are saved to the   Database 
(PDB) path with an .EVS file extension.

 6. Click Save.

 

Running Schedules as Background Tasks
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 To run a schedule as a background   task:

 1. In Classic view,   on the WorkSpace menu, click User Preferences. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences. 

 2. Select the Background   StartUp tab.

 3. Select the first   empty row and click the Browse (...)   button.

 4. Select the schedule   that you want to add to the Background Task Startup list and click Open.

 5. Click OK to save   the changes that you have made and close the User Preferences dialog box.

 

Starting FixBackgroundServer

 

 To start FixBackgroundServer:

 1. Click the Start button,   and point to Run.

 2. Enter the path and   file name of the FixBackgroundServer application. By default:
C:\Program Files (x86)\GE\iFIX\FIXBACKGROUNDSERVER.EXE

 3. Click OK.

 

Starting FixBackgroundServer as a Windows Service

 

 To start FixBackgroundServer as a   Windows Service:

 1. Shut down iFIX.

 2. Ensure that you are logged in as an Administrator.

 3. On the Start menu, point to Programs, iFIX, and then System Configuration. The System Con-
figuration Utility (SCU) window appears.

 4. From the Configure   menu, click Local Startup. The SCU's Local Startup Definition dialog box   
appears.

 5. Select the Continue   Running After Log Off check box, and click OK. This configures iFIX to   run 
as a service.

 6. Click the Task Configuration   button on the SCU toolbox. The SCU's Task Configuration dialog 
box appears.

 7. In the Filename field,    enter the path and file name of the FixBackgroundServer application. By   
default:
C:\Program Files (x86)\GE\iFIX\FIXBACKGROUNDSERVER.EXE
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 8. Select the Background   Option button.

 9. Click Add to add   FixBackgroundServer to the Configured Tasks list. 

 10. Click OK.

 11. On the File menu,   click Save to save the SCU file. 

 12. Exit the SCU.

 13. Restart iFIX.

 

Resolving Schedules

 

 To resolve a schedule:

 1. In Classic view,   from the WorkSpace toolbar, click the Resolve Files Tool button. 

-Or-

In Ribbon view, on the Applications tab,   in the Utilities group, click Utilities, and then click 
Resolve Files.   

 2. In the File Types   area, select the Schedule check box.

 3. In the Directories   area, verify that your schedule directory is correct. If it is not, enter   the correct 
path in the Schedules field.

 4. In the Resolve Files   area, select the schedule file you want to resolve. To select every file   in the 
list, click Select All.

 5. Click the Update   Schedule Files button and then click OK.

 

Assigning Schedules to a Security Area

 

 To assign a schedule to a security   area:

 1. Open the schedule   that you want to assign by:

Double-clicking it in the Schedules folder   of the iFIX WorkSpace system tree, 

-Or-

Creating a new schedule: 

In Classic view, click the New Schedule   button on the Standard Toolbar.

-Or-

In Ribbon view, click the WorkSpace button,   select New, and then click Schedule.

 2. In Classic view,   on the View menu, click Property Window. 

-Or-

In Ribbon view, on the View tab, in the   Window group, click Property Window. 

 3. In the Security Area   field, enter the security area you want to use.
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Working with Entries

You can perform the following tasks when working with the Scheduler   entries:

 l Creating   Event-Based Entries

 l Creating   Time-Based Entries

 l Editing,   Copying, and Sorting Entries

 

Creating Event-Based Entries

 To create an   event-based entry:

 1. Open the schedule   that you want to add the event-based entry to by double-clicking it in   the 
Schedules folder of the iFIX WorkSpace system tree, or create   a new schedule by clicking the 
New Schedule button on the Standard Toolbar.

 2. Right-click a row   in the schedule. From the pop-up menu, select Add New Event Entry. The   Add 
Event Entry dialog box appears.

 3. Enter the data source   that will trigger the event-based script for the entry, or click Browse to 
launch the Expression Builder dialog box. If you are using   a tagname expression as a data 
source, click Quick Modify to modify the   properties of a block directly without launching the Data-
base Manager.   

NOTE:   The data source can be a process value, object property, VBA script, or   mathematical expres-
sion.

 4. From the Event Type   menu, select the condition for triggering action. 

 5. If you selected While   True or While False for the Event Type, enter an interval in the Interval   field. 

 6. If you selected a   historical data source, complete the Historical Properties tab. To do   so:

 a. From the Historical   Mode list, select a mode. 

 b. In the Update   Rate area, select the hours, minutes, and seconds for the update rate.   If you 
chose a historical mode other than Current Value, go to Step C.   Otherwise, go to Step 7.

 c. In the Start   Date area, choose whether to use a fixed date or a relative date, (Days   Before 
Now). Depending on your selection, select either the date or the   Days Before Now.

 d. In the Start   Time area, choose whether to use a fixed time or a relative time, (Duration   
Before Now). Depending on your selection, select either the time, and   optionally, Lock 
Time, or the hours, minutes, and seconds for the Duration   Before Now.

 e. From the Time   Zone list, choose a time zone.

 f. In the Duration   Area, select the days, hours, minutes, and seconds for the duration.

 7. Click either Run   Wizard or VB Editor to create a script for the event. Complete the actions   as 
necessary.

 8. Click OK. 

Creating Time-Based Entries
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You can perform the following tasks when working with time-based entries:

 l Creating   One Shot Time-Based Entries

 l Creating   Continuous Time-Based Entries

 l Creating   Daily Time-Based Entries

 l Creating   Monthly Time-Based Entries

 

Creating One Shot Time-Based Entries

 

 To create a one shot time-based entry:

 1. Open the schedule   that you want to add the one shot time-based entry to by double-clicking   it in 
the Schedules folder of the iFIX WorkSpace system tree,   or create a new schedule by clicking 
the New Schedule button on the Standard   Toolbar.

 2. Right-click a row   in the schedule. From the pop-up menu, select Add New Timer Entry. The   Add 
Timer Entry dialog box appears.

 3. Select the One Shot   option button and enter the date and time at which you want the entry   to 
occur.

 4. Enter the necessary   information in the Schedule and Action areas. For help on individual fields   
within the Add Timer Entry dialog box, click the What's This? (question   mark) help button and 
select the field for which you want more information.

 5. Click OK. To save   your changes, click the Save button on the Standard Toolbar.

 

Creating Continuous Time-Based Entries

 

 To create a continuous time-based   entry:

 1. Open the schedule   that you want to add the continuous time-based entry to by double-clicking   it 
in the Schedules folder of the iFIX WorkSpace system tree,   or create a new schedule by clicking 
the New Schedule button on the Standard   Toolbar.

 2. Right-click a row   in the schedule. From the pop-up menu, select Add New Timer Entry. The   Add 
Timer Entry dialog box appears.

 3. Select the Continuous   option button and enter the date and time at which you want the entry   to 
occur.

 4. Enter the necessary   information in the Schedule and Action areas. For help on individual fields   
within the Add Timer Entry dialog box, click the What's This? (question   mark) help button and 
select the field for which you want more information.

 5. Click OK. To save   your changes, click the Save button on the Standard Toolbar.

 

Creating Daily Time-Based Entries
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 To create a daily time-based entry:

 1. Open the schedule   that you want to add the daily time-based entry to by double-clicking   it in the 
Schedules folder of the iFIX WorkSpace system tree,   or create a new schedule by clicking the 
New Schedule button on the Standard   Toolbar.

 2. Right-click a row   in the schedule. From the pop-up menu, select Add New Timer Entry. The   Add 
Timer Entry dialog box appears.

 3. Select the Daily   option button.

 4. Select the check   box for all of the days of the week that you want the entry to trigger.

 5. In the Start Time   field, enter the time that you want the event to trigger.

 6. Optionally, select   the Enable End Time/Interval check box to configure the entry to trigger   
repeatedly at a specific rate and for a specific duration of time. Enter   the time that you want to 
stop the entry from firing in the End Time field.   Enter the duration of time between occurrences of 
the entry in the Interval   field.

 7. Enter the necessary   information in the Schedule and Action areas. For help on individual fields   
within the Add Timer Entry dialog box, click the What's This? (question   mark) help button and 
select the field for which you want more information.

 8. Click OK. To save   your changes, click the Save button on the Standard Toolbar.

 

Creating Monthly Time-Based Entries

 

 To create a monthly time-based entry:

 1. Open the schedule   that you want to add the monthly time-based entry to by double-clicking   it in 
the Schedules folder of the iFIX WorkSpace system tree,   or create a new schedule by clicking 
the New Schedule button on the Standard   Toolbar.

 2. Right-click a row   in the schedule. From the pop-up menu, select Add New Timer Entry. The   Add 
Timer Entry dialog box appears.

 3. Select the Monthly   option button.

 4. Select the buttons   for all of the days of the month that you want the entry to trigger. Select   the 
End of Month check box to have iFIX automatically trigger the entry   on the last day of the month.

 5. In the Start Time   field, enter the time that you want the event to trigger.

 6. Optionally, select   the Enable End Time/Interval check box to configure the entry to trigger   
repeatedly at a specific rate and for a specific duration of time. Enter   the time that you want to 
stop the entry from firing in the End Time field.   Enter the duration of time between occurrences of 
the entry in the Interval   field.

 7. Enter the necessary   information in the Schedule and Action areas. For help on individual fields   
within the Add Timer Entry dialog box, click the What's This? (question   mark) help button and 
select the field for which you want more information.

 8. Click OK. To save   your changes, click the Save button on the Standard Toolbar.
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Editing, Copying, and Sorting Entries

The following sections provide information on editing, copying, and   sorting entries in the Scheduler:

 l Modifying   Existing Entries

 l Copying   Entries to Other Schedules

 l Moving   Entries to Other Schedules

 l Sorting   Entries in the Scheduler's Spreadsheet

 

Modifying Existing Entries

 

 To modify an existing entry:

 1. Open the schedule   that contains the entry you want to modify by double-clicking it in the   Sched-
ules folder of the iFIX WorkSpace system tree.

 2. Double-click the   row number of the entry to display the Modify Timer Entry or Modify Event   Entry 
dialog box.

 3. Modify the fields   in the Schedule, Trigger, and Action areas as desired. For help on individual   
fields, click the What's This? (question mark) help button and select   the field for which you want 
more information.

 4. Click OK. To save   your changes, click the Save button on the Standard Toolbar.

TIP:   You can also select an individual cell in the schedule's spreadsheet and   change its value directly 
rather than accessing the Modify Timer Entry   or Modify Event Entry dialog boxes. Your modifications 
are automatically   put into effect when you exit the cell.

 

Copying Entries to Other Schedules

 

 To copy an entry to another schedule:

 1. Right-click the entry   you want to copy from the Schedules folder of the iFIX WorkSpace   system 
tree and select Copy from the pop-up menu.

 2. From the Schedules   folder of the iFIX WorkSpace system tree, right-click the schedule   to which 
you want to copy the entry and select Paste from the pop-up menu.   The entry is added to the 
schedule.

 3. Open the schedule   to which you copied the entry and click the Save button on the Standard   Tool-
bar.

 

Moving Entries To Other Schedules
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 To move an entry to another schedule:

 1. Drag and drop the   entry from the one schedule to another in the Schedules folder of the   iFIX 
WorkSpace system tree. The entry is deleted from the schedule   from which it was moved and is 
added to the schedule to which it was moved.

 2. Open each schedule   and click Save on the Standard Toolbar.

 

Sorting Entries in the Scheduler's Spreadsheet

 

 To sort entries in the Scheduler's   spreadsheet:

Click the heading of a spreadsheet column   to toggle between sorting entries by ascending or descending 
order according   to the information in that column.

NOTE:   Sorting is only available in the configuration environment. In the run-time   environment, entries display 
in the order that they were added to the   schedule.

 

Working with the Scheduler at Run-time

You can perform the following tasks when working with the Scheduler   at run-time:

 l Viewing   the Status of Entries in the Run-Time Environment

 l Starting   and Stopping Entries from Executing

 l Resetting   the Statistics of Entries

 l Firing   Entries Manually

 

Viewing the Status of Entries in the Run-time Environment

 

 To view an entry's status in the   run-time environment:

 1. From the run-time   environment, open the schedule you want to view.

 2. Observe the following   fields:

 l Status   – displays   the current status of the entry. Based on the current condition of the   
entry, this cell may display Active or Stopped.

 l Name   – displays   the name that you provided for the entry.

 l Number   of Times Fired –   displays the number of times that the entry has fired since it 
was created,   or since it was last reset.

 l Last   Fired At –   displays the most recent time that the event has fired.

 l Next   Time to Fire –   displays the next time that the entry is scheduled to fire.
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NOTE:   The Next Time to Fire field only appears in time-based entries.

 l Description   – displays   the description you provided for the entry.

 

Starting and Stopping Entries from Executing

 

 To start or stop an entry from executing:

 1. From the run-time   environment, on the File menu, click Open. 

 2. Select the schedule   with the entry you want to control and click Open.

 3. Click the Start/Stop   button in the row of the entry. The Status cell changes to indicate whether   
the entry is Active or Stopped.

 

Resetting the Statistics of Entries

 

 To reset the statistics of an entry:

 1. From the run-time   environment, on the File menu, click Open.

 2. Select the schedule   with the entry you want to control and click Open.

 3. Click the Reset button   in the row of the entry. The Number of Times Fired cell resets to zero   and 
the Last Fired At cell resets to Undefined.

 

Firing Entries Manually

 

 To fire an entry manually:

 1. From the run-time   environment, on the File menu, click Open.

 2. Select the schedule   with the entry you want to control and click Open.

 3. Click the Fire Now   button in the entry's row. The entry fires and the Number of Times Fired   and 
Last Fired At cells update to show the new information.

 

Using Advanced Features

Advanced features of the Scheduler include the following:

 l Viewing   or Editing Scheduler Properties

 l Using   Script Authoring Experts
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 l Creating   Entries Using Custom Scripts

 l Troubleshooting   Scripts That are not Firing Properly

 

Viewing or Editing Scheduler Properties

 

 To view or edit Scheduler properties:

 1. Open a schedule by   double-clicking it in the Schedules folder of the iFIX WorkSpace   system 
tree, or create a new schedule by clicking the New Schedule button   on the Standard Toolbar.

 2. Right-click any row   in the schedule and select Scheduler Properties from the pop-up menu.    The 
Scheduler   Properties dialog box appears.

 3. Click the Run Time   State, Window Properties, Statistics Refresh, and Background Files tabs   to 
view the current settings and make changes as necessary. Use the What's   This? (question 
mark) help button to get field-specific help for each   tab.

 4. Click OK.

 

Using the Multiple Command Script Wizard in Scheduler

 

 To use the Multiple Command Script   Wizard in Scheduler:

 1. In the Add Timer   Entry, Add Event Entry, or Script Authoring Wizard dialog box, click the   Run 
Wizard button. The Multiple Command Script Wizard appears.

NOTE:   If you do not want to create a script automatically using the wizard,   you can click the VB Editor 
button to launch the Visual Basic Editor,   which allows you to enter your own custom script to fire at a 
specific   date and time, or based on a particular event. Refer to the Writing   Scripts manual for more 
information.

 2. Choose a command   from the Select Action to Append list. The Expert associated with the   com-
mand you chose appears.

 3. Complete the Expert   with your desired settings and information.

 4. Optionally, repeat   steps 2 and 3 if you want to add additional commands to your scripted   com-
mand sequence.

 5. When you have finished   choosing your command sequence, click OK.

 

 

Creating Entries Using Custom Scripts
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 To create an entry using a custom   script:

 1. Double-click the   schedule you want to add the entry to in the system tree. The schedule   appears 
in the iFIX WorkSpace.

 2. Right-click a row   in the schedule and select Add New Event Entry from the pop-up menu. The   
Add Event Entry dialog box appears.

- Or -

Right-click a row in the schedule and select   Add New Timer Entry from the pop-up menu. The 
Add Timer Entry dialog box   appears.

 3. Enter the Schedule   and Trigger information and click the VB Editor button. The Visual Basic   
Editor (VBE) appears.

 4. Write your custom   script in the VBE and click the Save Project button on the toolbar.

 5. Exit the VBE and   click OK.

NOTES:   

 l Although the Multiple   Command Script Wizard's purpose is to fully automate the VBA command script-
ing   process, you can manually edit scripts generated by the wizard with the   VB Editor. You may add or 
edit VBA scripts anywhere before the Scripts   Authoring Tool header line (***** Scripts Authoring Tool 
*****), or directly   between a "WizardEnd" and a “Wizard[x]=” statement. Do not edit   any of the com-
mented areas in the wizard-generated script. If the Multiple   Command Script Wizard detects an 
improperly customized VBA script, you   may encounter an error.

 l The Multiple Command   Script Wizard does not check the command sequence to make sure com-
mands   occur in a logical order. 

 

Troubleshooting Scripts That Are Not Firing Properly

 

 To troubleshoot scripts that are   not firing properly in a schedule:

 l In the run-time environment,   click the Fire Now button for the entry that is not working properly.   
This button executes the script independently from when then script is   scheduled to fire. Ensure 
that the script fires and runs properly.

 l Check the entry's   configuration by returning to the configuration environment and double-clicking   
the entry number to display the Modify Event Entry or Modify Timer Entry   dialog box. Ensure that 
the parameters are set correctly.

 l Check the SCU and   ensure that SAC is running. Refer to the Setting  Up the Environment e-book.

 l Check the Database   Manager and ensure that the block is on scan. Refer to the Building  a 
SCADA Systeme-book.

 l Use the Visual Basic   Editor to debug the script.
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Local Node Alias 

The local node alias feature allows iFIX local SCADA nodes to share   pictures, recipes, and historical col-
lection groups across nodes without   changing the node name. When you use this feature, you can cre-
ate generic   pictures and recipes and save development and maintenance time.

Fore more information, refer to the following sections:

 l Enabling   Local Node Alias

 l Using   Local Node Alias

 l Local   Node Alias Examples

 

Enabling Local Node Alias 

Before you can use the local node alias features you must enable the   local node alias feature in the 
SCU.

Using Local Node Alias 

Once you have enabled the local node alias feature, you can use the   THISNODE   placeholder in the 
node portion of the tagname (NODE.TAG.FIELD).   iFIX substitutes the local physical node name for the 
THISNODE   placeholder, increasing the portability of pictures and recipes and eliminating   the need to 
change tagname references for different nodes. The system   tree in the iFIX WorkSpace always shows 
the actual node represented   by the THISNODE   placeholder.

If, for example, you have ten production lines that produce similar   products, you can create one generic 
display that can access real-time   data from any of the ten lines. By using the THISNODE   placeholder, if 
you need to change the display, you only need to make   the change once. Refer to the Setting  Up the 
Environment manual for more information.

Local Node Alias Examples 

The local node alias feature can be used for pictures, recipes, and   historical collection groups, as illus-
trated in the following examples:

 l Picture   Example

 l Recipe   Example

 l Historical   Collection Group Example

 

Picture Example
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Assume that you have a Data link in a picture that is configured with   the tagname FIX32.THISNODE.AI-
1.F_CV, and your local SCADA node name is   CANLINE1. When you open the picture, the Data link 
behaves as if it were   configured as FIX32.CANLINE1.AI-1.F_CV. 

If you open the same picture on a different computer whose local SCADA   node name is CANLINE2,   the 
Data link's tagname resolves to FIX32.CANLINE2.AI-1.F_CV.

Recipe Example

Assume that you have two SCADA nodes:  FERMENTER1 and FERMENTER2. The recipes Beer1 and 
Beer2 are used to make beer and download to FERMENTER1 and FERMENTER2, respectively. The 
Beer1 recipe defines the following items:     

Identifier Formula
FERMENTER1:ILK1.F_CV 0
FERMENTER1:XCV1F1.F_CV 0
FERMENTER1:W16S1.F_CV 150
FERMENTER1:T16F.F_CV 55
FERMENTER1:K16F1.F_CV 132

The Beer2 recipe is identical except for the node name:     

Identifier Formula
FERMENTER2:ILK1.F_CV 0
FERMENTER2:XCV1F1.F_CV 0
FERMENTER2:W16S1.F_CV 150
FERMENTER2:T16F.F_CV 55
FERMENTER2:K16F1.F_CV 132

In this implementation, both recipes are required because each recipe has hard-coded node name ref-
erences. The local node alias feature eliminates the need for two recipes. Instead, you can create one 
recipe for both SCADA nodes, as shown in the following example:     

Identifier Formula
THISNODE:ILK1.F_CV 0
THISNODE:XCV1F1.F_CV 0
THISNODE:W16S1.F_CV 150
THISNODE:T16F.F_CV 55
THISNODE:K16F1.F_CV 132

After you create this recipe, share the directory that it resides in and map the recipe paths of both 
SCADA servers to the shared directory. For information on changing the recipe paths, refer to the Creat-
ing Recipes manual. 

Historical Collection Group Example
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Assume that you want to create a chart using the tank level and tank temperature from the two SCADA 
nodes in the Recipe example. On FERMENTER1 these tagnames are:     

Identifier Formula
Tank Level FIX32.FERMENTER1.AI_LEVEL.F_CV
Tank Temperature FIX32.FERMENTER1.AI_TEMP.F_CV

On FERMENTER2 these tagnames are:     

Identifier Formula
Tank Level FIX32.FERMENTER2.AI_LEVEL.F_CV
Tank Temperature FIX32.FERMENTER2.AI_TEMP.F_CV

When you define the pens for the chart, use the following data sources: FIX32.THISNODE.AI_
LEVEL.F_CV and FIX32.THISNODE.AI_TEMP.F_CV.  

If you open the chart on FERMENTER1, the tagnames resolve to FIX32.FERMENTER1.AI_LEVEL. F_
CV and FIX32.FERMENTER1.AI_TEMP.F_CV.  

If you open it on FERMENTER2, the tagnames resolve to FIX32.FERMENTER2.AI_LEVEL. F_CV and 
FIX32.FERMENTER2.AI_TEMP.F_CV.
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Reporting 

Detailed reports are important tools for reviewing the performance of   a process. They allow you to 
quickly grasp the relationships between specific   pieces of manufacturing process data so that you can 
make effective decisions.   Using any third-party reporting application that supports ODBC queries,   you 
can create customized reports based on iFIX real-time and historical   data. When you use iFIX real-time 
data, you generate the report with current   data extracted from an iFIX database. When you create a 
report using iFIX   historical data, you generate the report based on data gathered over a   period of time. 

Once generated, reports can be printed or displayed in the iFIX   WorkSpace. The ability to display reports 
directly in the iFIX   WorkSpace allows you to quickly view a report from any number of nodes   in your sys-
tem, greatly reducing the time it takes for you to make informed   decisions about your process.
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The Cross Reference Tool

The Cross Reference Tool is an iFIX utility that allows you to create   a report identifying every data 
source or occurrence of a data source   in pictures, scripts, schedules, or a User Global. Using the Cross 
Reference   Tool, you can also locate a text string in object names, property names,   and property values. 
The Cross Reference Tool also enables you to find   pictures containing selected Dynamo objects, or 
Dynamo objects that are   in selected pictures.

By default, the report results display in the Cross Reference Tool interface.   Additionally, the Cross 
Reference Tool provides options that allow you   to configure the report to automatically print or save upon 
report completion.   

This chapter describes the Cross Reference Tool interface and its functionality   including:

 l Understanding   the Cross Reference Tool

 l Using   the Report Wizard or the Quick Report

 l Exploring   the Cross Reference Tool Interface

 l Creating   Quick Reports

 l Creating   Reports Using the Cross Reference Report Wizard

 l Viewing   the Report Results

 l Selecting   Print Options and Printing a Report

 l Creating   a Cross Reference Tool Report from the Command-Line

 

Understanding the Cross Reference Tool

The Cross Reference Tool allows you to identify where tags are used   within iFIX pictures, scripts, 
schedules, and tag groups. Additionally,   you can also perform a search to find a text string, or search for 
Dynamo   objects. Once you select which type of search you would like to perform   and define additional 
search options, the Cross Reference Tool creates   a report that details the objects, properties, and prop-
erty values that   are related to that tag or text string.

You can create five types of searches using the Cross Reference Tool:

 l All   Tags

 l One   Tag

 l Text

 l Dynamo   Objects in Pictures

 l Pictures   Containing Dynamo Objects

For detailed information regarding the report results of each search,   refer to Viewing the Report   Results. 

For information on displaying the results of a search that includes   VBA scripts or that resolves tag sub-
stitutions with Tag Group files, refer   to the Viewing   a Search that Includes VBA Scripts and Viewing   a 
Search that Resolves Tags Using All Tag Group Files sections.
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Searching for All Tags

The All Tags search type returns   a list of all the tags in the selected object, picture, schedule, or User   
Global. This search returns a list that displays the name of the object   that references the tag (Object 
column), the property of that tag (Property   column), and the tag itself (Current Value column), as shown 
in the following   figure.

Report Results of a Search   for All Tags

Searching for One Tag

The One Tag search type searches   for a specific tag in the selected object, picture, schedule, or User   
Global, and all tag group files. You can enter a string in the Tag field   or click the Browse (...) button to 
open the Expression Editor. 

TIP: You can also search   using a partial tag name. For example, entering AI would find AI1 and   TANKAI.

The One Tag search also allows you to perform a find on an object in   an object to object connection. 
Using the Cross Reference Tool report   results, you could then determine which object required modi-
fication and   make the change manually. 

This search returns the name of the object that references the tag (Object   column), the property type 
(Property column), and the tag name (Current   Value column). For example, the following figure displays 
a One Tag search   on the partial tag name ACTIVESTATUS.

Report Results for a One   Tag Search

Searching for Text

The Text search type searches   for a text string in the object names, property names, and property val-
ues   of selected object, picture, schedule, or User Global. 
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Leave <ALL> in the Text field to display all object names, property   names, and property values. To 
search for a specific text string, enter   text that would appear in the either the object name, property, or 
property   value. 

NOTE: Do not use a   * wildcard in this field. Entering a wildcard returns a Search   completed with no output 
error.

The Text search returns the object name, property, and property value   in the Report Results section. If 
the Cross Reference Tool finds the text   string in the object name, all of the object properties are listed in   
the Property column. For example, the following figure displays a Text   search on the Text string 
FOREGROUNDCOLOR:

Report Results of a Text   Search

Searching for Dynamo Objects in Pictures

The Dynamos in Pictures search   type searches for Dynamo objects in selected pictures. 

To search for all Dynamo objects in a single picture, you can use either   the Quick Report or the Report 
Wizard. To search for all Dynamos in more   than one picture, use the Report Wizard to select multiple 
pictures from   the Picture Files tab.

NOTE: At least   one picture must be selected in the Picture Files tab, and at least one   Dynamo Set must be 
selected in the Dynamo Sets tab, before you can conduct   a search.

The Dynamos in Pictures search returns the name, revision number, and   description of Master 
Dynamos and Dynamo Instances in the selected picture(s),   as well as the Dynamo Sets to which the 
Dynamo objects belong.

If the Cross Reference Tool finds a Dynamo Instance and Master Dynamo   whose revision numbers are 
different, the search result is listed in red,   as shown below:

Report Results of a Dynamos   in Pictures Search
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You can use the Dynamo Updater, available via a button on the toolbar,   to update mismatched 
Dynamos. When you launch the Dynamo Updater, it pre-selects   the Dynamos that were identified in the 
Cross Reference Tool's search   results and displays them in its Select Dynamos tab.

NOTE: The Dynamo   Updater is only available when a search reveals at least one revision   mismatch 
between a Dynamo Instance and a Master Dynamo.

For more information on updating Dynamos, refer to Updating  Dynamos in Pictures.

Searching for Pictures Containing Dynamo Objects

The Pictures Containing Dynamos   search type searches for pictures that contain the selected Dynamo 
objects.

To search for all pictures that contain a single Dynamo object, you   can use either the Quick Report or 
the Report Wizard. To search for all   pictures that contain more than one Dynamo object, use the Report 
Wizard   to select multiple Dynamos from the Dynamo Sets tab. 

NOTE: At least   one picture must be selected in the Picture Files tab, and at least one   Dynamo Set must be 
selected in the Dynamo Sets tab, before you can conduct   a search.

The Pictures Containing Dynamos search returns the names of the pictures   in which the selected 
Dynamo objects exist, along with each Master Dynamo   or Dynamo Instance's name, revision number, 
and description.

If the Cross Reference Tool does not find the selected Dynamo object(s)   in any pictures, the search res-
ult is listed in red, as shown below:

Report Results of a Pictures   Containing Dynamos Search

You can use the Dynamo Updater, available via a button on the toolbar,   to update mismatched 
Dynamos. When you launch the Dynamo Updater, it pre-selects   the Dynamos that were identified in the 
Cross Reference Tool's search   results and displays them in its Select Dynamos tab.

NOTE: The Dynamo   Updater is only available when a search reveals at least one revision   mismatch 
between a Dynamo Instance and a Master Dynamo.

For more information on updating Dynamos, refer to Updating  Dynamos in Pictures.

Using the Report Wizard or the Quick Report

The Cross Reference Tool offers two utilities to create a report: the   Quick Report dialog box and the 
Cross Reference Report Wizard. The Quick   Report dialog box allows you to select from the most com-
mon Cross Reference   Tool search features on one picture, schedule, User Global, or object   listed in the 
Object Tree. 

The Cross Reference Report Wizard allows you to search on multiple files   and configure automatic sav-
ing and printing options. Use the following   feature lists to help you determine when to use each tool.
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Quick Report Features

The Quick Report dialog box allows you to do the following:

 l Search for all tags,   one tag, or a text string in the selected picture, schedule, user global   page, or 
object. 

 l Search for all pictures   that contain a single Dynamo object, or all Dynamo objects in a single   pic-
ture.

 l Display the search   results in the Report Results screen. Once the search completes, you can   
manually print out the results or choose to save the search results to   a .CSV, .HTM, .XLS, or 
.TB2 file. 

 l Resolve tags during   a search using all tag group files. 

 l Search through VBA   scripts. 

 l Include a summary   of the report at the end of the report. 

 l Automatically resize   report columns. 

 l Append results to   the Status Trail. 

For more information, refer to Creating   Quick Reports.
Cross Reference Report Wizard Features

The Cross Reference Report Wizard allows you to do the following:

 l Search for all tags,   one tag, or a text string in the selected picture, schedule, user global   page, or 
object. 

 l Search for Dynamo   objects in multiple pictures, or multiple pictures that contain several   Dynamo 
objects.

 l Select multiple files   to search through and arrange them in a specific order. 

 l Resolve tags during   a search using all tag group files. 

 l Search through VBA   scripts. 

 l Configure report   settings options, including: 

 l Automatically   save report to file. 

 l Automatically   save a status trail as a file. 

 l Automatically   print the report upon generation. 

 l Include a summary   of the report at the end of the report. 

 l Automatically resize   report columns. 

For more information, refer to Creating   Reports Using the Cross Reference Report Wizard.

Exploring the Cross Reference Tool Interface

To open the Cross Reference Tool, double-click the Cross Reference Tool icon in the system tree.

The Cross Reference Tool interface includes the following sections:
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Object Tree: Displays   pictures, schedules, and User Globals that are currently opened in the   Proficy 
iFIX WorkSpace. You can select a file or select an object within   that file. 

NOTE: If you have opened   new files in the WorkSpace since opening the Cross Reference Tool, you   will 
need to refresh the tree in order to see them displayed. To do this,   click the Refresh button in the Cross Refer-
ence Tool Toolbar.

Report Results Area: Displays   the results of the search. Refer to Viewing   the Report Results for more 
information.

Status Trail : Displays   the detailed status of the report, including error messages. Refer to   Viewing the 
Status Trail   for more information.

Using the Cross Reference Tool Toolbar

You can quickly access many of the Cross Reference Tool features in   the Cross Reference Tool tool-
bar. The following table describes the functions   of the Cross Reference Tool toolbar buttons. 

Use this 
button...

To...

Open the Quick Report dialog box. 

For more information, refer to the Creating   Quick Reports section.

Save the currently displayed report. Available files   types include *.CSV, *.HTM, *.XLS, or 
*.TB2.

NOTE: Microsoft   Excel enforces a maximum row limit of 65536. If you try to save a report   
that exceeds this row limitation in Excel, you will be prompted to continue   or cancel. Please 
be aware that rows exceeding that limitation may be   lost if you select either option. 

Open the Print dialog box to configure print settings   and print the currently displayed report. 

For more information, refer to the Selecting   Print Options and Printing a Report section.

Refresh the Object Tree. 

If you have opened new files in the WorkSpace since   opening the Cross Reference tool, you 
will need to refresh the tree in   order to see them.

Open the Font dialog box. This dialog box allows you   to specify font type, size, and style.

Open the Report Wizard dialog box. 

For more information, refer to the Creating   Reports Using the Cross Reference Report Wiz-
ard section.

Opens the Dynamo Updater.

For more information, refer to the Working  with Dynamo Objects section.

Open the Cross Reference Tool Help. 

Cross Reference Tool Toolbar   Buttons  

Creating Quick Reports
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The Quick Report Dialog Box   appears when you open the Cross Reference Tool. In addition to allowing   
you to select a search type, the Quick Report dialog box also allows you   to select the following search, 
report, and view options when you click   the Options button:
Search Options

Resolve Tags using   All Tag Group Files –   If the selected file or object contains Tag Group symbols, 
this option   resolves those symbols by attempting to match symbols with all Tag Group   Definition 
files and finds all substitutions. This option is available   for all search types.

Include VBA Scripts   in Search –   Allows the Cross Reference Tool to search through scripts within the 
selected   file for the tag(s) or text.

Report Option

Include Summary   – Adds   a summary report to the end of the Cross Reference Report detailing the   num-
ber of objects and tags searched.

View Options

Automatically Resize   Report Columns –   Automatically resizes the columns in the Report results to 
accommodate   the text.

Append to Status   Trail –   If enabled, the status trail adds any new tracking information to the   existing 
status trail. If disabled, each time the Report runs, all previous   tracking information is overwritten by 
the new status trail.

 To create a report using the Quick   Report dialog box: 

 1. Select a file or   object in the Object Tree. 

NOTE:   If you want to run a Dynamos Quick Report to search for all pictures that   contain Dynamo 
objects from a Dynamo Set, select the Dynamo Set in the   Object Tree. If you want to run a Dynamos 
report that searches for all   Dynamo objects in a picture, select the picture.

 2. From the File menu,   select Quick Report. The Quick Report dialog box appears.

 3. Select the desired   search settings in the Quick Report dialog box. 

 4. Click the Search   button. 

NOTE: You cannot   access the iFIX WorkSpace while the Cross Reference Tool generates   a report. 
Once the report completes, you will be able to access the   iFIX WorkSpace again.

You can also double-click an object or file in the Object Tree to run   a Quick Report. This runs the Quick 
Report using the default settings   or the settings of your last report. 

The results of the Quick Report display in the Report Results section    of the Cross Reference Tool. You 
can save or print the report manually   using the appropriate toolbar buttons. 

Creating Reports Using the Cross Reference Report Wizard

The Cross Reference Report Wizard walks you through the process of creating   a Cross Reference 
Report. The Cross Reference Report Wizard allows you   to search through multiple files, and then con-
figure the report to automatically   print or save upon report completion.

 To create a report using the Cross   Reference Report Wizard: 

 1. Select what you want   to search for and specify search options. 

 2. Choose which files   the Cross Reference Tool searches and modify the search order. 
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 3. Select whether the   report results are automatically saved or printed and modify additional   output 
options. 

 4. Review the wizard   settings and run the report. 

Specifying Search Settings

The Search Settings tab of the Cross Reference Report Wizard allows   you to select the type of search 
that the report runs and specify the   following search options:

Resolve Tags using   All Tag Group Files –   If the selected file or object contains Tag Group symbols, 
this option   resolves those symbols by attempting to match symbols with all Tag Group   Definition 
files and finding all substitutions. This option is available   for all search types.

Include VBA Scripts   in Search –   Allows the Cross Reference Tool to search through scripts within the 
selected   files for the tag(s).

Specifying Picture Files for the Report

The Picture Files tab of the Cross Reference Report Wizard allows you   to select one or more pictures to 
search, and allows you to arrange them   in a specific search order.

By default, the Select Files list displays all pictures in the C:\Program Files (x86)\GE\iFIX\PIC folder. If 
any of the selected pictures   are not opened in the WorkSpace, the Cross Reference Tool opens them 
during   report generation. Once the report finishes, these pictures are closed.

The Cross Reference Tool processes pictures from top to bottom in the   list. You can re-arrange the order 
in which the pictures are processed   by selecting a picture and clicking the up or down arrow button to 
move    the selected picture up or down in the list.   

Specifying Schedule Files for the Report

The Schedule Files tab of the Cross Reference Report Wizard allows you   to select one or more sched-
ules to search, and allows you to arrange them   in a specific search order.

By default, the Select Files list displays all schedules in the C:\Program Files (x86)\GE\iFIX\PDB folder. 
If any of the selected schedules   are not opened in the WorkSpace, the Cross Reference Tool opens 
them during   report generation. Once the report finishes, these schedules are closed.

The Cross Reference Tool processes schedules from top to bottom in the   list. You can re-arrange the 
order in which the schedules are processed   by selecting a schedule and clicking the up or down arrow 
button to move    it up or down in the list. 

Specifying Dynamo Sets for the Report

The Dynamo Sets tab of the Cross Reference Report Wizard allows you   to select one or more Dynamo 
Sets to search, and allows you to arrange   them in a specific search order.
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By default, the Select Files list displays all Dynamo Sets in the C:\Program Files (x86)\GE\iFIX\PIC 
folder. If any of the selected Dynamo   Sets are not opened in the WorkSpace, the Cross Reference Tool 
opens them   during report generation. Once the report finishes, these Dynamo Sets   are closed.

The Cross Reference Tool processes Dynamo Sets from top to bottom in   the list. You can re-arrange 
the order in which the Dynamo Sets are processed    by selecting a Dynamo Set and clicking the up or 
down arrow button to   move it up or down in the list. 

Specifying Report Settings Options

By default, the Cross Reference Tool displays the results of a search   in the Report Results section of 
the Cross Reference Tool. The Report   Settings tab of the Cross Reference Report Wizard allows you to 
specify   the following output options in addition to the default display:

Save Report to File   – Automatically   saves the report when the report generation completes. You can 
save the   report to the default file and location listed, enter one directly into   the Save Report to File 
field, or click the Browse (...) button to locate   a file or path. 

Available file types include *.CSV, *.HTM,   *.XLS, or *.TB2. 

NOTE: Microsoft   Excel enforces a maximum row limit of 65536. If you try to save a report   that exceeds 
this row limitation in Excel, you will be prompted to continue   or cancel. Please be aware that rows 
exceeding that limitation may be   lost if you select either option. 

Save Status Trail   –   Saves the status trail information when the report completes. You can   save the 
report to the default file and location listed, enter one directly   into the Save Status Trail field, or click 
the Browse (...) button to   locate a file or path. 

The available file type is *.TXT. 

Print Report   – Automatically   prints the report when complete. Click the Advanced button to modify the   
Print settings. Refer to Selecting   Print Options and Printing a Report for more information.

Additionally, the Report Settings tab also   allows you to set the following report and view options:

Include Summary   – Adds   a summary report to the end of the report that details the number of objects   
and tags searched.

Automatically Resize   Report Columns –   Automatically resizes the columns in the Report Results sec-
tion to accommodate   the text.

Reviewing the Report Settings

The Apply and Go tab displays all of the settings you have selected   in the Wizard. 

Review your choices and if they are correct, click the OK button. If   you need to modify any of the 
options, click the Back button to return   to the appropriate tab.

NOTE: You cannot access   the iFIX WorkSpace while the Cross Reference Tool generates a   report. Once the 
report completes, you will be able to access the   iFIX WorkSpace again.

Viewing the Report Results
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Once you create a report using either the Quick Report or Cross Reference Report Wizard, the results 
display in the Report Results section of the Cross Reference Tool interface. 

The information that appears in the Report Results columns depends upon which type of search you 
selected. The following table describes the search type and display results.    

Type 
of 
Search

Displays

All 
Tags

Returns a list that displays the name of the object that references the tag (Object 
column), the property of that tag (Property column), and the tag itself (Current Value 
column), as shown in the Report Results of a Search for All Tags figure. 

One 
Tag

Returns the name of the object that references the tag (Object column), the property 
type (Property column), and the tag name (Current Value column).

For example, the Report Results for a One Tag Search figure shows a One Tag 
search on the partial tag name ACTIVESTATUS. 

Text Returns the object name, property, and property values. If the Cross Reference Tool 
finds the text string in the object name, all of the object properties are listed in the 
Property Column. 

For example, the Report Results of a Text Search figure shows a Text search on the 
string FOREGROUNDCOLOR.

Search Results   

Additionally, if you selected the Save Report to File or Print Report options in the Cross Reference 
Report Wizard, those are automatically completed when the results display. Once the Report Results 
display, you can also save or print the report manually using the appropriate toolbar buttons.

Viewing the Status Trail

The Status Trail, shown in the following figure, tracks the processing   status of the report. This allows 
you to monitor the report progress and   messages, and track errors encountered in the report. 

Status Trail

To automatically save the Status Trail to a .TXT file when the report   generates, select the Save Status 
Trail option in the Report Settings   tab of the Cross Reference Report Wizard. You can also modify the 
name   and default location of the Status Trail file in the Report Settings tab.   
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Viewing a Search that Resolves Tags Using All Tag Group Files

If you select the Resolve Tags Using All Tag Group Files option in either   the Quick Report dialog box or 
the Cross Reference Report Wizard, the   Cross Reference Tool attempts to resolve any tag sub-
stitutions found in   the selected files with all Tag Group Files that you have on your computer   during the 
All Tags, One Tag, or Text search. 

The following figure displays the results of an All Tags search with   the Resolve Tags using All Tag 
Group Files option. 

Search Results of Resolving   Tags using All Tag Group Files

The Report Results section displays the object that references the tag,   the property type of that tag, the 
tag substitution in the Current Value   column, the resolved data source in the Resolved column, and the 
Tag Group   File name that the substitution was found in. 

The Cross Reference Tool attempts to resolve the substitution in all   Tag Group files. Therefore, if the 
substitution does not exist in a Tag   Group file, the Resolved column displays Unresolved, as shown in 
the previous   figure. 

Viewing a Search that Includes VBA Scripts 

If you select the Include VBA Scripts in Search option in either the   Quick Report or Cross Reference 
Report Wizard, the Cross Reference Tool   searches through all scripts that are contained within the 
selected file(s)   during an All tags, One Tag, or Text search.

The following figure displays the results of an All Tags search with   the Include VBA Scripts in Search 
option.
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Search Results of Including   VBA Scripts in Search

If the Cross Reference Tool finds a tag in a script (or the tag or text   string that you searched for), the 
Object column displays the object associated   with that script, the Property column displays 
ScriptSource, and the Current   Value column displays the line number and line text of the script that   the 
tag appears in.

NOTE: If the scripts   contained in the files that you are searching include variables and those   variable names 
are either custom alarm areas or tag names, the Cross Reference   Tool displays the variable as a source.

Selecting Print Options and Printing a Report

The Print dialog box allows you to specify   the print settings for a report. When a report completes and 
displays   in the Report Results section of the Cross Reference Tool, you can access   this dialog box on 
the File menu by clicking the Print button. This prints   the report as it appears. You can also access this 
dialog box in the Cross   Reference Report Wizard, on the Report Settings tab, by clicking the Advanced   
button. 

The Print option in the Report Settings tab allows you to set these   options for automatic printing once the 
report generates.

 To select print options and print   a report: 

 1. Select a Print Range.   

 2. Click the Page Setup   button to configure page settings. Refer to the Selecting Page Options for 
Printing section for more information.  

 3. Select any of the   following Print Options: 

Column Headers   – Prints   column headers at the top of each page.

Row Headers   – Prints   row headers on the left side of each page. 

Grid Lines   – Prints   spreadsheet grid lines.

Border   – Prints   the spreadsheet border.

Data Cells Only   – Does   not print empty cells beyond the last column and row containing data.

Color   – Prints   colors in the spreadsheet as they appear on the screen.

Shadows   – Prints   the shadow effect in the column and row headers.

 4. Click the Printer   Setup button to modify the current printer and printer options. 

 5. Optionally, click   the Print Preview button to view how the Report will appear when printed.   Select 
Close from the Print Preview screen to return to the Print dialog   box. 

 6. Click OK. 

If you accessed the Print dialog box from the   print toolbar button, clicking OK prints the report. If 
you accessed the   Print dialog box from the Cross Reference Report Wizard, clicking OK returns   
you to the wizard.

Selecting Page Options for Printing
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The Page Setup dialog box allows you to:

 l Select page orientation   

 l Enter or modify page   margins 

 l Create or modify   headers and footers 

 l Specify the Preview   zoom setting 

Enter any desired changes to the Page Setup dialog box and click OK   to return to the Print dialog box.

Customizing Header or Footer Text

The Change Header and Footer Attributes dialog box, shown in the following   figure, allows you to create 
and modify headers and footers for your printed   report. To access the Change Header and Footer Attrib-
utes dialog box,   click the Change Header and Footer Attributes button on the Page Setup   dialog box.

To add a header or footer to your printed report, select either the   Header Text or Footer text option from 
the Apply to section and enter   your text in the appropriate column. For example, if you want your text   to 
be centered, enter the text in the Center column.

The Cross Reference Tool also provides some pre-configured common header   and footer options, includ-
ing:

<Default Header>   – Inserts   the Report Title including the file name, date, and time.

<Time>   – Inserts   a time stamp (date and time).

<Page Number>   – Inserts   the current page number. 

To select from these pre-configured strings, select a cell in the table   and right-click it. The display 
toggles through the options.

Creating a Cross Reference Tool Report from the Command-Line

The Cross Reference Tool also allows you create reports or access the Cross Reference Tool Help 
while the Cross Reference Tool is closed. You can run the command-line options outlined in the fol-
lowing table from the Windows Run prompt.      

Option Syntax Description
/r crossreference.exe 

/r
Creates a report with the CrossReference.ini settings. This runs 
the CrossReference.ini settings which were automatically saved 
when you last closed the Cross Reference Tool. If no CrossRe-
ference.ini is found, the report runs with the defaults.

NOTE: You must use the Cross Reference Report Wizard once 
before using the /r command. The Cross Reference Tool writes to 
the CrossReference.ini file when you create reports using the 
Cross Reference Report Wizard. Reports created using the 
Quick Report do not get written to the CrossReference.ini file.

The /r parameter allows you to set up an entire search in the 
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Cross Reference Report Wizard, navigate to the Apply and Go 
tab, and then click the Cancel button to cancel the search. After 
exiting the Cross Reference Tool, you could then run the cross-
reference.exe /r command at any point to generate the report with 
the settings you had entered.

/? crossreference.exe 
/?

Displays Cross Reference Tool Help.

  

Cross Reference Tool Dialog Boxes

The Cross Reference Tool includes the following dialog boxes (listed   in alphabetical order):

 l Change   Header or Footer Attributes Dialog Box

 l Cross   Reference Report Wizard Dialog Box

 l Page   Setup Dialog Box

 l Print   Dialog Box

 l Print   Preview Screen

 l Quick   Report Dialog Box

 l Quick   Report Options Dialog Box

 

Change Header or Footer Attributes Dialog Box

The Change Header or Footer Attributes dialog box displays the following   items:

Header Text

Select this option to insert or modify text in the header.  

Footer Text

Select this option to insert or modify text in the footer.

Text Reset Button

Resets all header or footer information.

Cross Reference Report Wizard Dialog Box

The Cross Reference Report Wizard dialog box displays the following   items:

Search Settings Tab

Item Description
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All Tags Select this option to search for all tags contained   in the selected picture, 
schedule, User Global, or object.

One Tag Select this option to search for a specific tag, tag   substitution, or symbol in 
the selected picture, schedule, User Global,   or object and all Tag Group 
Definition files.  

Enter a specific tag, tag substitution, or symbol   in the Tag field or click 
Browse to open the Expression Editor.   

Tag (edit 
box)

Enter a specific tag, tag substitution, or symbol   in the Tag field or click 
Browse to open the Expression Builder.  

NOTE:  Do   not use a * wildcard in this field.  Entering   a wildcard returns a 
Search completed with no output error. 

Text (but-
ton)

Select this option to search for text in object names,   property names, and 
property values in the selected object.  

Enter a text string that would appear in the Object,   Property, Property 
Value, Resolved, or Tag Group File name columns in   the Text field.  To   
return a list of all objects, leave <ALL> in the Text field.  

Text (edit 
box)

Leave <ALL> or clear the field to return a list   of all objects.  To   search for 
specific objects, enter a text string that would appear in   the Object, Prop-
erty, Property Value, Resolved, or Tag Group File name   columns. 

NOTE:  Do   not use a * wildcard in this field.  Entering   a wildcard returns a 
Search completed with no output error. 

Dynamos 
in Pictures 

Select this option to search for Dynamo objects in   selected pictures.

Pictures 
Containing 
Dynamos 

Select this option to search for pictures that contain   the selected Dynamo 
objects.

Resolve 
Tags using 
All Tag 
Group Files 

If the selected picture or object contains Tag Group   symbols, this option 
resolves those symbols by attempting to match the   symbols with all tag 
group files and find all substitutions.  This   option is available for all search 
types.  

Include 
VBA 
Scripts in 
Search

Select this option to allow the Cross Reference Tool   to search for the tag(s) 
through scripts within the selected file. Both   the All Tag and One Tag 
searches return the tag, if found. The Text search   returns all lines of script.    
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Picture Files Tab

Item Description

File Loca-
tion Field

Click Browse to select another location to search   for picture files. The iFIX 
PIC path is chosen by default:C:\Program Files (x86)\GE\iFIX\PIC. 

Select All 
Button

Click this button to select all files listed in the   Picture Files tab.

During report generation, the Cross Reference Tool   opens any of the selec-
ted files that were closed.  When   the Report finishes, those files are closed 
again.  

Clear All 
Button

Click this button to clear any currently selected   files. 

Up Arrow 
Button

Select this option to move the selected file up in   the arranged search order.  

Down 
Arrow But-
ton

Select this option to move the selected file down   in the arranged search 
order. 

Schedule Files Tab

Item Description

File Loca-
tion Field

Click Browse to select another location to search   for schedule files. The 
iFIX PDB path is chosen by default: C:\Program Files (x86)\GE\iFIX\PDB. 

Select All 
Button

Click this button to select all files listed in the   Schedule Files tab. 

During report generation, the Cross Reference Tool   opens any of the selec-
ted files that were closed.  When   the Report finishes, those files are closed 
again. 

Clear All 
Button

Click this button to clear any currently selected   files. 

Up Arrow 
Button

Select this option to move the selected file up in   the arranged search order.  

Down 
Arrow But-
ton

Select this option to move the selected file down   in the arranged search 
order. 

Dynamo Sets Tab

Item Description
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File Loca-
tion Field

Click Browse to select another location to search   for Dynamo files. The 
iFIX PIC path is chosen by default: C:\Program Files (x86)\GE\iFIX\PIC. 

Select All 
Button

Click this button to select all files listed in the   Dynamo Sets tab.  

During report generation, the Cross Reference Tool   opens any of the selec-
ted files that were closed.  When   the Report finishes, those files are closed 
again. 

Clear All 
Button

Click this button to clear any currently selected   files. 

Up Arrow 
Button

Select this option to move the selected file up in   the arranged search order.  

Down 
Arrow But-
ton

Select this option to move the selected file down   in the arranged search 
order. 

Report Settings Tab

Item Description

Save Report 
to File...  
(check   box)

Select this option to automatically save the report   when the report gen-
eration completes.  Save   the report to the default file and location listed, 
enter one directly   into the Save Report to File field, or click Browse to loc-
ate a file or   path.  

Available file types include *.csv, *.htm, *.xls,   or *.tb2. 

NOTE:  Microsoft   Excel enforces a maximum row limit of 65536. If you 
try to save a report   that exceeds this row limitation in Excel, Excel 
prompts you to continue   or cancel.  Be   aware that rows exceeding that 
limitation may be lost if you select either   option. 

Save Report 
to File...  (edit   
box)

Displays the location of the saved report file.  To   modify the default set-
tings, enter a new location or file name directly   into this field, or click the 
Browse (…) button to locate one.

Available file types include *.csv, *.htm, *.xls,   or *.tb2. 

Save Status 
Trail... (check 
box)

Select this option to save the status trail information when the report   com-
pletes.  Save   the report to the default file and location listed, enter one dir-
ectly   into the Save Status Trail field, or click Browse to locate a file or   
path. 

You can only save this file as a *.txt file. 

Save Status 
Trail... (edit 

Displays the location of the status trail file.  To   modify the default set-
tings, enter a new location or file name directly   into this field or click 
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box) Browse to locate one. 

You can only save this file as a *.txt file.   

Print Report Select this option to automatically print the report   when complete.  Click   
Advanced to modify the Print settings.  

Advanced 
Button

Click this button to open the Print dialog box and   modify the settings for 
your print report.

Include Sum-
mary

Select this option to add a summary report to the   end of the Cross Refer-
ence Report detailing the number of objects and   tags searched.  This   
option is not available for a One Tag search.  

Automatically 
Resize 
Report 
Columns

Select this option to automatically resize the Report   Results columns to 
accommodate the text.  

Apply and Go Tab

Review your settings prior to generating a report.

Left/Right Buttons

Click the Left or Right button to scroll the row of tabs left or right.

Back/Next Buttons

Click the Back or Next button to navigate between tabs.

OK 

Click the OK button to run the Cross Reference Report.

Page Setup Dialog Box

The Page Setup dialog box displays the following items:

Portrait

Prints a page that is taller than it is wide. 

Landscape

Prints a page that is wider than it is tall.  

Page Margins

Item Description

Left Enter the desired space between the left line of the   page and the left line of 
the report.
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Right Enter the desired space between the right line of   the page and the right line 
of the report with no indent.  

Top Enter the desired space between the top of the page   and the first line of the 
report.  

Bottom Enter the desired space between the bottom line of   the report and the bottom 
edge of the page.  

Change Header and Footer Attributes

Click to open the Change Header and Footer dialog box, and configure   headers and footers for your 
report.  You   can configure up to 9 lines of text for both the header and footer.  

Range

Select the percent or number of pages that you would like to display   in the Print Preview screen.    

Print Dialog Box

The Print dialog box displays the following items:

Print Range

Item Description

All Prints the entire report. This is the only option   available in Report Wizard 
configurations.

Selected 
Cells

Prints only the cells that you highlighted in the   Cross Reference Tool 
screen.

Current 
Page

Prints only the current page of your report.  

Pages Prints a specific page range.  Enter   the desired start and end page ranges in 
the Pages fields.

Print Options

Item Description

Column 
Headers

Prints the column headers at the top of each page.   

Row Head-
ers

Prints the row headers on the left side of each page.   

Grid Lines Prints the spreadsheet grid lines.  

56 © 2020 General Electric Company. All rights reserved.



Border Prints the spreadsheet border.  

Data Cells 
Only

Select this option to ensure that the printer does   not print empty cells bey-
ond the last column and row containing data.    

Screen 
Image 
Color

Prints the colors in the spreadsheet as they appear   on the screen.  

Shadows Prints the shadow effect within the column and row   headers.  

Print Preview Screen

The Print Preview screen displays the following items:

Next

Allows you to browse through multiple report pages in the Print Preview   dialog box.

Previous

Allows you to browse through multiple report pages in the Print Preview   dialog box.

Zoom

Click to zoom in and out on the displayed report.  You   configure the zoom percentage in the Page Setup 
dialog box.

Print

Click to print the previewed report directly from the Print Preview   dialog box.

Setup

Click to open the Page Setup dialog box and modify any Page Orientation,   Page Margins, Header and 
Footer Display, or Preview Zoom options.

Close

Closes the Print Preview screen and returns you to the Print dialog   box.

Quick Report Dialog Box

The Quick Report dialog box displays the following items:

All Tags

Select this option to search for all tags contained in the selected   picture, schedule, User Global, or 
object.

© 2020 General Electric Company. All rights reserved. 57



One Tag (Button)

Select this option to search for a specific tag, tag substitution, or   symbol in the selected picture, sched-
ule, User Global, or object and all   Tag Group Definition files.  

Enter a specific tag, tag substitution, or symbol in the Tag field or   click the Browse (…) button to open the 
Expression Editor.   

Tag (Edit Box)

Enter a specific tag, tag substitution, or symbol in the Tag field or   click the Browse (…) button to open the 
Expression Builder.  

NOTE:  Do   not use a * wildcard in this field.  Entering   a wildcard returns a Search completed with no output 
error. 

Text (Button)

Select this option to search for text in object names, property names,   and property values in the selected 
object.  

Enter a text string that would appear in the Object, Property, Property   Value, Resolved, or Tag Group 
File name columns in the Text field.  To   return a list of all objects, leave <ALL> in the Text field.  

Text (Edit Box)

Leave <ALL> or clear the field to return a list of all objects.    To search   for specific objects, enter a text 
string that would appear in the Object,   Property, Property Value, Resolved, or Tag Group File name 
columns. 

NOTE:  Do   not use a * wildcard in this field.  Entering   a wildcard returns a Search completed with no output 
error. 

Dynamos

Select this option to search for Dynamo objects in a selected picture,   or pictures containing Dynamo 
objects from a selected Dynamo Set. The   type of object you select in the Object Tree determines which 
search is   conducted.

Search 

Generates the Quick Report based on the settings and selections you   have chosen.

NOTE: You can   also generate the Quick Report by double-clicking an object in the Object   Tree.

Options

Opens the Quick Report Options dialog box.

Quick Report Options Dialog Box

The Quick Report Options dialog box displays the following items:

Resolve Tags Using All Tag Groups

If the selected picture or object contains Tag Group symbols, this option   resolves those symbols by 
attempting to match the symbols with all tag   group files and find all substitutions.  This   option is 
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available for all search types.  

Include VBA Scripts in Search

Select this option to allow the Cross Reference Tool to search for the   tag(s) through scripts within the 
selected file. Both the All Tag and   One Tag searches return the tag, if found. The Text search returns all   
lines of script.   

Include Summary

Select this option to add a summary report to the end of the Cross Reference   Report detailing the num-
ber of objects and tags searched.  This   option is not available for a One Tag search.  

Automatically Resize Report Columns

Select this option to automatically resize the Report Results columns   to accommodate the text.  

Append to Status Trail

Select this option to add any new tracking information to the existing   status trail, if enabled.  If   disabled, 
each time a search runs, all previous tracking information is   overwritten by the new status trail.  

 

How Do I...

Click the appropriate link below for information about Cross Reference   Tool's step-by-step procedures:

 l Generating   a Report Using the Quick Report Dialog Box

 l Generating   a Report Using the Report Wizard

 l Resolving   Tags During a Search using Tag Group Files

 l Searching   through VBA Scripts

 l Configuring   Report Output Settings

 

Generating a Cross Reference Report Using the Quick Report Dialog Box

 To generate a   Cross Reference Report using the Quick Report dialog box:

 1. In Classic view,   from the WorkSpace toolbar, click the Cross Reference Tool button. 

-Or-

In Ribbon view, on the Applications tab,   in the Utilities group, click Utilities, and then click Cross 
Reference   Tool. 

 2. On the File menu,   click Quick Report. 

By default, the Quick Report dialog box   also appears when you open the Cross Reference Tool.

 3. From the Object Tree,   select a picture or object. To search through multiple pictures or objects,   
use the Report Wizard.
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 4. Choose to search   for All Tags, One Tag, Text, or Dynamos in the selected object. 

 5. Click the Options   button and select from the following search options from the Quick Report   
Options dialog box, if applicable:

 l Resolve   Tags using All Tag Group Files – If the selected picture or object   contains Tag 
Group symbols, this option resolves those symbols by attempting   to match symbols with 
the Tag Group Definition file and find all substitutions.   This option is available for all 
Search types. 

 l Include   VBA Scripts in Search – Allows the Cross Reference Tool to search   through 
scripts within the selected file for the tag(s). 

 l Summary   Report – Includes a Summary Report at the end of the Cross Reference   
Report.

 l Automatically   Resize Report Columns – Automatically resizes the columns in the   
Report Results section to accommodate the text. 

 l Append   to Status Trail – If enabled, the status trail adds any new tracking   information to 
the existing status trail. If disabled, each time the report   runs, all previous tracking inform-
ation is overwritten by the new status   trail. 

 6. Click OK to close   the Quick Report Options dialog box.

 7. Click Search to generate   the report.

NOTE:   You cannot access the iFIX WorkSpace while the Cross Reference   Tool generates a report. 
Once the report completes, you will be able to   access the iFIX WorkSpace again.

 
 

Generating a Cross Reference Report Using the Report Wizard

 To generate a   Cross Reference Report using the Report Wizard:

 1. In Classic view,   from the WorkSpace toolbar, click the Cross Reference Tool button. 

-Or-

In Ribbon view, on the Applications tab,   in the Utilities group, click Utilities, and then click Cross 
Reference   Tool. 

 2. On the Tool menu,   click Report Wizard. 

 3. On the Search Settings   tab, select what you would like to search for: All Tags, One Tag, Text,   
Dynamos in Pictures, or Pictures Containing Dynamos. 

 4. Select any of the   Search Options, if appropriate. 

 5. Click Next to proceed   to the Pictures Files Tab. This tab allows you to select multiple picture   files 
to search through when the report generates. You can change the   order of the search hierarchy by 
selecting the appropriate file and clicking   the up and down arrow buttons. 

NOTE:   The Cross Reference Tool opens any closed files that are selected for   report generation. 
When the report finishes, these files are closed again.
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 6. Click Next to proceed   to the Schedule Files Tab. This tab allows you to select multiple schedule   
files to search through when the report generates. You can change the   order of the search hier-
archy by selecting the appropriate file and clicking   the up and down arrow buttons. 

 7. Click Next to proceed   to the Dynamo Sets Tab. This tab allows you to select multiple Dynamo   
files to search through when the report generates. You can change the   order of the search hier-
archy by selecting the appropriate file and clicking   the up and down arrow buttons. 

 8. Click Next to proceed   to the Report Settings tab. This tab allows you to select any appropriate   
Report Output options. 

 9. Optionally, select   the Include Summary option. This option adds a summary report to the end   of 
the report that details the number of objects and tags searched. 

 10. Optionally, select   the Automatically Resize Report Columns option. Enabling this option auto-
matically   resizes the columns in the Report Results display and printed report to   accommodate 
the text.

 11. Click Next to proceed   to the Apply and Go tab. This tab allows you to review all the settings   you 
have configured throughout the wizard. 

TIP: If   you need to make any changes, click the Back button to return to the appropriate   tab.

 12. Click OK to generate   the Report. You cannot access the iFIX WorkSpace while the Cross   Refer-
ence Tool generates a report. Once the report completes, you will   be able to access the iFIX 
WorkSpace again.

TIP: If   the progress bar stops during report generation, an error message may   have appeared in the 
background. Click in the Cross Reference Tool to   move the Cross Reference Tool error dialog box to 
the foreground and acknowledge   the error.

The output from the report displays in the   Cross Reference Tool screen. If you configured Save 
Report to File or   Print Report, those automatically occur. Once the results from the Report   
appear, you can also save or print the report manually from the toolbar   buttons in the Cross Refer-
ence screen. 

Resolving Tags During a Search Using All Tag Group Files

 To resolve tags   during a search using all Tag Group Files:

 1. In Classic view,   from the WorkSpace toolbar, click the Cross Reference Tool button. 

-Or-

In Ribbon view, on the Applications tab,   in the Utilities group, click Utilities, and then click Cross 
Reference   Tool. 

 2. From the File menu,   select Quick Report. 

-Or-

From the Tool menu, select Report Wizard.   

 3. In the Quick Report   Options dialog or Search Options section, select the Resolve Tags using   All 
Tag Group Files option. 

If the selected picture or object contains   Tag Group symbols, this option resolves those symbols 
by attempting to   match symbols with the Tag Group Definition file and find all substitutions.   The 
Resolve Tags using All Tag Group Files option is available for all   Search types. 
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Searching Through VBA Scripts

 To search through   VBA scripts:

 1. In Classic view,   from the WorkSpace toolbar, click the Cross Reference Tool button. 

-Or-

In Ribbon view, on the Applications tab,   in the Utilities group, click Utilities, and then click Cross 
Reference   Tool. 

 2. From the File menu,   select Quick Report.  

-Or-

From the Tool menu, select Report Wizard.    

 3. In the Quick Report   Options dialog or Search Options section, select the Include VBA Scripts   in 
Search option. This option allows the Cross Reference Tool to search   through scripts within the 
selected picture for the tag(s). 

Configuring Report Output Settings

 To configure   report output settings:

 1. In Classic view,   from the WorkSpace toolbar, click the Cross Reference Tool button. 

-Or-

In Ribbon view, on the Applications tab,   in the Utilities group, click Utilities, and then click Cross 
Reference   Tool. 

 2. From the Tool menu,   select the Report Wizard. 

 3. The Report Settings   tab of the Cross Reference Report Wizard allows you to configure the fol-
lowing   settings:

Report Output Settings

Option Description

Save Report to File Automatically saves the report when the report 
generation   completes. Save the report to the 
default file and location listed, enter   one directly 
into the Save Report to File field, or click the 
Browse (…)   button to locate a file or path. Avail-
able file types are *.csv, *.htm,   *.xls, or *.tb2.

Save Status Trail Saves the status trail information when the report   
completes. Save the report to the default file and 
location listed, enter   one directly into the Save 
Status Trail field, or click the Browse (…)   button to 

62 © 2020 General Electric Company. All rights reserved.



locate a file or path. The available file type for this 
file   is *.txt.

Print Report Automatically prints the report when complete. 
Click   the Advanced button to modify Print set-
tings.

Report Option

Option Description

Include Summary Adds a summary report to the end of the report 
that   details the number of objects, number of 
tags, and VBA project reference   information.

View Option

Option Description

Automatically Resize Report Column Automatically resizes the columns in the Report 
results   to accommodate the text.

 

Modifying Print Options

Click the appropriate link below for information on modifying print   options:

 l Selecting   Print Options and Printing a Report

 l Selecting   Page Options for Printing

 l Customizing   Your Header or Footer Text

 

Selecting Print Options and Printing a Report

 To select print   options and print a report:

 1. In Classic view,   from the WorkSpace toolbar, click the Cross Reference Tool button. 

-Or-

In Ribbon view, on the Applications tab,   in the Utilities group, click Utilities, and then click Cross 
Reference   Tool.

 2. Perform one of the   following sets of steps:

 l In the Object   Tree pane, select an object with a report that you want to print.

 l On the File menu,   click Print.  

- Or -
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 l From the Tool   menu, select Report Wizard.  

 l From the Report   Settings tab, select the Print Report option, and click the Advanced but-
ton.    

 2. Select a Print Range.

 3. Click Page Setup.    

 4. Configure the page   settings and click OK to return to the Print dialog box.

 5. Optionally, select   any of the following Print Options:

 l Column   Headers – Prints column headers at the top of each page.

 l Row   Headers – Prints row headers on the left side of each page. 

 l Grid   Lines – Prints spreadsheet grid lines.

 l Border   – Prints the spreadsheet border.

 l Data   Cells Only – Does not print empty cells beyond the last column   and row containing 
data.

 l Screen   Image Color – Prints colors in the spreadsheet as they appear on   the screen.

 l Shadows   – Prints the shadow effect in the column and row headers.

 5. Optionally, click   the Printer Setup button to modify the current printer and printer options.

 6. Click the Print Preview   button to view how the Report will appear when printed. 

 7. Click the Close button   to return to the Print dialog box.

 8. Click OK. 

If you accessed the Print dialog box from   the Cross Reference Report Wizard, clicking OK 
returns you to the wizard.   If you accessed the Print dialog box on File menu by clicking the Print   
option, clicking OK prints the report. 

 

Selecting Page Options for Printing

 To select page   options for printing:

 1. In Classic view,   from the WorkSpace toolbar, click the Cross Reference Tool button. 

-Or-

In Ribbon view, on the Applications tab,   in the Utilities group, click Utilities, and then click Cross 
Reference   Tool. 

 2. Perform one of the   following sets of steps:

 l In the Object   Tree pane, select an object with a report that you want to print.

 l On the File menu,   click Print.  

-Or-

 l From the Tool   menu, select Report Wizard.  

 l From the Report   Settings tab, select the Print Report option, and click the Advanced but-
ton.    
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 3. Click the Page Setup   button.  

TIP:   You can also access the Page Setup dialog box by clicking the Setup button   in the Print Preview 
screen.

 4. Select either Portrait   or Landscape for the Page Orientation.

 5. Modify the Page Margins,   if necessary.

 6. Optionally, you can   modify the Header and Footer text and display.  To   do this:

 l Click the Change   Header and Footer Attributes button.  .

 l Modify the Header   and Footer text and display attributes you would like to change.

 l Click OK to save   the changes and return to the Page Setup dialog box.

 7. From the Preview   Display Range drop-down menu, select a display setting. This setting determ-
ines   the percentage of or number of pages displayed in the Print Preview screen.

 8. Click OK to save   changes and exit the Page Setup dialog box.

 

Customizing Header or Footer Text

 To customize   header or footer text:

 1. In Classic view,   from the WorkSpace toolbar, click the Cross Reference Tool button. 

-Or-

In Ribbon view, on the Applications tab,   in the Utilities group, click Utilities, and then click Cross 
Reference   Tool. 

 2. Perform one of the   following sets of steps:

 l In the Object   Tree pane, select an object with a report that you want to print.

 l On the File menu,   click Print.  

-Or-

 l From the Tool   menu, select Report Wizard.  

 l From the Report   Settings tab, select the Print Report option, and click the Advanced but-
ton.    

 3. Click the Page Setup   button.  

TIP:   You can also access the Page Setup dialog box by clicking the Setup button   in the Print Preview 
screen.

 4. Click the Change   Header and Footer Attributes button.  

 5. In the Apply to area,   select the Header Text or Footer Text option.

 6. Enter text in the   appropriate column. For example, if you want text to be centered in the   header, 
enter that text in the Center column. 

To select from some pre-configured common   Header or Footer options, select a cell in the table 
and right-click it.   The display toggles through a list of options including:

 l <Default   Header> – Inserts the Report Title including the picture name,   date, and time.

 l <Time>   – Inserts a time stamp (date and time).
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 l <Page   Number> – Inserts the current page number. 

 4. Optionally, click   the Browse (…) button to modify the Font characteristics.

 5. Click OK to save   your changes.

Creating Picture-specific Help Files 

Picture-specific Help files are an efficient means of bringing more   information to operators electronically 
without taking up valuable display   space. This section describes how to add your own context-sensitive 
Help   files to iFIX pictures. It includes the following sections:

 l Why   Create Picture-specific Help Files?

 l What's   This? Help

 l Adding   Help to an iFIX Picture

 l Creating   the Help File

 l Example:   Creating a Picture-specific Help File

 

Why Create Picture-specific Help Files?

There are several reasons why you might want to create a picture-specific   Help file. For example, you 
may want to provide operators with concise   answers to the following questions:

 l What piece of equipment   does this object represent? 

 l Where is this equipment   located? 

 l What does this equipment   control? 

 l Who is the manufacturer   of this equipment? 

 l What are the Standard   Operating Procedures (SOPs) for this picture? 

In general, if you develop pictures that need to provide operators with   equipment-specific information or 
sets of instructions, you should consider   creating picture-specific Help files. For example, you are devel-
oping   a picture that contains a pump. You can design the picture so that when   operators click the pump 
and press SHIFT+F1,   they receive a pop-up with information about the pump's manufacturer,   voltage, 
amp rating, and horsepower. 

Similarly, you can use picture-specific Help to develop training screens   for new operators. If you were 
developing a training screen for the pump   picture in the previous example, you could display Help pop-up 
windows   containing such basic information as how to know when the pump is on or   off, and when it is 
operating properly.

What's This? Help 

Context-sensitive Help within a picture is in the form of What's This?   Help. What's This? Help is a 
simple but highly useful form of Help that   is designed to allow operators to quickly access Help inform-
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ation and   return to their work. To get What's This Help on an object within an iFIX   picture in run mode, an 
operator presses SHIFT+F1,   points and clicks on the object, and a brief explanation appears. 

Example

In the following example, an operator has pressed SHIFT+F1   in a picture while in run mode. The mouse 
cursor changes to the What's   This? Help pointer.
   

While in What's This? Help mode, operators can click any object in the   picture (or even the picture itself) 
for a Help pop-up window on that   object.
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What's This? Help Design 

The iFIX WorkSpace supports What's This? Help in two different types   of compiled formats: Winhelp 
(*.hlp) and HTML Help (*.chm). A Winhelp   .hlp file consists of the following source files: a project file, a 
topic   file, and a map file. An HTML Help .chm file consists of the following   source files: a project file, a 
topic file, a map file, and, an alias   file.

The Help project file contains the Help file's project options, such    as the source files to include and com-
pile, the name of the Help file,   and so forth. The topic file contains the content that you want to display   in 
the pop-up window when you invoke What's This? Help. The map file is   a header file that creates an 
association between the object that you   want to provide Help for and the topic within the Help file. In 
HTML Help,   the alias file works in tandem with the map file to associate the object   name with a specific 
HTML file name (you can map one or more objects to   the same file name). In Winhelp, the alias file is an 
optional tool to   help you map the same topic content to multiple objects. 

What's This? Help files are not difficult to create, since you only   have to specify a couple of Help project 
options in order to build a useful   context-sensitive Help file. The following table provides an overview   of 
the minimum file types you need to create a What's This? Help project   for use with iFIX.

Help Component Winhelp HTML Help 

Project File *.hpj *.hhp

Content File *.rtf *.htm

Map File *.h *.h

Alias File (optional for Winhelp) *.h *.h
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Adding Help to an iFIX Picture 

First, specify the Help file name in the HelpFile property of your picture.

 To specify the Help file name: 

 1. Right-click a blank   space within the picture and   select Properties from the pop-up menu. The 
Properties dialog box appears   with the name of the CFixPicture object as the active object. 

 2. In the HelpFile property   cell, specify the name of the Help file that contains your context-sens-
itive   topics. If you copied this file to a path other than the default path   (for example: C:\Program 
Files (x86)\GE\iFIX, or C:\Program Files (x86)\GE\iFIX\PIC), you need to include the path to the 
help file   as well.

Refer to the Creating   Picture-specific Help Files section for examples on how to create   the Help 
file. 

 3. Save the picture.   

Next, assign a unique number, called a Help context   ID, to each object in your picture that you want the 
operator to   be able to get Help on. 

 To assign a Help context ID: 

 1. Right-click each   object in your picture (including the picture itself) for which you want   to write a 
Help topic and select the Property Window command. The Properties   window appears with the 
name of the selected object as the active object.   

 2. Set the ContextID   property to the desired number. Remember that all context IDs within the   
same Help file must   be unique. These values are used by the Help (Winhelp or HTML Help) 
application   to correctly display the Help topic that is associated with the control.   If two controls 
have the same context ID, the Help compiler displays an   error message. 

Finally, you need to make any object that you want an operator to be   able to get Help on selectable. 

 To make the object selectable so   that the operator can view the help: 

 1. Right-click each   object in your picture (including the picture itself) for which you want   to write a 
Help topic and select the Property Window command. The Properties   window appears with the 
name of the selected object as the active object.   

 2. Set the IsSelectable   property to True. 

 

Creating the Help File 

This chapter discusses how to create the source files that comprise   a picture-specific Help file, and also 
provides all of the steps required   to successfully implement What's This? Help into iFIX pictures. It 
includes   the following sections:
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 l Requirements

 l Creating   a Topic File

 l Creating a Map and Alias File

 l Creating   and Compiling a Project File

 l Testing   Your Help File

 

Requirements

The requirements for creating a picture-specific What's This? Help files   in iFIX are different for Winhelp 
and HTML Help. The sections below describe   what each type of Help project requires.

HTML Help

 l A text editor such   as Notepad (to create or modify .htm and .h files).

 l Microsoft® HTML Help   Workshop, version 1.31 or higher . If you do not have Microsoft HTML 
Help   Workshop, you can obtain the latest version from Microsoft at this location:   http://msdn.-
microsoft.com/library/default.asp?url=/library/en-us/htm-
lhelp/html/hwmicrosofthtmlhelpdownloads.asp.   

 

Creating a Topic File 

When creating What's This? Help topic files, keep in mind that each   topic must contain a unique topic 
ID number. The Help application   needs a unique ID to display topics correctly. The steps below describe   
how to create a new topic whether you are using Winhelp or HTML Help.   

 To create a simple   Winhelp topic file (.rtf) in Microsoft Word: 

 1. Open Microsoft® Word.

 2. Create a new document.

 3. From the Insert menu,   click Footnote. The Footnotes and End Note dialog box appears.

 4. Select the Custom   Mark option button, enter a pound sign (#) in the adjacent field, and   click OK. 
The document window displays a footnote area. 

 5. In the footnote area,   enter a unique context string to the right of the pound sign. Do not include   
spaces in the context string. One common method is to use underscores   for more descriptive 
context strings, such as: 
water_pump_onoff_btn

 6. Click the Close button   on the footnote pane to close the footnote area and return to a full-screen   
document window. (To view the footnote text again, double-click the footnote   symbol at the top of 
the topic.) 

 7. To the right of the   footnote symbol, on the main page, enter the information that you want   to 
appear in the Help pop-up window. 
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NOTE:   If you want to create more topics, repeat steps 2-5 for each topic. Additionally,   add a manual 
page break between the topics. Each topic must appear on   a separate page in the .RTF file.  (In   
Microsoft Word, select Ctrl+Enter to create a manual page break between   Help topics.) 

 8. Save the document   as an .RTF file. 

 To create a simple   HTML Help topic file (.htm) in a text editor: 

 1. Open a text editor,   such as Notepad.

NOTE:   Optionally, you can use an HTML Editor such as Macromedia® HomeSite® or   Microsoft® 
FrontPage®. This allows you to add more formatting to your   HTML page, without requiring a lot of 
knowledge of how to use HMTL tags.

 2. Copy (CTRL+C)   the following text to the Windows clipboard, and paste (CTRL+V)   it into your 
text editor:
<HTML>
<HEAD>
<TITLE>Title 1</TITLE>
</HEAD>
<body>
 
<H1><font face="Arial">Title 1 </font> </H1>
<P><font face="Arial">Paragraph 1 </font> </P>
</BODY>
</HTML>

 3. Enter a title (heading)   in the two "Title 1" sections, shown bolded above. 

 4. Replace "Paragraph   1" (shown bolded above) with the rest of the information that you   want to 
appear in the Help pop-up window. 

 5. Save the file.

 

Creating a Map and Alias File 

In order for the Help application to display the correct Help pop-up   window when you select SHIFT+F1   on 
a particular object, you must associate each unique topic ID name with   its corresponding Help context 
ID number (defined in the property page   of an object). This association, or mapping,   is done in the MAP 
section of a Help project file. The easiest way to   map these values is to create a header file (.h) in a text 
editor and   include that header in the MAP section. 

Additionally, in HTML Help only, the next step is to create an alias   (.h) file to map the ID number to an 
.htm file name. This file name is   included in the ALIAS section of the Help project.

NOTE: The alias   file is optional in Winhelp. It's not an integral component for the context-sensitive   Winhelp, 
like it is for HTML Help. If you use Robohelp to create your   HTML Help files, your aliases are stored in a .ali 
file instead of the   default .h file that Microsoft Help WorkShop uses.

 To create a header   file with the context IDs (for both Winhelp & HTML Help): 

 1. Create a new text   file in a text editor, such as Notepad.

 2. In the text file,   associate each topic ID name with an object's context ID number using   the fol-
lowing format: 
#define <topic ID name> <context ID number>
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For example, in the iFIX WorkSpace, if you   defined the HelpContextID property of the pump in 
the previous example   as 1000, it would appear in the header file as:
#define water_pump_onoff_btn 1000

 3. Continue to add these   define statements, one per line, until all of your Context IDs have been   
added to the header file. 

 4. Save the file as   a text-only file and provide it with an .h file name extension. 

 To create an   alias file with additional ID mapping (for HTML Help only): 

 1. Create a new text   file in a text editor, such as Notepad.

 2. In the text file,   associate each topic ID name with an object's HTML file name using the   following 
format: 
<topic ID name>=<HTML File Name>

For example, if the HTML file name of the   pump in the previous example is water_pump_onoff_
btn.htm, it would appear   in the alias file as:
water_pump_onoff_btn = water_pump_onoff_btn.htm

 3. Continue to add these   statements, one per line, until all of your topics IDs have an associated   
HTML file name. 

 4. Save the file as   a text-only file and provide it with a .h file name extension. 

 

Creating and Compiling a Project File 

The final step is to create a Help project file that allows you to compile   the map file(s) and topic files into 
one binary Help file. At a minimum,   the steps you need to perform include:

 l For HTML   Help, you need to create a .hhp project file, add your .htm files    with the content, add 
the .h file with the ID numbers, add your .h file   with the aliases, define a default window type, and 
then save and compile   the help project. 

Creating and Compiling a   Simple Help Project

 To create and   compile the project file in Winhelp: 

 1. In Microsoft Help   Workshop, from the File menu, click New. The New dialog box appears.

 2. Select Help Project   and click OK. The Project Name dialog box appears.

 3. Type or browse for   a path location, and enter a file name. Remember to use the same Help   file 
name that you specified in the picture's Properties dialog box. 

 4. Click Save. 

 5. Click the Options   button. The Options dialog box appears.

 6. Select the General   tab, and then, in the Help Title field, enter the name you want to appear   in the 
title bar of your Help system. 

 7. Select the Files   tab and click Change. The Topic Files dialog box appears.
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 8. Click the Add button   and browse for the .rtf file that includes your Help topics. Click OK   when you 
are complete.

 9. From the Options   dialog box, click OK.

 10. Click the Map button.   The Map dialog box appears. 

 11. Click Include. The   Include File dialog box appears.

 12. Browse and select   the header file that includes all of your map statements. Click OK to   exit the 
Include File dialog box, and click OK again to save your changes   to the Map dialog box. 

 13. When you are ready   to compile, click the Save and Compile button. 

 To create and   compile the project file in HTML Help: 

 1. In the Microsoft   HTML Help Workshop, from the File menu, click New. The New dialog box   
appears.

 2. In the list box,   select Project and click OK. The New Project wizard appears.

 3. Leave the Convert   Winhelp Project check box cleared, and click Next. The New Project - Destin-
ation   screen appears in the wizard.

 4. In the edit box,   enter the location and name that you want your Help project to use. Remember   to 
use the same Help file name that you specified in the picture's Properties   dialog box. 

 5. Click Next. The New   Project - Existing Files screen appears in the wizard.

 6. Select the HTML Files   (.htm) check box, and click Next. The New Project - HTML Files screen   
appears in the wizard. 

 7. Click Add. The Open   dialog box appears.

 8. Browse to and select   the HTML file(s) that you want to add to your project and click Open to   
return to the New Project - HTML Files screen.

 9. Click Next. The New   Project - Finish screen appears in the wizard.

 10. Click Finish.

 11. Click the HTML Help   API Information button (the fourth button down, on the Project tab). The   
HTML Help API Information dialog box appears.

 12. From the Map tab,   click the Header File button. The Include File dialog box appears.

 13. Enter or browse to   select the path and file name of your .h file.

 14. Click OK.

 15. Click the Alias tab,   and then click the Include button. The Include File dialog box appears.

 16. Enter or browse to   select the path and file name of your .ali file.

 17. Click OK, and then   click OK again to close and save the information in the HTML Help API   
Information dialog box. After you do that, you will notice two new sections   in your help project: 
[ALIAS] and [MAP].

 18. Click the Add/Modify   Window Definitions button (the third button down, on the Project tab).   The 
Add a New Window Type dialog box appears.

 19. Enter a name for   your default window. For example, you may want to create a window named   
main. After you do that, click   OK. The Window Types dialog box appears.
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 20. Click the Position   tab, and then click the Autosizer button. The Autosizer dialog box appears.

 21. Drag the dialog box   and its corners until the box appears where you want topics to display   on your 
screen, by default, and click OK.

 22. On the Window Types   dialog box, click OK.

 23. Click the Save All   Files and Compile button (the bottom button on the Project tab). 

How to Compile from a Command Line

As an alternative, you can also build and compile a   Help system from the command line. If you are build-
ing more complex help   systems, you may find the command line options helpful.

Use these steps if you already created a .hpj or .hhp   file and just want to build and compile an updated 
version. From the DOS   prompt or from within a batch file, use the following commands to build   and com-
pile your help:

 To build and   compile Winhelp from the command line: 

Type this command to build and compile a   help file:
hcrtf -xn "C:\MyFolder\ProjectName.hpj"

In this example, replace C:\Myfolder   with the path of your Help project and replace Pro-
jectName.hpj   with the name of your help project. The -xn option, in this example, builds   the help 
file without displaying the Help Workshop window. Refer to the   Microsoft Help Workshop online 
Help for detailed information on command-lines   and options.

 To build and   compile HTML Help from the command line: 

Type this command to build and compile a   help file:
hhc "C:\MyFolder\ProjectName.hhp"

In this example, replace C:\Myfolder   with the path of your Help project and replace Pro-
jectName.hhp   with the name of your help project. Refer to the Microsoft HTML Help Workshop   
online Help for detailed information on command-lines and options.

 

Testing Your Help File

After you create the Help file, you should test it within your application.

 To test your Help file: 

 1. Copy your compiled   Help file to the iFIX base path or PIC path. By default, this path is:  C:\Pro-
gram Files (x86)\GE\iFIX\PIC. 

 2. Follow the steps   in the Adding Help to   an iFIX Picture section to create a picture with context-
sensitive   help information, if you have not already created one.

 3. In the iFIX   WorkSpace run-time environment, open your Help-enabled picture. 

 4. Press SHIFT+F1.   The cursor changes to a question mark pointer, indicating that it is in   What's 
This? Help mode. 
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 5. Click an object to   which you assigned a Help context ID. The Help topic that you assigned   to the 
object displays in a pop-up window. To dismiss the Help pop-up   window, click anywhere on the 
screen. 

Example: Creating a Picture-specific Help File

This section serves as a mini-tutorial that walks you through the complete   process of creating a sample 
Help file and assigning it to a picture.   For clarity, this example assumes that iFIX is installed to the 
C:\Program Files (x86)\GE\iFIX path and that you are developing your Help   file in a working directory 
entitled C:\Program Files (x86)\GE\iFIX\HELP TEST. 

HTML Help Example

 To create the   HTML content in a text editor: 

 1. Open a text editor,   such as Notepad.

 2. Copy (CTRL+C)   the following text to the Windows clipboard, and paste (CTRL+V)   it into your 
text editor:
<HTML>
<HEAD>
<TITLE>Title 1</TITLE>
</HEAD>
<body>
 
<H1><font face="Arial">Title 1 </font> </H1>
<P><font face="Arial">Paragraph 1 </font> </P>
</BODY>
</HTML>

 3. For the two "Title   1" sections, shown bolded above, enter "My Square."

 4. Replace "Paragraph   1" (shown bolded above) with the following:
This is the Help topic for my square.

 5. Save the file as   SQUARE.htm in the C:\Program Files (x86)\GE\iFIX\HELP TEST folder.

 To assign the HTML Help file, context   ID, and set the IsSelectable property: 

 1. In the iFIX WorkSpace   configure mode, open a new iFIX picture. 

 2. Right-click the picture   and select the Property Window command. 

 3. In the HelpFile property   field, enter the following text: 
square.chm

 4. Click the Rectangle   button on the Toolbox and draw a rectangle. 

 5. Right-click the rectangle   and select the Property Window command. 

 6. In the ContextID   property field, enter the following number: 
1000

 7. Set the IsSelectable   property field to True. 

 8. Save the picture   with the name HELPTEST. By default, iFIX saves the picture to this folder:   
C:\Program Files (x86)\GE\iFIX\PIC.
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 To create a map   file and alias file for HTML Help: 

 1. Create a new text   file in a text editor, such as Notepad.

 2. In the text file,   enter the following information: 
#define square 1000

 3. Save the file as   SQUARE.h in the C:\Program Files (x86)\GE\iFIX\HELP TEST folder.   

 4. Create another new   text file in a text editor, such as Notepad.

 5. In the text file,   enter the following information: 
square = SQUARE.htm

 6. Save the file as   MYALIASES.h in the C:\Program Files (x86)\GE\iFIX\HELP TEST folder.   
 To create and build the HTML Help   project file: 

 1. In the Microsoft   HTML Help Workshop, from the File menu, click New. The New dialog box   
appears.

 2. In the list box,   select Project and click OK. The New Project wizard appears.

 3. Leave the Convert   Winhelp Project check box cleared, and click Next. The New Project - Destin-
ation   screen appears in the wizard.

 4. In the edit box,   enter the location and name that you want your Help project to use: C:\Program 
Files (x86)\GE\iFIX\HELP TEST\SQAURE.HHP

 5. Click Next. The New   Project - Existing Files screen appears in the wizard.

 6. Select the HTML Files   (.htm) check box, and click Next. The New Project - HTML Files screen   
appears in the wizard. 

 7. Click Add. The Open    dialog box appears.

 8. Browse to and select   the following file: C:\Program Files (x86)\GE\iFIX\HELP 
TEST\SQAURE.htm.   Click Open to return to the New Project - HTML Files screen.

 9. Click Next. The New   Project - Finish screen appears in the wizard.

 10. Click Finish.

 11. Click the HTML Help   API Information button (the fourth button down, on the Project tab). The   
HTML Help API Information dialog box appears.

 12. From the Map tab,   click the Header File button. The Include File dialog box appears.

 13. Click Browse to select   the SQUARE.h file in your C:\Program Files (x86)\GE\iFIX\HELP TEST   
folder. 

 14. Click OK.

 15. Click the Alias tab,   and then click the Include button. The Include File dialog box appears.

 16. Click Browse to select   the MYALIASES.h file in the C:\Program Files (x86)\GE\iFIX\HELP   
TEST folder. 

 17. Click OK, and then   click OK again to close and save the information in the HTML Help API   
Information dialog box. After you do that, you will notice two new sections   in your help project: 
[ALIAS] and [MAP].
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 18. Click the Add/Modify   Window Definitions button (the third button down, on the Project tab).   The 
Add a New Window Type dialog box appears.

 19. Enter a name for   your default window. For example, you may want to create a window named   
main. After you do that, click   OK. The Window Types dialog box appears.

 20. Click the Position   tab, and then click the Autosizer button. The Autosizer dialog box appears.

 21. Drag the dialog box   and its corners until the box appears where you want topics to display   on your 
screen, by default, and click OK.

 22. From the Window Types   dialog box, click OK.

 23. Click the Save All   Files and Compile button (the bottom button on the Project tab). 
 To test the HTML Help file: 

 1. Copy the SQUARE.CHM   Help file to the C:\Program Files (x86)\GE\iFIX\PIC directory. 

 2. In the iFIX   WorkSpace, open the HELPTEST picture. 

 3. If you are not already   in run mode, on the WorkSpace menu, select Switch to Run (Classic view)   
or on the Home tab, in the WorkSpace group, click Switch to Run (Ribbon   view).

 4. Press SHIFT+F1.   The cursor changes to a question mark pointer, indicating that it is in   What's 
This? Help mode. 

 5. Click the rectangle.   A Help pop-up window with the following text appears: 
My Square
This is the Help topic for my square.

 

Customizing the System Tree 

CAUTION: The instructions in this section are strictly intended for users who are creating their own custom 
installation DVD. We strongly discourage customizing your system tree under any other circumstances. This 
information is meant for advanced users only. 

The iFIX WorkSpace system tree is the main tool for locating files and launching applications. It also 
provides access to your files and applications during the development of your pictures and schedules.  

Depending on your needs, you may want to remove certain applications or folders or add new ones. For 
example, you may want to add a custom application to the system tree. On the other hand, if you did not 
purchase FIX SCADA support, you may want to delete the Database Manager application and I/O 
Drivers folder.

You can customize the system tree by modifying the text file SystemTree.CSV. This file defines the 
folders, applications, and files that appear when you start the iFIX WorkSpace. The file resides in the 
Local path.

CAUTION: Any changes made to the SystemTree.CSV file are done so at your own risk. All changes made to 
the system tree are permanent. We recommend making a backup copy of the SystemTree.CSV file that, if 
necessary, can be used to reset the system tree to its default settings.

NOTE: We recommend using Microsoft Excel when editing the SystemTree.CSV file. When saving the file in 
Excel, be sure to save it with a .CSV extension. If prompted to save the file in Microsoft Excel Workbook 
format, select No. If the SystemTree.CSV file is saved incorrectly, the system may not be usable. When editing 
the file, you must use a comma (,) as the list separator. Other characters, such as the international list 
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separator (;) cannot be used as the list separator in the SystemTree.CSV file. To view or modify the list sep-
arator setting on your system, double-click the Regional Settings icon in the Control Panel and click the Num-
ber tab.

The SystemTree.CSV file is divided into two sections. The top section defines the folders in the system 
tree and the bottom section defines the files. Within each of these sections are attributes that determine 
how a folder or file appears in the system tree. For example, the Key field contains the name of the file or 
folder as it appears in the system tree, and the Key Type field defines whether it is a folder or file. The 
remaining attributes have Entry and Value fields. The Entry field holds the name of the attribute and the 
Value field defines the corresponding attribute value. The attributes for folders and files are defined in the 
Folder Attributes and File Attributes tables.

NOTE: Although not all of the attributes in this file need to be defined, it is important to note that if the Entry 
field is completed for an attribute, the corresponding Value field must also be completed.  

When you are ready to customize the SystemTree.CSV file, refer to the following figure for an overview 
of the required steps.

System Tree Customization Overview

Adding Folders to the System Tree 

You can add folders to the system tree by editing the top section of   the SystemTree.CSV file. Use the 
Folder   Attributes table as a guide to editing the file.
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 To add a folder to the system tree:   

 1. Open the SystemTree.CSV   file located in the Local path. 

 2. Insert a row within   the Define GE Folder section. 

 3. Enter the information for the folder in the attribute   fields. For example, to add a folder named 
Events that contains event   files enter the following (leave unused fields blank): 

For the attribute... Enter...
Description Events
Folders Folder
Extension Entry Extension
Extension of the files for this folder Evt
AutoFind Entry AutoFind
Used to find, create, and populate this folder   on startupTRUE
Fix Path Entry Fix Path
Default path for files in this folder ALM_PATH

 4. Save the file in   the Local path with a .CSV extension. 

 5. Close the    iFIX WorkSpace. 

 6. Click the Start button,   and then click Run.  In   the Open field, type Regedit.   Find   HKEY_
CLASSES_ROOT\FIX32\BrowseTree\LocalNode.  Delete    the LocalNode branch.

 7. Click the Start button,   and then click Run.  In   the Open field, type WorkSpace /regserver.

 8. Click OK. 

 9. Restart the   iFIX WorkSpace. 

Folder definitions include the attributes in the following table. 

The attrib-
ute...

Defines...

Description The names of the folders in the system tree. By adding   a new name, you add a new 
folder to the system tree. If you want the folder   to appear inside another folder enter the 
complete path. For example,   to add a folder called Drawings to the Pictures folder you 
would enter:

Pictures\Drawings
Folders Each entry as a folder and always has the value FOLDER.
AppKey An entry that is reserved for future use and should   be left blank.
Vendor of 
Folder

A company name. When you add a folder, enter the name   of your company. Completing 
this attribute is optional.

ProgID of files 
in this folder

The program identification from the registry of the   ActiveX documents residing in the 
folder. If the folder does not contain   ActiveX documents, leave the ProgID blank.

Extension of 
the files for this 
folder

The file extension you want to associate with the   folder. Completing this attribute is 
optional. If Used to find create   and populate this folder on startup is set to TRUE, this 
attribute must   be completed.

Used to find 
create and pop-
ulate this folder 

Whether the iFIX WorkSpace automatically displays   the files with the specified exten-
sion. Setting Used to find create and   populate this folder on startup to TRUE displays 
the files; entering FALSE   or leaving the extension undefined creates an empty folder. 

Folder Attributes  
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on startup Typically,   this attribute is set to TRUE. If set to TRUE, the Extension attribute   must be 
completed.

Fix Path Entry The path to each folder. When you add a folder, enter   the complete path to it. This must 
be a FIX path.

Disable New 
Entry

Whether the New command on the folder's right mouse   menu is grayed out or enabled. 
Entering TRUE grays out the command; setting   the attribute to FALSE or leaving it 
undefined enables the command. Typically,   this attribute is set to FALSE.

OpenExclusiveHow the documents in the folder are opened. Entering   TRUE opens the files exclusively 
for use in the iFIX WorkSpace;   no other applications can read or write to these files. Set-
ting the attribute   to FALSE opens documents in a non-exclusive manner so that other 
applications   can read or write the file. Typically, this attribute is set to FALSE.

Adding Files to the System Tree 

You can add files to the system tree by editing the bottom section of   the SystemTree.CSV file. Use the 
File   Attributes table as a guide to editing the file.

 To add a file to the system tree:   

 1. Open the SystemTree.CSV   file located in the Local path. 

 2. Add a folder named   Event as described in the Adding   Folders to the System Tree section. 

 3. Insert a row within   the Define GE Files section of the file. 

 4. Enter the information for the file in the attribute   fields. For example, to add a text file called Text 
File within the Events   folder enter the following (leave unused fields blank): 

For the attribute... Enter...
Description Events\Text File
Files File
Fix Path Entry Fix Path
Path of this file ALM_

PATH\Test.txt
AutoLoad Entry AutoLoad
Used to determine if this file should be opened   on startup by the 
WorkSpace

FALSE

 5. Save the file in   the Local path with a .CSV extension. 

 6. Using Notepad, create   a text file named Test.txt and save it in your C:\Program Files 
(x86)\GE\iFIX\Alm folder. 

 7. Close the    iFIX WorkSpace. 

 8. Click the Start button,   and then click Run.  In    the Open field, type Regedit.   Find   HKEY_
CLASSES_ROOT\FIX32\BrowseTree\LocalNode.  Delete    the LocalNode branch.  

 9. Click the Start button,   and then click Run.  In   the Open field, type WorkSpace /regserver. 

 10. Click OK. 

 11. Restart the   iFIX WorkSpace. 

Folder definitions include the attributes in the following table. 
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The attribute... Defines...
Description The names of the files that appear directly off the   system tree root. By adding a new 

name, you add a new file to the system   tree. If you want the file to appear inside a 
folder, enter the complete   path. For example, to add a globals file called OEMG-
lobals to the Globals   folder you would enter:

Globals\OEMGlobals
Files Each entry as a file and always has the value FILE.
AppKey An entry that is reserved for future use and can be   left blank.
Vendor of File A company name. When you add a file, enter the name   of your company. Com-

pleting this attribute is optional.
Path of this File The complete path to each file. This must be a FIX   path and the file name.

If the file resides in an iFIX path, you can specify   the path with a predefined alias, 
such as PDB_PATH or BASE_PATH. For example,   if you are adding a globals file, 
enter PIC_PATH since all global files   reside in the iFIX Picture path. 

Used to determine 
if this file should be 
opened on   startup 
by the WorkSpace

Whether the iFIX WorkSpace automatically opens   the file on start-up. This attribute 
is set to TRUE for globals files   only. Typically, this attribute is set to FALSE.

Hidden In Tree 
Entry

Whether the file is visible or hidden in the system   tree. In general, you only want to 
set this attribute to TRUE for any   non-modifiable globals file you add to the system 
tree. Typically, this   attribute is set to FALSE.

Not In Collection 
Entry

Whether the file should be included in a collection.   A collection   is one or more open 
ActiveX documents. Typically, you want to include   all files except non-modifiable 
(system) globals files in collections.   Consequently, you enter TRUE for system 
globals files and FALSE for any   other file. Typically, this attribute is set to FALSE.

Disable Close 
Entry

Whether the Close command on the file's right mouse   menu is grayed out or 
enabled. Entering TRUE grays out the command; entering   FALSE or leaving it 
undefined enables the command. Typically, this attribute   is set to FALSE.

Disable Show 
Entry

Whether the Show command on the file's right mouse   menu is grayed out or 
enabled. Entering TRUE grays out the command; entering   FALSE or leaving it 
undefined enables the command. Typically, this attribute   is set to FALSE.

Disable Save 
Entry

Whether the Save command on the file's right mouse   menu is grayed out or enabled. 
Entering TRUE grays out the command; entering   FALSE or leaving it undefined 
enables the command. Typically, this attribute   is set to FALSE.

Type of file we are 
creating

Whether the file is a globals file. If it is not a   globals file, enter DEFAULT. If it is, 
enter USER for user-defined globals   files or SYSTEM for non-modifiable globals 
files. Typically, you supply   system globals to prevent these value from being 
changed.

ProgID of this file The program identification for your system and user   globals files. This attribute is 
left blank or set to FIXGLOBALSSERVER.FIXGLOBALSSERVER.1

Determines if this 
file can be 
renamed and 
deleted

Whether the Rename and Delete commands on the file's   right mouse menu is 
grayed out or enabled. Entering TRUE grays out the   command; entering FALSE or 
leaving it undefined enables the command. This   attribute is set according to user 
preference.

File Attributes  

Deleting Folders and Files from the System Tree 
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You can delete folders and files from the system tree by editing the   SystemTree.CSV file.
 To delete a folder or file from the   system tree:  

 1. Open the SystemTree.CSV   file located in the Local path. 

 2. Delete the row with   the file or folder information you want to remove from the system tree.   

 3. Save the file in   the Local path with a .CSV extension. 

 4. Close the   iFIX WorkSpace. 

 5. Click the Start button,   and then click Run.  In   the Open field, type Regedit.   Find   HKEY_
CLASSES_ROOT\FIX32\BrowseTree\LocalNode.  Delete   the LocalNode branch.

 6. Click the Start button,   and then click Run.  In   the Open field, type WorkSpace /regserver.

 7. Click OK. 

 8. Restart the   iFIX WorkSpace. 

Validating an Application

The Application Validator is a utility you use to verify the versions of an application's files, and to ensure 
that the files associated with the application have not changed. You can run the Application Validator 
with or without iFIX running.

To use the Application Validator, you first specify the Windows folders that you want to work with. After 
you specify the folders, you take an initial "snapshot" of the content. This "snapshot" is called a 
baseline. You can later compare this baseline snapshot to the same folder(s) at another date, or on a reg-
ular basis, to see if the contents of each folder have changed.  

You will find the Application Validator utility most helpful, for instance, when you finish configuring your 
iFIX system. Once you configure iFIX, you can create a baseline of the iFIX folders and other ones asso-
ciated with your process. You can monitor which files were changed since you created the baseline. So, 
if you ever run into problems, or want to go back to an original configuration, you can determine which 
files were changed or added, and you can manually rollback to that configuration. You can view these 
changes, as a summary or detailed report, in online or printed format.  

Application Validator Basics

There is certain basic information you should know before using the   Application Validator. This section 
contains information on the following:

 l Running   the Application Validator

 l Running   With or Without iFIX

 l Running   in Demo Mode

 l General   Configuration for the Application Validator

 l Working   with Default Settings

 l Using   the Application Validator Toolbar and Quick Keys

 

Running the Application Validator
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You can run the Application Validator from the iFIX WorkSpace, the Windows Explorer, or the command 
line. Refer to the following table for more information.     

If you want 
to start the 
Application 
Validator 
from the...

Do this...

iFIX 
WorkSpace

Double-click the Application Validator icon in the system tree.

Windows 
Explorer

Double-click the AppValidator.exe file in the folder where you installed iFIX.

Command 
Line

From the DOS prompt type the AppValidator command with the desired com-
mand line options.  

Refer to the Command Line Options for the Application Validator section for a 
full description of these options.

Running the Application Validator   

Running With or Without iFIX

You can use the Application Validator with or without iFIX. If you require that iFIX be running, open the 
AppValConfig.ini file in the folder where you installed iFIX and specify Yes for the Run-
ningIFixIsRequired key in this file. If you require that iFIX is running, you can also specify whether iFIX 
Security is required by setting the EnabledSecurityIsRequired key to Yes in the AppValConfig.ini file.

For example, an AppValConfig.ini file with both options enabled appears as follows:

[Security]
RunningIFixIsRequired=Yes
EnabledSecurityIsRequired=Yes

If you use iFIX Security, you can modify your iFIX groups to allow the users in the designated groups to 
create baselines and/or have runtime access to the Application Validator. The iFIX application features 
name for these privileges are as follows:  

 l Application Validator - Creation of Baselines    

 l Application Validator - Run-time Access    

For more information on iFIX security setup, refer to the Defining and Assigning Security Privileges in 
the Configuring Security Features manual.

Running in Demo Mode

Demo mode in the Application Validator restricts how you:

 l Select directories   

 l Load application   settings 
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 l Save application   settings 

 l Save Detail Reports   

If you do not have an iFIX software license, you can only use the Application   Validator when iFIX runs in 
Demo mode. The command line mode for the Application   Validator is not available while iFIX is in Demo 
mode. 

General Configuration for the Application Validator

To change the default options for the Application Validator, select   Options from the Tools menu to open 
the Options dialog box. From this   dialog box you can:

 l Identify specific   files or file types to exclude from the comparison. 

 l Define an application   to run if differences are found when running the Application Validator   from 
the command line. 

 l Specify an automatic   report naming convention when running the Application Validator from the   
command line. 

Working with Default Settings

Every time you shutdown the Application Validator, it updates the Default.avs   file. The .AVS (Applic-
ation Validator Settings) file contains the settings   that you define in the Application Validator Options dia-
log box and includes   a list of the folders to display in the main window. Each time you restart   the 
Application Validator, it displays the settings from when you last   used the Application Validator.

You later can define your own settings, save them in another file, and   load them when you want to run 
specific reports. You could also use these   custom .AVS files when running the Application Validator 
from the command   line.

Using the Application Validator Toolbar and Quick Keys

All of the commands found on the menu bar have corresponding toolbar   buttons. For each action that 
you can perform from the toolbar and menu   bar, there are also quick keys that you can enter from the 
keyboard. The   following table summarizes the functions of the toolbar buttons and key   combinations 
that you can use. 

Use 
this...

To...

Select directories for use in the Application Validator.

Load predefined settings.

Open the Save As dialog box to save settings.

Open the Print Preview dialog box.

Application Validator Toolbar   Buttons  
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Open the Print dialog box to print the current screen.

Select all folders displayed in the main window.

Clear the check boxes for all folders selected in   the main window.

Create a baseline file for each folder selected in   the main window.

Create a baseline for a single folder. 

Generate summary information indicating which folders   contain changes. This information 
appears in the third column of the main   window.
Generate a detailed summary report. This information   appears in another window.

Open the Application Validator Options dialog box.

Show or hide the activity log window in the bottom   half of the main window.

View information about the Application Validator version.

Ctrl+A Select all folders displayed in the main window.
Ctrl+B Create baseline files for each folder selected in   the main window.
Ctrl+D Open the Select Directories dialog box from the main   window, or if you are in the Comparison 

Detail Report window, this key   combination allows you to display differences only.
Ctrl+G Create a baseline for a single folder. To create a   baseline for one folder, only select the check 

box for that folder.
Ctrl+L Open the Open dialog box to load predefined settings.
Ctrl+M Generate summary information indicating which folders   contain changes. This information 

appears in the third column of the main   window.
Ctrl+O Open the Application Validator Options dialog box.
Ctrl+P Open the Print dialog box to print the current screen.
Ctrl+S Open the Save As dialog box to save the application   settings or detailed report.
Ctrl+T Generate a detailed summary report. This information   appears in another window.
Ctrl+U Clear the check boxes for all folders selected in   the main window.

Types of Reports from the Application Validator

There are two types of reports that you can run from the Application Validator:

 l Summary Report

 l Comparison Detail Report

You can view both these reports in online or printed format. 

Summary Report 

When you run a Summary Report, it displays in the main window of the   Application Validator. A status 
for each folder appears in the third column   of the main window, indicating if differences were found or if 
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the files   in the folder were identical to the original baseline. For instance, the   Compare Status field for the 
folder could be identified as Identical,   Differences Found, or Missing a Baseline.

The following figure shows an example of a Summary Report as it appears   in the main window of the 
Application Validator. Notice the Compare Status   column of the far right of the window that includes the 
Summary Report   information.

Example of the Summary   Report from the Main Window

Comparison Detail Report 

When you run a Comparison Detail Report, it displays in a new window.   A Comparison Detail Report 
describes whether a file in any folder was   modified, added, removed, or unchanged. Unlike the Sum-
mary Report that   details the changes in complete folders, the Comparison Detail Report   describes the 
changes for individual files.

The following figure shows an example of a Comparison Detail Report.   Notice the Status column (the 
second column from the left) that displays   whether the file is Identical, Different, Added to Current 
(New), or Deleted   from the Current folder.
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Example of Comparison Detail   Report Window
Viewing Only the Files that Changed

In the Comparison Detail Report, you can reduce the number of files   included in the list by ignoring 
identical files. If you want to view   only the files that changed, select the Differences Only option from the   
View menu in the Comparison Detail Report window.
Saving the Comparison Detail Report

In addition, you can save the Comparison Detail Report to a .CSV or   .TXT file. Select Save from the File 
menu in the main window to open the   Save dialog box, from which you can select a comma-delimited 
format (.CSV)   or text format (.TXT) from the drop-down list.

General Overview of Steps for Using the Application Validator 

Once you understand and configure the Application   Validator Basics, you can begin to use Application 
Validator with   your application. The steps are generally the same for each application.

 To use the Application Validator:   

 1. Select the folders   you want to work with. 

 2. Generate a baseline   for the selected directory or directories. 

NOTE: The Application   Validator cannot create a baseline for files that are open with exclusive   rights. 
For instance, if you attempt to create a baseline of the root   drive C:/, where the Pagefile.sys is open 
with exclusive rights from the   operating system, the baseline will fail. The operating system has full   
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control over that file, and no one else, not even the administrator nor   the user creating the baseline, 
has rights to open it.

 3. At a later time when   you want to validate the files, run a report: 

 l Summary Report.   

 l Comparison Detail   Report. 

Command Line Options for the Application Validator

The syntax for the Application Validator command line is as follows:

AppValidator /ConfigFile:"C:\FullPath\Settings.avs" 
                         | /Directory:"single directory name" 
[/CreateBaseline | /CB] 
[/OverWrite] 
[/PrintSingleBaseline | /PSB] 
[/PrintComparisonSummary | /PCS] 
[/PrintComparisonDetail | /PCD] 
[/SaveComparisonDetail:"Full path of output file" 
                         | /SCD:"Full path of output file"] 
[/CSV] 
[/DifferencesOnly | /DO] 
[/? | /Help]

Notes on the Syntax

 l The brackets ( [   ] ) indicate that a parameter is optional. The brackets are not part of   a command; 
if a bracketed option is desired, only type the text that is   inside the brackets, and not the brackets 
themselves. 

 l The pipe bar ( |   ) indicates separate items in a group that you can choose from. For instance   you 
can use the /CreateBaseline or the /CB argument with the AppValidator   command, and, in this 
case, both perform the same task. 

 l Italics are used   to represent the information that the user must supply to run the command.   The 
information in italics is not typed exactly as it appears. Instead,   the user enters the information 
specific to the italicized expression.   

Descriptions of Optional Arguments

The following table outlines the optional arguments. If an abbreviation   is available, that is listed instead 
of the full argument name. For instance,   the /CB argument is listed instead of the /CreateBaseline argu-
ment, but   either could be used. 

Argument Description
/CB Creates baseline files for the specified directories   and folders.
/OverWrite Overwrites any existing baseline files. (Used with   the /CB argument only.)
/PSB Prints the existing baseline for the specified folder.
/PCS Prints the Summary Report for the specified folders.
/PCD Prints the Comparison Detail Report for the specified   folders.
/SCD:"Full Path Saves a copy of the Comparison Detail Report for the   specified folders. If you do not 

Application Validator Command   Line Options(Sheet 1 of 2) 
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Output File" use the /CSV argument, the file is saved   as a .TXT file.
/CSV Specifies that the Comparison Detail Report be saved   in Comma Separated Value 

(CSV) format. (Used with the /SCD option only.)
/DO Specifies that you only want to display the files   with changes in the Comparison 

Detail Report. (Used with the /SCD option   only.)
/? Displays the Help for the command line options.
Command Line Options You Can Define in the GUI

In addition to the options that you can specify on the command line,   some options must be set from 
within the Application Validator user interface   (non-command line version). These options include:

 l Using an automatic   report naming convention when running the Application Validator from the   
command line. 

 l Define an application   to run if differences are found when running the Application Validator   from 
the command line. 

Command Line Errors

You may encounter errors caused when an invalid command line parameter   is passed to the Application 
Validator. Errors are logged to the AppValidator.log   file in the iFIX folder.

Understanding Auditing for the Application Validator

You can configure the Application Validator to audit all user actions. Once configured, each time you per-
form an action, such as create a baseline, run a baseline summary report, or run a comparison report, an 
audit message is sent to the iFIX alarm system. This message is then recorded as part of the standard 
iFIX audit trail.

 To enable audited actions in the Application Validator: 

 1. Open the AppValConfig.ini file and enable both options in this .ini file by entering Yes for both set-
tings:   
RunningIFixIsRequired=Yes 
EnabledSecurityIsRequired=Yes

 2. Enable the Alarm ODBC Service and configure your relational database to store the audit mes-
sages in the ODBC alarm table.   

For more information on the AppValConfig.ini, refer to the Understanding the AppValConfig.ini File and 
Auditing section in this chapter. For more information on enabling and configuring the Alarm ODBC Ser-
vice, refer to Configuring the Alarm ODBC Service section in the Implementing Alarms and Messages 
manual.

Understanding the AppValConfig.ini File and Auditing

The AppValConfig.ini file specifies whether iFIX must be running in order to start the Application Val-
idator and if iFIX security applies. This file is located in the iFIX folder (the folder where you installed 
iFIX). Both options must be enabled if you want to audit user actions in the Application Validator. With 
both options enabled, the Application Validator user and node can be tracked in the standard iFIX audit 
trail.
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 To configure the AppValConfig.ini file for auditing purposes: 

 1. Open the AppValConfig.ini in Notepad or another text editor.     

 2. Make that both settings in this file are set to Yes:   
[Security]
RunningIFixIsRequired=Yes
EnabledSecurityIsRequired=Yes

NOTE: If you set EnabledSecurityIsRequired to Yes, then the Application Validator only runs when 
Security is Enabled within iFIX. If you set EnabledSecurityIsRequired to No, then iFIX Security does 
not have to be enabled in order to run the Application Validator.

 3. Save the file into the iFIX folder (the same location where you installed iFIX).   

 4. Restart the Application Validator.   

Viewing the Audited Messages

Use your database tools or VisiconX to view the iFIX audit trail. For   information on Microsoft SQL Server 
or Oracle database tools, refer to   your manufacturer's documentation. For more information on VisiconX, 
refer   to the Using VisiconX manual. 

iFIX alarm destinations such as the Alarm File and Alarm Printer also   get these audit messages. For 
information on configuring these alarm locations,   refer to the Configuring  Alarms chapter in the Imple-
menting Alarms and Messages manual.

NOTE: The Alarm History   window only displays the most recent 500 messages; it is not a complete   list of mes-
sages, and therefore, not an audit trail. 

Sample Audit Message from the Application Validator

The following figure displays a sample of the audit message sent to the iFIX alarm system. Notice that 
the timestamp, iFIX node name, node name where the user was logged in, plus the name of iFIX oper-
ator who performed the action are all included with the audit message.

Format of Audit Message Sent to iFIX Alarm System

List of Audit Messages from the Application Validator
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The following list describes the audit messages associated with the Application Validator. These mes-
sages describe the events that can occur (to the operator) when running the Application Validator:

 l Application Validator – Baseline File has been tampered with!   

 l Application Validator – Command-line: Create Baseline   

 l Application Validator – Command-line: Print Comparison Detail   

 l Application Validator – Command-line: Print Comparison Summary   

 l Application Validator – Command-line: Print Single Baseline   

 l Application Validator – Command-line: Save Comparison Detail   

 l Application Validator – Create Baseline   

 l Application Validator – Error retrieving security user   

 l Application Validator – Error with Compare Directory: %s   

 l Application Validator – Error with Fill Baseline Detail: Checksum difference for baseline file: [%s]. 
%s   

 l Application Validator – Error with Fill Baseline Detail: Failed to read encrypted baseline file: [%s]. 
%s   

 l Application Validator – Failed to start Application: %s   

 l Application Validator – iFIX isn't running   

 l Application Validator – Insufficient Security Rights   

 l Application Validator – Invalid Security Feature   

 l Application Validator – Print Baseline Status/Comparison Summary   

 l Application Validator – Report Comparison Detail   

 l Application Validator – Report Comparison Summary   

 l Application Validator – Report Printed   

 l Application Validator – Report Saved   

 l Application Validator – Report Single Baseline   

 l Application Validator – Security not enabled   

 l Application Validator – User not logged in   

NOTE: The %s in these messages is replaced with the actual the directory name when the message 
appears.

Activity Log in the Main Window

The activity log displays informational messages on the actions performed   in the Application Validator 
since you enabled logging. This log displays   the most recent actions first in the list, at the top of the win-
dow. By   scrolling down, you can review previous actions. 

The activity log may be helpful when trying to diagnose problems using   the Application Validator.

NOTE: The activity   log is not saved when you stop the Application Validator or shut it down.   
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The following figure shows an example of the Application Validator main   window with the Log window 
displayed.

Application Validator with   Log Window Displayed

Best Practices 

Some best practices to keep in mind when using the Application Validator include the following:

 l Specify that iFIX be running in order to start the Application Validator and that iFIX security be 
enabled in the AppValConfig.ini file, if you want to use auditing.   

 l If using iFIX security, limit the creation of baselines to a specified set of users. For each des-
ignated user in the Security Configuration tool, select the Application Validator - Creation of 
Baselines feature from the Application Feature Selection dialog box.   

NOTE: Depending upon your security requirements, you probably can allow run-time access to the Applic-
ation Validator (Application Validator - Run-time Access feature) more liberally.

For more information on iFIX security setup, refer to the Defining and Assigning Security Privileges in 
the Configuring Security Features manual.

Application Validator Dialog Boxes

The Application Validator includes the following dialog   boxes:
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 l Application   Validator Options Dialog Box

 l Select   Directories Dialog Box

Application Validator Options Dialog Box

The Application   Validator Options Dialog Box consists of three tabs:

Exclusion List Tab

Item Description
Exclusion List Displays the files excluded when you compare the folders with the 

baseline.
Excluded File Filter Enter the file or file name mask that you want to exclude from the 

folder   comparison. Click Add to add it to the file exclusion list.

For file name masks, you can use standard Windows wildcard char-
acters.   For instance, use the * symbol to represent multiple 
unknown characters   in a file name. Use the ? symbol for a single 
unknown character in a file   name. 

For example, if you did not want to compare log files versions you 
would   add *.log to the file exclusion list.

Exclusion List Text Box Enter the file or file name mask that you want to exclude from the 
folder   comparison. Click Add to add it to the file exclusion list.

For file name masks, you can use standard Windows wildcard char-
acters.   For instance, use the * symbol to represent multiple 
unknown characters   in a file name. Use the ? symbol for a single 
unknown character in a file   name.

For example, if you did not want to compare log files versions you 
would   add *.log to the file exclusion list

Add Click to add the file or file name mask, entered in the field above,   to 
the file exclusion list.

Remove Click to delete the selected file or file mask from the file exclusion   
list.

Application Execution Tab

Field Name Description
Enable Application Exe-
cution

Select this check box if you want to run an executable file when dif-
ferences   are found between the baseline and the current folder ver-
sions, when running   the Application Validator from the command 
line.

Application Enter the name and location of the file that you want to run (when 
the   Application Validator runs from the command line) and finds dif-
ferences.

Browse Click to browse for a file.

Auto Report Naming Tab

Field Name Description
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Enable Auto Report Nam-
ing

Select this check box if you want to use a predefined   name for all 
reports generated from the command line with the Application   Val-
idator.

Report Name Enter the name for the auto-generated report file.   If you select the 
Auto Increment option, a number is added to the end   of this name 
each time a new report is run from the command line.

Directory Enter the name and location of the folder to which   you want to save 
the detailed summary reports generated when you run the   Applic-
ation Validator from the command line.

Browse (...) Click to browse for a folder to which you want to   save the report.
Prefix Enter the name for the auto-generated report file.   If you select the 

Auto Increment option, a number is added to the end   of this name 
each time a new report is run from the command line.

Auto Increment Select this check box if you want to individually   number each report 
file, instead of overwriting the original file each   time you run a new 
report.

How Do I...

Refer to one of the following sections for steps on how to use the Application   Validator:

 l Configuring   Settings

 l Creating   Baselines

 l Working   with Reports

 l Working   with the Command Line

 l Working   with iFIX

 

Working with iFIX

To use the Application Validator with iFIX, you should be aware of the   following operations:

 l Auditing   the Actions Performed in the Application Validator

 l Requiring   that iFIX to be Running in Order to Start the Application Validator

 

Troubleshooting

You can troubleshoot the Application Validator by:

 l Viewing   the Error Log

 l Displaying   Informational Log Messages for the Current Session
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Customizing the iFIX Installation

The following sections provide information for users who want to create   a custom iFIX installation for 
use on either a DVD or over a network:

 l Types   of Users Who Create Custom Install Programs

 l Creating   a Custom iFIX Install for a DVD or Network

 l Running   a Quiet Install

 l Modifying   the Default Behavior of the iFIX Install

 l Including   Additional iFIX Project Files in the Install

 l Installing   Software Improvement Modules (SIMs) with iFIX

 l Including   Additional Third-Party Software in the Install

 l Customizing   the Install Splash Screen

 l Rebranding   Install Graphics

 l Rebranding   Install Text

 l Rebranding   the iFIX DVD Booklet and Tray Card

 l Rebranding   Other Parts of the iFIX Product

 l Deploying   the iFIX Install Setup.exe Command Line Options

 l INI   Files Used by the iFIX Install

 l Language   Codes Used by the iFIX Install Program

IMPORTANT: If you want   to create and/or produce rebranded iFIX DVDs for use other than internal   to your 
company, you must have license agreement and permission from GE    to do so. Contact GE for more inform-
ation.

 

Types of Users Who Create Custom Install Programs

With a customized iFIX install program, you can change the default install   settings, modify the com-
ponents included with the install, or change the   appearance of the install. The following types of users 
may be interested   in custom iFIX install programs:

 l The   Administrator (Admin)

 l The   System Integrator (SI)

 l The   Original Equipment Manufacturer (OEM)

Depending on the type of user you are, your requirements for creating   a custom FIX install program will 
differ. The following sections describe   the types of actions each type of user may want to do with their 
custom   iFIX install program.

 

The Administrator
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As an Administrator, you may want to create a custom iFIX install that   includes:

 l A quiet install of   the iFIX product. For more information, refer to the Running   a Quiet Install sec-
tion.

 l Modification of the   default behavior of the install, such as a different install path for   the iFIX 
product, or a different name for the PIC or PDB folders. For   more information, refer to the Modi-
fying   the Default Behavior of the iFIX Install section.

IMPORTANT: If you want to create   and/or produce custom iFIX DVDs for use other than internal to 
your company,   you must have license agreement and permission from GE to do so.   Contact GE for 
more information.

  

The System Integrator

As a system integrator, you may want to can create a custom iFIX install   that includes:

 l A quiet install of   the iFIX product. For more information, refer to the Running   a Quiet Install sec-
tion.

 l Modification of the   default behavior of the install, such as a different install path for   the iFIX 
product, or a different name for the PIC or PDB folders. For   more information, refer to the Modi-
fying   the Default Behavior of the iFIX Install section.

 l Additional files,   such as customized project, database, or alarming files. For more information,   
refer to the Including   Additional iFIX Project Files in the Install section.

 l Software Improvement   Modules (SIMs) that have been released after the initial release of the   
iFIX product. You can also choose to install these SIMs quietly. For more   information, refer to the 
Installing   Software Improvement Modules (SIMs) with iFIX section.

 l Additional third-party   software, specific to your organization or site. For more information,   refer to 
the Including   Additional Third-Party Software in the Install section.

 l A different initial   graphic (splash screen) that displays when you first load the iFIX product   install 
DVD. For more information, refer to the Customizing   the Install Splash Screen section.

IMPORTANT: If you want to create   and/or produce custom iFIX DVDs for use other than internal to 
your company,   you must have license agreement and permission from GE to do so.   Contact GE for 
more information.

  

The Original Equipment Manufacturer

As an Original Equipment Manufacturer (OEM), you may want to can create   a custom iFIX install that 
includes:

 l A quiet install of   the iFIX product. For more information, refer to the Running   a Quiet Install sec-
tion.

 l Modification of the   default behavior of the install, such as a different install path for   the iFIX 
product, or a different name for the PIC or PDB folders. For   more information, refer to the Modi-
fying   the Default Behavior of the iFIX Install section.

96 © 2020 General Electric Company. All rights reserved.



 l Additional files,   such as customized project, database, or alarming files. For more information,   
refer to the Including   Additional iFIX Project Files in the Install section.

 l Software Improvement   Modules (SIMs) that have been released after the initial release of the   
iFIX product. You can also choose to install these SIMs quietly. For more   information, refer to the 
Installing   Software Improvement Modules (SIMs) with iFIX section.

 l Additional third-party   software, specific to your organization or site. For more information,   refer to 
the Including   Additional Third-Party Software in the Install section.

 l A different initial   graphic (splash screen) that displays when you first load the iFIX product   install 
DVD. For more information, refer to the Customizing   the Install Splash Screen section.

 l Rebranded graphics   that appear when the install program runs, after the splash screen. For   more 
information, refer to the Rebranding   Install Graphics section.

 l Rebranded text that   appears in the install. For more information, refer to the Rebranding   Install 
Text section.

 l Rebranded license   agreement. For more information, refer to the Rebranding   the License Agree-
ment section.

 l Rebranded DVD booklet   and tray card. For more information, refer to the Rebranding   the iFIX 
DVD Booklet and Tray Card section.

 l Rebranded product   items. For more information, refer to the Rebranding   Other Parts of the iFIX 
Product section.

IMPORTANT: As an OEM,   you must have license agreement and permission from GE to create   rebranded 
installations. Additionally, you will need a copy of the iFIX   NLS Toolkit for the InstallShield Stand-Alone 
builder, which you need   to recompress the install program if you choose to modify the graphics,   text, or 
license in the actual installer. With the NLS Toolkit, you can   also rebrand other parts of the iFIX application. 
Contact GE for   more information.

 

Creating a Custom iFIX Install for a DVD or Network

You can create a customized iFIX install (for use on a DVD or a network)   for use at your site, assuming 
that a license is available for each individual   install. The steps that follow describe how to produce a cus-
tom iFIX install   program.

IMPORTANT: If you want   to create and/or produce rebranded iFIX DVDs for use other than internal   to your 
company, you must have license agreement and permission from GE    to do so. Contact GE for more inform-
ation.

 To create a customized   install program:

 1. In Windows Explorer,    create a folder on your local drive named dvdimage.   For example: C:\d-
vdimage. You must have at least 400 MB of free space available.

 2. Obtain an iFIX product   DVD, for the version you want to install or upgrade.

 3. Copy all of the files   and folders from the iFIX DVD, and paste them to your dvdimage   folder.

 4. Perform the steps   for the options you want to customize.
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 To create a customized   product DVD:

 1. After you finish   your customizations, copy all of the files and folders from your dvdimage   folder to 
a new DVD using your DVD writing software.

 2. Test the new DVD.   Make sure that iFIX installs properly, and that all your customizations   appear 
correctly.

After all of your tests pass, you can use   this DVD internally on other computers, or supply it to 
customers who use   your rebranded, customized software (if you have a license from GE   to do 
so).

 To create a customized   network install in preparation for deployment:

 1. After you finish   your customizations, copy all of the files and folders from your dvdimage   folder to 
a network drive that you want to run the install from.

 2. Test the network   install. Make sure that iFIX installs properly, and that all your customizations   
appear correctly.

After all of your network install tests   pass, you can use this network installation on other com-
puters, or supply   it to customers who use your rebranded, customized software (if you have   a 
license from GE to do so).

 

Running a Quiet Install

A quiet install is useful if you want to create an iFIX install that   is non-interactive and uses a set of pre-
defined installation options.   With a non-interactive install, you can ensure that iFIX installs or upgrades   
to the latest release the same way on each computer you run the install   on. If you are installing or upgrad-
ing iFIX on many systems and you want   every system to install the same way, a quiet install program 
helps you   save time.

A quiet install is similar to a silent install, except that with a quiet   install the user knows when the 
product is installing. A silent install   program installs the product without any online cues, so the user 
may   not even be aware when the product is in the process of installing. A   quiet install does display dia-
logs and messages on the user's computer   during the install, but no user input is required. 

When you use the quiet install capability, you can modify the installation   defaults, such as the local 
paths and additional program features. For   instance, you can customize the quiet install with iFIX. To 
customize   a quiet install, modify the default answers to all of the desired install   questions and options 
beforehand by editing the InstallConfig.ini file   on the iFIX product DVD. The InstallConfig.ini supplies 
the setup program   with all of the information that a user is prompted to enter during the   install, as well as 
pre-configured information about items such as the   install paths. For more information on modifying this 
file, refer to the   Modifying   the Default Behavior of the iFIX Install section.

IMPORTANT:   GE Historian does not support a quiet or silent install.

 To launch the iFIX   install so it runs quietly (without making any configuration changes):

Launch the install with the "/Quiet"   install command line option:
setup.exe /quiet /nomsg

98 © 2020 General Electric Company. All rights reserved.



 To customize the   iFIX install so that it always runs quietly:

 1. Create a customized   iFIX install program. For steps, refer to the Creating   a Custom iFIX Install 
for a DVD or Network section.

 2. Locate the InstallConfig.ini   file in the dvdimage folder, and open it in a text editor such as Note-
pad.

 3. In the [config] section,   set Quiet=TRUE.

 4. Save the file.

 

Modifying the Default Behavior of the iFIX Install

To modify the default behavior of the iFIX install program, edit the   InstallConfig.ini file for the iFIX 
product install. The InstallConfig.ini   supplies the setup program with all the information that a user is 
prompted   to enter during the install, as well as pre-configured information. The   information you can edit 
in the InstallConfig.ini file includes:

 l Pre-configured path   locations for the iFIX product during install.

 l Enabled features   such as the e-books.

 l Behavior such as   whether iFIX creates shortcuts for Launch.exe or the e-books.

 l Default answers to   prompted install questions, such as the node name, whether networking   is 
enabled, or whether SCADA support is enabled.

 l The option to run   the iFIX install quietly (without user input).

For example, as a system administrator, system integrator, or an OEM,   you may want to change the 
default paths that iFIX uses for pictures,   alarm history files, recipes, and so on, so that the paths are spe-
cific   to your environment. Be aware that if you change these paths, you may   not be able to use iFIX with 
the Change Management product. Contact   GE for more information.

 To modify the default   behavior of the install program:

 1. Create a customized   iFIX install program. For steps, refer to the Creating   a Custom iFIX Install 
for a DVD or Network section.

 2. Locate the InstallConfig.ini   in the dvdimage folder, and open it in a text editor such as Notepad.

 3. If you want to change   the default paths to which iFIX installs in your Program Files folder,   you 
can do so by editing the bold text in the following snippet. Be aware   that if you change these 
paths, you may affect iFIX's capability to work   with other GE products, such as Change Man-
agement.
[PATHS]
ROOT=
BasePath=GE\iFIX
PDBPath=PDB
NLSPath=NLS
PICPath=PIC
APPPath=APP
HTRPath=HTR
HTRDATAPath=HTRDATA
LOCALPath=LOCAL
ALMPath=ALM
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RCMPath=RCM
RCCPath=RCC
AADPath=PDB

 4. To specify the node   name, enable or disable networking or SCADA support, or indicate whether   
to run a quiet install, edit the bold text in the following snippet. Quiet   must be set to TRUE for the 
install to run quietly.
[config]
NODENAME=FIX
NETWORK=TRUE
SCADA=FALSE
quiet=FALSE

 5. To specify whether   features such as the e-books are to be installed, or to specify whether   iFIX 
should show these features in the Custom Install option, edit the   bold text in the following snip-
pet. TRUE indicates that the feature installs,   and FALSE means that it does not.
[features]
PAV=TRUE
EBOOKS=TRUE
MYTSOFT=TRUE
SHOWEBOOKS=TRUE
SHOWMYTSOFT=TRUE

 6. Create a customized   DVD or a customized network install in preparation for deployment. For   
more information, refer to the Creating   a Custom iFIX Install for a DVD or Network section.

 

Including Additional iFIX Project Files in the Install

Along with the iFIX product itself, you can install customized iFIX   project files specific to your company 
or site. If you are a system integrator   or OEM, this feature can significantly decrease your deployment 
time by   allowing you to install your iFIX project files to all your computers   without having to copy these 
files manually afterward.

To include additional iFIX project files, you create a custom batch   or executable file that runs during the 
iFIX install (named Runtask.bat).   The instructions you provide in this file will indicate a designated loc-
ation   to copy from and to.

The Runtask.bat File

The Runtask.bat file is a batch command file that you can run at the   end of the iFIX product installation 
program. The iFIX product install   is configured to automatically run this file if it exists.

This batch file copies picture files and customized help files from   the MyProjects\pic folder you created 
in your dvdimage folder, to your   local product install folder. It also copies Alarm Area Databases (.AAD   
files) and Process Databases (.PDB files) from the MyProjects\pdb folder   in your dvdimage folder, to 
your local product install folder. The default   install paths of C:\Program Files (x86)\GE\iFIX\PIC and 
C:\Program   Files\Proficy\Proficy iFIX\PDB are used, as illustrated below in a sample   Runtask.bat file:

REM Copy Picture Files
copy %2\MyProjects\pic\*.grf "%1\Program Files\Proficy\Proficy iFIX\PIC"
 
REM F1 Help Files for Picture
copy %2\MyProjects\pic\*.chm "%1\Program Files\Proficy\Proficy iFIX\PIC"
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REM Copy Alarm Area Database Files
copy %2\MyProjects\pdb\AlarmAreas.AAD "%1\Program Files\Proficy\Proficy iFIX\PDB"
 
REM Copy Process Database Files
copy %2\MyProjects\pdb\MyDatabase.PDB "%1\Program Files\Proficy\Proficy iFIX\PDB"

As you can see in this example, there are two variable parameters: %1   and %2. To specify the dir-
ectories that you want to work with, you need   to modify these two parameters as follows:

 l %1 is the target   directory where iFIX installs.

 l %2 is the iFIX install   image folder (on a DVD or network).

 To create a Runtask.bat   file which copies additional files:

 1. Open Notepad or another   text editor.

 2. Enter the instructions   that you want to include.

 3. Copy this file to   the dvdimage folder that you created when you created a custom iFIX install   pro-
gram. For more information, refer to the Creating   a Custom iFIX Install for a DVD or Network sec-
tion.

 

Installing Software Improvement Modules (SIMs) with iFIX

If you want to install additional GE product SIMs along with iFIX,   you can easily do so by adding them to 
the iFIX installation. Use this   feature to save time if you need to install iFIX upgrades and multiple   SIMs 
on several computers. You can customize the SIM install options so   that they install quietly as well.

 To add SIMs to   your customized iFIX install:

 1. Create a customized   iFIX install program. For steps, refer to the Creating   a Custom iFIX Install 
for a DVD or Network section.

 2. Locate the Subinstall.ini   file in the dvdimage folder, and open it in a text editor such as Notepad.

 3. In the [post_install]   section, add another sequential line that includes the name of your SIM.   For 
instance, in this example we add install6 with the SIM name of iFIX_MySIM:
[post_install]
install0=WindowsInstaller-KB893803-v2-x86
install1=dotnet11
install2=dotnet20
install3=vcredist_x86
install4=plicense
install5=ilicense
install6=iFIX_MySIM

NOTE:   The numbers that follow after the "install" text must be in   sequential order. For instance: 
install0, install1, install2, install3,   install4, and so on. If the numbers skip, or appear out of order, the   
install tasks may not run.

 4. Scroll to the end   of the Subinstall.ini file. Copy this entire snippet and paste it at the   very end of 
your file:
[iFIX_MySIM]
display1031=Installing SIM iFIX_MySIM
display1033=Installing SIM iFIX_MySIM
display1036=Installing SIM iFIX_MySIM
display1041=Installing SIM iFIX_MySIM
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display1042=Installing SIM iFIX_MySIM
display1045=Installing SIM iFIX_MySIM
display1049=Installing SIM iFIX_MySIM
display2052=Installing SIM iFIX_MySIM
required=1
execute=iFIX45SIMs\iFIX45_1135599586.exe
cmdline=/quiet /nomsg

NOTES:

 l The   /quiet /nomsg command line options allow the SIM to install quietly, without   any messages 
prompting the user. These command line options are the preferred   way to install SIMs along 
with the iFIX product install.

 l If you want to run   the SIM install command from the dvdimage folder, instead from a DVD,   you 
need to include the dvdimage path. For example: execute=dvdimage\iFIX45SIMs\iFIX45_
1135599586.exe

 5. In the first line   replace the bracketed text with the SIM name you entered in step 3. In   the pre-
vious example, the SIM was named iFIX_MySIM, and the bracketed   item is similarly named 
[iFIX_MySIM].

 6. For the display lines   1031-2052, enter the text that you want to appear in localized product   
installs. The display code at the beginning of these lines represents   the languages that iFIX 
installs on. If you are creating an English install,   these text strings can be left at their default val-
ues, as shown in the   previous example. If you are installing different language versions of   iFIX, 
you can modify the bold text to display an informational message   in the language corresponding 
to the language code at the beginning of   each line. For a list of language codes, refer to the Lan-
guage   Codes Used by the iFIX Install Program section.

 7. For the execute line,   enter the file location and name of the SIM that you want to install.

 8. Make sure that the   cmdline contains the /quiet /nomsg options. This ensures that your SIM   
installs quietly.

 9. Save the file.

 10. Create a customized   DVD or a customized network install in preparation for deployment. For   
more information, refer to the Creating   a Custom iFIX Install for a DVD or Network section.

 

Including Additional Third-Party Software in the Install

Along with iFIX, you can install other software specific your company   or site. For instance, you might 
want to include tools you created to   work with iFIX, or patches for other required software. Your custom 
install   can include these as part of the standard iFIX install.

NOTE: If you install   additional documentation, it currently cannot be accessed from the main   iFIX e-book. You 
can only access it outside of the iFIX master e-book,   or directly from iFIX picture files.

 To add other software   programs to your customized iFIX install:

 1. Create a customized   iFIX install program. For steps, refer to the Creating   a Custom iFIX Install 
for a DVD or Network section.

 2. Locate the Subinstall.ini   file in the dvdimage folder, and open it in a text editor such as Notepad.
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 3. In the [post_install]   section of the Subinstall.ini file, add another sequential line that includes   the 
name of your software's executable installation file. For instance,   in this example we add install6 
with the name of MySpecialInstall:
[post_install]
install0=WindowsInstaller-KB893803-v2-x86
install1=dotnet11
install2=dotnet20
install3=vcredist_x86
install4=plicense
install5=ilicense
install6=MySpecialInstall

NOTE:   The numbers that follow after the "install" text must be in   sequential order. For instance: 
install0, install1, install2, install3,   install4, and so on. If the numbers skip, or appear out of order, the   
install tasks may not run.

 4. Scroll to the end   of the Subinstall.ini file. Copy this entire snippet and paste it to the   very end of 
your file:
[MySpecialInstall]
display1031=Installing MySpecialInstall
display1033=Installing MySpecialInstall
display1036=Installing MySpecialInstall
display1041=Installing MySpecialInstall
display1042=Installing MySpecialInstall
display1045=Installing MySpecialInstall
display1049=Installing MySpecialInstall
display2052=Installing MySpecialInstall
required=1
execute=Myfolder\MySpecialInstall.exe
cmdline=/MyCommand

NOTE:   If you want to run the executable command from the dvdimage folder, instead   from a DVD, you 
need to include the dvdimage path. For example: execute=dvdimage\Myfolder\MySpecialInstall.exe.

 5. In the first line,   replace the bracketed text with the name you entered in step 3. In the   previous 
example, the executable installation file was named MySpecialInstall,   and the bracketed item 
has the exact same name [MySpecialInstall].

 6. For the display lines   1031-2052, enter the text that you want to appear in localized product   
installs. The display code at the beginning of these lines represents   the languages that iFIX 
installs on. If you are creating an English install,   these text strings can be left at their defaults as 
shown in the previous   example. If you are installing different language versions of iFIX, you   can 
modify the bold text to display an informational message in the language   corresponding to the lan-
guage code at the beginning of each line. For   a list of language codes, refer to the Language   
Codes Used by the iFIX Install Program section.

 7. For the execute line,   enter the folder and executable installation file that you want to run.   In this 
example, it's Myfolder\MySpecialInstall.exe.

 8. If there are command   lines that you want to include with your custom install add-on, add them   to 
the cmdline section.

 9. Save the file.

 10. Repeat steps 3-9   for each additional software program that you want to add to the install.

 11. Create a customized   DVD or a customized network install in preparation for deployment. For   
more information, refer to the Creating   a Custom iFIX Install for a DVD or Network section.

 

Customizing the Install Splash Screen
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If you are an OEM that resells the iFIX product with your own customizations,   or a system integrator that 
wants to brand your customized install program,   you can modify the first screen that a user encounters 
when installing   the product. This screen is called the install splash screen.

When you insert the rebranded iFIX DVD into the DVD drive, the install   splash screen appears. You can 
rebrand the install splash screen so that   it includes your company name or logo, for instance. Be aware 
that GE    requires special licensing to distribute rebranded DVDs. Contact   GE for more information.

IMPORTANT: If you want   to create and/or produce rebranded iFIX DVDs for use other than internal   to your 
company, you must have license agreement and permission from GE    to do so. Contact GE for more inform-
ation.

 To replace the   install splash screen for a customized install:

 1. Create a customized   iFIX install program. For steps, refer to the Creating   a Custom iFIX Install 
for a DVD or Network section.

 2. Locate the InstallFrontEnd.bmp   in your dvdimage folder.

 3. In an image editing   software program (Microsoft Paint or Paint Shop Pro, for instance), modify   the 
InstallFrontEnd.bmp. Be careful not to change the dimensions of the   graphic.

 4. Save the file over   the existing image.

 To customize the   text that appears on this splash screen:

 1. Locate the Installation.ini   file in your dvdimage folder.

 2. In Notepad or another   text editor, modify the Installation.ini file. Use the comments in the   file to 
guide you with your changes.

 3. Save the file over   the existing file.

 4. Create a customized   DVD or a customized network install in preparation for deployment. For   
more information, refer to the Creating   a Custom iFIX Install for a DVD or Network section.

 

Rebranding Install Graphics

To include rebranded graphics that appear during   the install (not just the initial graphic in the splash 
screen), you must   also have a special agreement with GE. Contact GE for details.   

The artwork includes a number of graphic files named: bbrd1.bmp, bbrd2.bmp,   bbrd3.bmp, and so on. 
These graphics are also known as the billboard graphics   that appear in the middle of the screen during 
the install. To rebrand   these files, edit each .bmp file in an image editing program. Make sure   that you do 
not change the dimensions or resolution of the graphics. If   you want to add additional billboard graphic 
files, you can do so. However,   you must make sure that their file name and numbering sequence fits 
with   the existing files, and you must make sure that they are the same dimensions   and resolution as the 
other billboard graphics. 

 To replace the   install graphics that appear after the splash screen:

 1. Obtain the bbrd*.bmp   files from GE.

 2. Create a customized   iFIX install program. For steps, refer to the Creating   a Custom iFIX Install 
for a DVD or Network section.
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 3. In the dvdimage folder,   create a folder named OEM\1033   folder, where 1033   represents the Eng-
lish language code. For a list of language codes, refer   to the Language   Codes Used by the iFIX 
Install Program section. Copy the bbrd*.bmp   files to this folder.

 NOTE:   Other language codes are supported as well. Contact GE for more   a list of language codes 
and information on licensing localized products.

 4. Use any graphics   editor to edit the bbrd*.bmp graphics, or create new bbrd*.bmp graphics.

IMPORTANT:   Be sure that you do not change the height and width (dimensions or resolution)   of the 
graphic. If you do, the graphic may not appear correctly in the   install.

 5. Save changed or new   files with the same naming convention.

 

Rebranding Install Text

To provide rebranded text that appears during   the install, you must also have a special agreement with 
GE. Contact GE for details. After an agreement   is signed, GE will provide the string table files   that you 
need to modify the product's install program.

The string table files have an .ips file extension, such as StringTable-0009-English.ips,   and an asso-
ciated .ini file, such as stringtable_English.ini. String table   files are included for the main install program. 
To rebrand a string table   file, use a text editor such as Notepad and enter changes for each row   you want 
to rebrand. You may need additional help from GE    with this process. Contact GE for details   and avail-
ability.

If you modify the text in an .ips file, you must recompress the install   program using the InstallShield 
Stand-Alone Builder (SAB), version 11.5,   that is available with the iFIX NLS Toolkit. For more inform-
ation on the    InstallShield SAB, refer to the Recompressing   the iFIX Install with Rebranded Material sec-
tion.

 To translate the   strings for the main install:

 1. Obtain the *.ips   and corresponding *.ini files for the main install from GE.

 2. Create a customized   iFIX install program. For steps, refer to the Creating   a Custom iFIX Install 
for a DVD or Network section.

 3. In your dvdimage   folder, create a new folder named Translate_iFix_Installer_Strings. Copy   the 
*.ips and *.ini files obtained for this installer from GE   to this folder.

 4. Open the .ips file   corresponding to your language in a text editor such as Notepad. For example,   
for English that file is named StringTable-0009-English.ips.

 5. Provide edits for   each string you want to rebrand. The text that you can rebrand appears   to the 
right of the equals (=) sign. For example, if you wanted to modify   the text that appears when a 
user who is not an Administrator attempts   to install iFIX, you would edit the bold portion shown 
here:
ERROR_NO_ADMIN_RIGHTS=Setup requires an user account with Administrator privileges.

 6. Save the file.
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 To update additional   text strings:

 1. Locate the Setup.ini   file in the dvdimage folder, and open it in a text editor such as Notepad.

 2. In the [Startup]   section of the Setup.ini file, provide updated information for the AppName,   Com-
panyName, or CompanyURL fields:
[Startup]
AppName=iFIX
ProductGUID=8E2D0FDB-EF39-4AE0-A9E8-619E7575A17E
CompanyName=GE
CompanyURL=https://digitalsupport.ge.com
...

 3. Save the file.

 To update the install   program with the rebranded string table files:

 1. Recompress the install   program using the InstallShield Stand-Alone Builder.

 2. Create a customized   DVD or a customized network install in preparation for deployment. For   
more information, refer to the Creating   a Custom iFIX Install for a DVD or Network section.

 

Rebranding the License Agreement

To include a rebranded end-user license agreement (EULA) in your install   program, you must also have a 
special agreement with GE. Contact   GE for details. After an agreement is signed, GE will provide   the 
license file that you need to modify the product's install program.   The license file is named license.rtf, 
and can be edited in Microsoft®   Word.

 To replace the   install splash screen for a customized install:

 1. Obtain the license.rtf   file from GE.

 2. Create a customized   iFIX install program. For steps, refer to the Creating   a Custom iFIX Install 
for a DVD or Network section.

 3. In the dvdimage folder,   create a folder named OEM\1033   folder, where 1033   represents the Eng-
lish language code.For a list of language codes, refer   to the Language   Codes Used by the iFIX 
Install Program section. Copy the license.rtf   file to this folder.

 NOTE:   Other language codes are supported as well. Contact GE for more   a list of language codes 
and information on licensing localized products.

 4. In Microsoft® Word,   open the license.rtf file and make the rebranding edits.

 5. Save the file (with   the original license.rtf file name).

 6. Copy the file to   the dvdimage folder.

 7. Validate the rebranded   End User License Agreement with the appropriate legal counsels at your   
company and GE before you ship the license.rtf with the product.   If changes need to be made to 
the license.rtf file at any future date,   copy the edited version to the OEM\1033   folder and over-
write the existing file. For a list of language codes,   refer to the Language   Codes Used by the iFIX 
Install Program section.

 

Recompressing the iFIX Install with Rebranded Material
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To recompress an iFIX install program with your rebranded text, you   need to use the InstallShield Stand-
Alone Builder (SAB), version 2012   Spring Edition. A copy of this program is included as part of the iFIX   
NLS Toolkit. You must have a special agreement with GE   to obtain a copy of the NLS Toolkit CD with 
the InstallShield SAB installer.   Steps on how to install the InstallShield SAB are described in the 
"Installing   the InstallShield Standalone Builder" topic in the Translating iFIX   with the NLS Toolkit e-book 
(NLSToolkit.chm).

To recompress the install, run the InstallShield SAB (ISCab.exe) from   the command-line, with the 
required command line options (described in   the steps below). This allows you to add files into the 
data1.cab cabinet   file for the install program, and rebuild the installer.

 To recompress the   install with the InstallShield SAB:

 1. For the main installer   (if you modified an .IPS file for it), copy the updated .IPS string table   file 
from the Translate_iFIX_Installer_Strings and the stringtable_<language>.ini   file into the dvdim-
age folder.

 2. Using a Command Prompt,   from the dvdimage directory, run the following command:
iscab.exe data1.cab -a -i"stringtable_<language>.ini"

 3. In the dvdimage folder,   remove the files you copied over in step 1.

 

Rebranding the iFIX DVD Booklet and Tray Card

Optionally, other artwork, such as the DVD Booklet and tray card, can   also be rebranded. You must 
have a special agreement with GE, to   do so. Contact GE for details. After an agreement is signed, GE    
will provide the artwork for these items.

The artwork source is in QuarkXpress format, so that you can replicate   these graphics as accurately as 
possible. You must have QuarkXpress to   edit these files.

Rebranding Other Parts of the iFIX Product

As an OEM, you must have license agreement and permission from GE   to rebrand any parts of the iFIX 
product. To do this, you will need a   copy of iFIX NLS Toolkit product. The NLS Toolkit allows you to 
rebrand   parts of the iFIX user interface, as well as the install program. Contact   GE for more information.

Deploying the iFIX Install Setup.exe   Command Line Options

You can run the iFIX Setup.exe   program from the command line using the options described in the fol-
lowing   table. These command line options are particularly helpful if you want   to deploy the iFIX install 
over a network using system management software,   such as Microsoft Systems Management Server 
(SMS). 

IMPORTANT:  For   Microsoft Windows 7 and up,  when   running iFIX Setup.exe directly, the installation user 
must either be   the build Administrator or use the same account that was used to set up   the machine.

Option Description
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/targetdir=
c:\Path

Sets the install folder, where c:\Path   represents the path where you want iFIX 
to install to.

/inifile=
c:\Path\
installconfig.ini

Redirects the install program to use the installconfig.ini   in the specified folder, 
where c:\Path   represents the path of the installconfig.ini file that you want to 
use.

/quiet Installs iFIX in unattended mode. For more information,   refer to the Running a 
Quiet   Install section.

/nomsg Installs iFIX without prompts (even for critical message   boxes), when used 
with the /quiet command.

 Example 1

In this example, we install iFIX quietly using a custom installation   file in the user's c:\myfolder directory:

Setup.exe /inifile=c:\myfolder\installconfig.ini /quiet /nomsg

Example 2

In this example, we install iFIX from the DVD without prompts:

Setup.exe /quiet /nomsg

Example 3

In this example, we change the default the iFIX install to the c:\Program   Files\MyFolder directory:

Setup.exe /targetdir=c:\Program Files\MyFolder

NOTE: Instead of using   the command line in Example 3, you can also modify the BasePath= option   in the 
InstallConfig.ini file.

INI Files Used by the iFIX Install

The following initialization (.ini) files are associated with the iFIX   install program. You can modify these 
.ini files to create a custom iFIX   install:

 l Installation.ini

 l InstallConfig.ini

 l Subinstall.ini

 l Setup.ini

 

Installation.ini

The following is an example of the iFIX Installation.ini file. Use the   Installation.ini file to modify the items 
displayed on the install splash   screen graphic.

; The Settings section configures general properties as follows 
;
;  Key Name Description
;  ----------------- -----------------------------------------------------------------
;  ShowTitle: If true, a caption bar displays at the top. Otherwise, it doesn't
;  Title: The caption that shows up at the top of the installation screen.
;  SplashScreen: The splash screen used if the color resolution is > 256 colors
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;  OnColor: The color value used to display the active option (RGB) - Format of BBGGRR (COLORREF)
;  OffColor: The color value used to display inactive options (RGB) - Format of BBGGRR (COLORREF)
;  ShadowColor: The color value used to provide a 3d effect to the text - Format of BBGGRR (COLORREF)
;  FontName: Use to override the default font name used by the software.
;  FontSize: Use to override the default font size used.
;  FontBold: 1 for bold, 0 for no bold.
;  FontItalic: 1 for italic, 0 for no italic
;  Icon Specify the icon file (.ico) to use for an icon.  The icon should have a 16x16 and 32x32 version.
;
;
;  IMPORTANT
;  =========
;  The splash screen will get sized to match the size of the splash bitmap.
;  the default label-button sizes and positions work well for a 640x480 bitmap.
;  if you use a different size, you should use the XCoord and YCoord parameters (see
;  below) to adjust the position of each label on the screen.
;
;  if you remove the caption bar (ShowTitle=0) make sure one of your buttons
;  includes the ExitButton=1 field . This command is used to exit the program. Otherwise
;  users won't be able to exit the program at all.
;
;  NOTE: All values except for FontSize, FontBold, FontItalic, and Icon are required.  
[Settings]
ShowTitle=1
Title=iFIX installation program
SplashScreen=InstallFrontEnd.bmp
OnColor=0xFF0000
OffColor=0xF0F0F0
ShadowColor=0x000000
FontSize=0x00000D
FontItalic=0
FontBold=1
FontName=Arial
Icon=Fix.ico
Status=Installing Proficy iFIX
;
;  Key Name Description
;  ----------------- -----------------------------------------------------------------
;  ButtonX where X is a number (Button1).  
; NOTE: Button names MUST be sequential!
; The values will be the section names of the buttons to be created.
; This allows for many buttons to be defined while only showing a subset of them.
[Buttons]
Button1=InstalliFIX
Button2=6XDriver
Button3=SupportWebsite
Button4=ReleaseNotes
Button5=Browse
Button6=Exit
Button7=Hist45
Button8=DataProvider
Button9=ServiceProvider
Button10=WorkflowTrigger11
;--------------------------------------------------------------------------------------------------
; Buttons
; This is made up of one or more sections.  Each section describes 1 button.
; ButtonText, XCoord and YCoord are required or the button will not be created.
; Also either ExitButton Or Executable are required.
; All other fields are optional.
;
;  Key Name Description
;  ----------------- -----------------------------------------------------------------     
;  ButtonText: The text to be shown
;  Hint:    The tool tip that shows up when that button is highlight.
;  ConfirmationRequired:0 for no confirmation, 1 for confirmation (default is 0)
;  ConfirmationPrompt: The string you want to use as a confirmation prompt.
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;
;  XCoord : The coordinate (horizontal, left is 0) where  you want the button to
;             appear. Negative coordinates are not allowed.
;  YCoord : The coordinate (vertical, top is 0) where you want the button to appear
;               negative coordinates are not allowed.
;  XIndent: Adjusts the x coordinate by the given value. Easy to display a hierarchy.
;  OnColor: The color value used to display the active option (RGB) - Format of BBGGRR (COLORREF)
;  OffColor: The color value used to display inactive options (RGB) - Format of BBGGRR (COLORREF)
;  ShadowColor: The color value used to provide a 3d effect to the text - Format of BBGGRR (COLORREF)
;  FontName: Use to override the default font name used by the software.
;  FontSize: Use to override the default font size used.
;  FontBold: 1 for bold, 0 for no bold.
;  FontItalic: 1 for italic, 0 for no italic
;  FontScale: An integer, used to scale the font relative to the established font size.
;                 (easy to make something slightly smaller or larger than default)
; It is not recommended that a button FontSize be defined if this field is defined.
;  LabelOnly: When set to 1, will not use the "on" color as the mouse goes over this label.
;                 (allows to create title labels) 
; Setting this overrides all other functionality (ExitButton, Executable, 3D highlighting on mouse over, etc.)
;  Executable: The command line command.  Can be a filename(setup.exe), a URL(http://something.com).
; May also include full or relative paths: (iFIXDriver\Setup.exe)
;  CmdLineParam: use if your executable requires a command line parameter. 
;  DefaultDir: use if your executable needs a default directory specified.
;  CloseAfterLaunch: Set to 1 to make this button run a command and also act as an exit button
;  ExitButton: Set to 1 to make this button exit the program without running any commands
;
;
;
[InstalliFIX]
ButtonText=Install iFIX 5.8
Hint=Selecting this option will launch the iFIX installation program
ConfirmationRequired=1
ConfirmationPrompt=Selecting this option will start the iFIX setup program. Do you want to proceed?
CloseAfterLaunch=1
XCoord = 355
YCoord = 15
FontScale=10
Executable=Setup\Setup.exe
CmdLineParam=FXMANAGER=TRUE
;[6XDriver]
;ButtonText=Install an I/O driver version 6.x
;Hint=Selecting this option will launch the setup a 6.x driver installation program.
;Executable=Setup\Proficy\iFIXDriver\SETUP.EXE
;XCoord = 355
;YCoord = 70
;[M1Licensing]
;ButtonText=Install M1 Licensing Software
;Hint=Selecting this option will launch the M1 licensing installation program.
;ConfirmationRequired=0
;ConfirmationPrompt=Selecting this option will start the Licensing setup program. Do you want to proceed?'
;CloseAfterLaunch=1
;Executable=Proficy\License\M1Licensing.exe
;XCoord = 355
;YCoord = 110
;[M4Licensing]
;ButtonText=Install M4 Licensing Software
;Hint=Selecting this option will launch the proficy license installation program.
;ConfirmationPrompt=Selecting this option will start the Licensing setup program. Do you want to proceed?'
;Executable=Proficy\License\ProficyClientInstaller.exe
;XCoord = 355
;YCoord = 150
[SupportWebsite]
ButtonText=Support Web Site
Hint=Go to the GE Web-site
Executable=http://support.ge-ip.com/support/index?page=home&view=AUTOMATION
XCoord = 355
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YCoord = 105
[ReleaseNotes]
ButtonText=View iFIX release notes
Hint=View the iFIX release notes
Executable=hh.exe
CmdLineParam=releasenotes/ipiifix.chm
XCoord = 355
YCoord = 140
[Browse]
ButtonText=Browse the DVD
Hint=Explore the DVD
XCoord = 355
YCoord = 175
Executable=explorer.exe
CmdLineParam=.
[DataProvider]
ButtonText=Install Proficy iFIX DataProvider
Hint=Install iFIX58 Data Provider Service components.
XCoord = 355
YCoord = 210
Executable="Setup\Proficy\iFIXDataProvider\iFIX58_DataProvider_001.exe"
[ServiceProvider]
ButtonText=Install Proficy iFIX ServiceProvider
Hint=Install Proficy iFIX Service Provider components.
XCoord = 355
YCoord = 245
Executable="Setup\Proficy\iFIXServiceProvider\ProficyiFIXServiceProvider.exe"
[WorkflowTrigger11]
ButtonText=Install Workflow Trigger 1.1
Hint=Install Workflow  Trigger 1.1 and related components
XCoord = 355
YCoord = 280
Executable="Setup\Proficy\WorkflowTrigger\Workflow  Trigger.exe"
[Exit]
ButtonText=Exit
Hint=Exit
XCoord=575
YCoord =330
FontScale=10
ExitButton=1
;FontName=MS Sans Serif

 

InstallConfig.ini

The following is an example of the iFIX InstallConfig.ini file. Use   the InstallConfig.ini to modify the 
default install settings, or to indicate   whether iFIX installs quietly.

[PATHS]
ROOT=
BasePath=GE\iFIX
PDBPath=PDB
NLSPath=NLS
PICPath=PIC
APPPath=APP
HTRPath=HTR
HTRDATAPath=HTRDATA
LOCALPath=LOCAL
ALMPath=ALM
RCMPath=RCM
RCCPath=RCC
AADPath=PDB
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[config]
NODENAME=FIX
NETWORK=TRUE
SCADA=FALSE
quiet=FALSE
[features]
PAV=TRUE
EBOOKS=TRUE
MYTSOFT=TRUE
SHOWEBOOKS=TRUE
SHOWMYTSOFT=TRUE
[upgrade]
USESCU=TRUE
WarnBTKUpgrade=TRUE
[nlsToolKit]
NLSTOOLKITFOLDER=FIX
[EBOOKS]
DOCPATH=Proficy\ProficyDoc
DEFAULTLANGUAGECODE=1033
PRODUCTNAME=IFIX
 

Subinstall.ini

The following is an example of the iFIX SubInstall.ini file. Use the   Subinstall.ini to include additional 
third-party software, or Software   Improvement Modules (SIMs) with your iFIX install.

[requisite]
install0=WindowsInstaller-KB893803-v2-x86
install1=vcredist_x86
install2=vcredist_x64
[pre_install]
install0=dotnetfx40
install1=plicense
[post_install]
install0=ChangeManagementClient
install1=opcclient
install2=discovery
install3=ikbf
[post_workspace_register]
[UNINSTALL]
[WindowsInstaller-KB893803-v2-x86]
display1031=Installing Microsoft Windows Installer 3.1
display1033=Installing Microsoft Windows Installer 3.1
display1036=Installing Microsoft Windows Installer 3.1
display1041=Installing Microsoft Windows Installer 3.1
display1042=Installing Microsoft Windows Installer 3.1
display1045=Installing Microsoft Windows Installer 3.1
display1049=Installing Microsoft Windows Installer 3.1
display2052=Installing Microsoft Windows Installer 3.1
required=1
execute=Microsoft\WindowsInstaller3_1\WindowsInstaller-KB893803-v2-x86.exe
cmdline=/quiet /norestart
checkregistry=SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\KB893803v2
[dotnetfx40]
display1031=Installing Microsoft .NET framework v4
display1033=Installing Microsoft .NET framework v4
display1036=Installing Microsoft .NET framework v4
display1041=Installing Microsoft .NET framework v4
display1042=Installing Microsoft .NET framework v4
display1045=Installing Microsoft .NET framework v4
display1049=Installing Microsoft .NET framework v4
display2052=Installing Microsoft .NET framework v4
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required=1
execute=Microsoft\DotNetFx40\dotNetFx40_Full_x86_x64.exe
cmdline=/q /norestart
checkregistry=SOFTWARE\Microsoft\NET Framework Setup\NDP\v4
[vcredist_x86]
display1031=Installing Microsoft Visual C++ Runtime Libraries (x86)
display1033=Installing Microsoft Visual C++ Runtime Libraries (x86)
display1036=Installing Microsoft Visual C++ Runtime Libraries (x86)
display1041=Installing Microsoft Visual C++ Runtime Libraries (x86)
display1042=Installing Microsoft Visual C++ Runtime Libraries (x86)
display1045=Installing Microsoft Visual C++ Runtime Libraries (x86)
display1049=Installing Microsoft Visual C++ Runtime Libraries (x86)
display2052=Installing Microsoft Visual C++ Runtime Libraries (x86)
required=1
execute=Microsoft\vcpp2010\vcredist_x86.exe
cmdline=/q /r:n /norestart
checkregistry=SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\{196BB40D-1578-3D01-B289-BEFC77A11A1E}
[vcredist_x64]
display1031=Installing Microsoft Visual C++ Runtime Libraries (x64)
display1033=Installing Microsoft Visual C++ Runtime Libraries (x64)
display1036=Installing Microsoft Visual C++ Runtime Libraries (x64)
display1041=Installing Microsoft Visual C++ Runtime Libraries (x64)
display1042=Installing Microsoft Visual C++ Runtime Libraries (x64)
display1045=Installing Microsoft Visual C++ Runtime Libraries (x64)
display1049=Installing Microsoft Visual C++ Runtime Libraries (x64)
display2052=Installing Microsoft Visual C++ Runtime Libraries (x64)
required=1
execute64=Microsoft\vcpp2010x64\vcredist_x64.exe
cmdline64=/q /r:n /norestart
[ikbf]
display1031=Installing Keyboard Driver
display1033=Installing Keyboard Driver
display1036=Installing Keyboard Driver
display1041=Installing Keyboard Driver
display1042=Installing Keyboard Driver
display1045=Installing Keyboard Driver
display1049=Installing Keyboard Driver
display2052=Installing Keyboard Driver
required=1
execute=Proficy\ikbf5\setupikbf5.exe
cmdline=/SILENT
[plicense]
display1031=Installing Proficy Common Licensing
display1033=Installing Proficy Common Licensing
display1036=Installing Proficy Common Licensing
display1041=Installing Proficy Common Licensing
display1042=Installing Proficy Common Licensing
display1045=Installing Proficy Common Licensing
display1049=Installing Proficy Common Licensing
display2052=Installing Proficy Common Licensing
required=0
execute=Proficy\license\ProficyClientInstaller.exe
cmdline=/quiet /nomsg
[opcclient]
display1031=Installing OPC Client Driver
display1033=Installing OPC Client Driver
display1036=Installing OPC Client Driver
display1041=Installing OPC Client Driver
display1042=Installing OPC Client Driver
display1045=Installing OPC Client Driver
display1049=Installing OPC Client Driver
display2052=Installing OPC Client Driver
required=0
execute=Proficy\OPCClientSetup\setup.exe
cmdline=1
[discovery]
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display1031=Installing Discover And Auto Configure
display1033=Installing Discover And Auto Configure
display1036=Installing Discover And Auto Configure
display1041=Installing Discover And Auto Configure
display1042=Installing Discover And Auto Configure
display1045=Installing Discover And Auto Configure
display1049=Installing Discover And Auto Configure
display2052=Installing Discover And Auto Configure
required=0
execute=Proficy\discovery\discovery.exe
cmdline=/quiet /nomsg
[ChangeManagementClient]
display1031=Installing Change Management Client
display1033=Installing Change Management Client
display1036=Installing Change Management Client
display1041=Installing Change Management Client
display1042=Installing Change Management Client
display1045=Installing Change Management Client
display1049=Installing Change Management Client
display2052=Installing Change Management Client
required=1
execute=Proficy\ChangeManagementAPI\setup.exe
cmdline=/s /v"/qn"

 
 
 

Setup.ini

The following is an example of the iFIX Setup.ini file. Use the Setup.ini   to modify text that appears in the 
actual install program. It is recommended   that you do not modify this file, unless you obtain permission 
from GE. Do not attempt to modify the ProductGUID item,   or you may experience unexpected errors.

[Startup]
Product=iFIX
ProductGUID=8E2D0FDB-EF39-4AE0-A9E8-619E7575A17E
CompanyName=GE
CompanyURL=https://digitalsupport.ge.com
ErrorReportURL=http://www.installshield.com/isetup/ProErrorCentral.asp?ErrorCode=%d : 0x%x&ErrorInfo=%s
MediaFormat=1
LogMode=1
SmallProgress=N
SplashTime=
CheckMD5=Y
CmdLine=
ShowPasswordDialog=N
ScriptDriven=4
[Languages]
Default=0x0409
Supported=0x0409,0x0804,0x0404,0x040c,0x0407,0x0410,0x0411,0x0412,0x0415,0x0416,0x0816,0x0419,0x040a,0x041d,0x0406,0x0413,0x042d,0x0402,0x0403,0x041a,0x0405,0x040b,0x0c0c,0x0408,0x040e,0x0421,0x0414,0x0418,0x0c1a,0x041b,0x0424,0x041e,0x041f
RequireExactLangMatch=0x0404,0x0804
RTLLangs=0x0401,0x040d
[0x0409]
0x0409=English (United States)
0x0411=Japanese
0x0401=Arabic (Saudi Arabia)
0x042d=Basque
0x0402=Bulgarian
0x0403=Catalan
0x0804=Chinese (PRC)
0x0404=Chinese (Taiwan)
0x041a=Croatian
0x0405=Czech
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0x0406=Danish
0x0413=Dutch (Netherlands)
0x040b=Finnish
0x0c0c=French (Canada)
0x040c=French (France)
0x0407=German (Germany)
0x0408=Greek
0x040d=Hebrew
0x040e=Hungarian
0x0421=Indonesian
0x0410=Italian (Italy)
0x0412=Korean
0x0414=Norwegian (Bokmal)
0x0415=Polish
0x0416=Portuguese (Brazil)
0x0816=Portuguese (Portugal)
0x0418=Romanian
0x0419=Russian
0x0c1a=Serbian (Cyrillic)
0x041b=Slovak
0x0424=Slovenian
0x040a=Spanish (Traditional Sort)
0x041d=Swedish
0x041e=Thai
0x041f=Turkish
 

Language Codes Used by the iFIX Install Program

The following table displays a list of language codes you can use when   creating a customized iFIX 
install. 

Language Code
Catalan 1027
Czech 1029
Danish 1030
English 1033
German 1031
Greek 1032
Japanese 1041
Swedish 1053
Basque 1069
Brazilian Portuguese 1046
Chinese - Taiwan 1028
Chinese PRC 2052
Croatian 1050
Cyrillic 3098
Dutch 1043
Finnish 1035
French 1036
French Canadian 3084
Hungarian 1038
Indonesian 1057
Italian 1040
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Korean 1042
Norwegian 1044
Polish 1045
Portuguese 2070
Russian 1049
Slovak 1051
Slovenian 1060
Spanish 1034
Thai 1054
Turkish 1055
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